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Execution Analysis

The Visual Execution Analyzer (VEA) is made up of an
advanced and comprehensive suite of tools that allow you to
build, debug, record, profile, simulate and otherwise
construct and verify your software development while
keeping the code tightly integrated with your model.
Enterprise Architect has rich support for a wide range of
popular compilers and platforms, in particular the Java, .Net
and Microsoft Windows C++ environments. Software
development becomes a highly streamlined visual
experience, quite unlike working in traditional
environments.
Enterprise Architect is itself modeled, built, compiled,
debugged, tested, managed, profiled and otherwise
constructed totally within the Visual Execution Analyzer
built into Enterprise Architect. While the VEA can be used
to complement other tool suites, it also shines when used as
the primary development IDE in close coupling with the
model and project management capabilities provided by
Enterprise Architect.

Access
(c) Sparx Systems 2022
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Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Shift+F12

Execution Analyzer Features
Feature
Build and
Debug

(c) Sparx Systems 2022

Description
Using Analyzer Scripts linked to Model
Packages, it is possible to tightly
integrate the code/build/debug cycle into
Enterprise Architect. For Java, .Net and
Microsoft C++ in particular, it is simple
to link to project code bases and take over
the building and debugging within
Enterprise Architect's Model Driven
Development Environment. In addition to
standard debugging features, the strong
coupling with the model and the use of
advanced debugging features such as
Action Points makes Enterprise Architect
Page 10 of 449
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the ideal platform from which to both
design and construct your software
application.
Simulation

Bring your behavioral models to life with
instant, real-time behavioral model
execution. Coupled with tools to manage
triggers, events, guards, effects,
breakpoints and simulation variables,
plus the ability to visually track execution
at run-time, the Simulator is an effective
means of 'watching the wheels turn' by
visualizing execution of your behavioral
models.

Profiling

Lift the hood on software performance
and see what is actually going on.
Quickly gain a clear picture of why
certain tasks behave poorly or worse than
expected. Whether its Microsoft .NET,
native C++ or Java, use profiles to
effectively judge changes in performance
over your software lifecycle.

Recording
Execution

Record the execution of code without the
need for instrumentation. Control the
amount of detail through filters and stack
depth. Generate beautiful Sequence
diagrams and diagrams that illustrate

(c) Sparx Systems 2022
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Class collaboration. Use recording to
create Test Domain diagrams that can be
used with the VEA Testpoints feature.
Testing

Create and manage test scripts for model
elements. Explore the Testing interface,
supporting unit, integration, scenario,
system, inspection and acceptance tests.
Employ programming by contract
methodology with the Testpoints facility.

Object
Workbench

Workbench Class behavior on the fly, by
instantiating them in the Object
Workbench and then invoking their
operations. You can even pass objects on
the workbench as parameters to other
workbench objects.

Visual
Execution
Analyzer
Samples

Try our sample patterns to set up and
explore the rich set of features in the
Visual Execution Analyzer.

Benefits of the Execution Analyzer
(c) Sparx Systems 2022
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The Execution Analyzer provides an integrated development
and testing environment for multiple platforms, including
Microsoft .NET, Java, Native C++, Mono and Android. It
includes a feature-rich debugger, execution recording and
profiling, and Testpoint management.
It helps you to generate Sequence, Test Domain Class and
Collaborative Class diagrams from a single recording. This
is a great way to understand and document your application.
· Visualize program execution
· Optimize existing system resources and understand
resource allocation
· Verify that the system is following the rules as designed
· Produce high quality documentation that more accurately
reflects system behavior
· Understand how and why systems work
· Train new employees in the structure and function of a
system
· Provide a comprehensive understanding of how existing
code works
· Identify costly or unnecessary function calls
· Illustrate interactions, data structures and important
relationships within a system
· Trace problems to a specific line of code, system
interaction or event
· Establish the sequence of events that occur immediately
prior to system failure
· Simulate the execution of behavior models including
(c) Sparx Systems 2022
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StateMachines, Activities and Interactions

Operations
Operation

Description

Simulate
Behavior

Simulate UML behavior models to verify
their logical and design correctness, for:
· Activities
· Interactions and Sequences
· StateMachines

Record
Execution

Record executing programs and represent
the behavior as a UML Sequence
diagram; recording is supported for:
· Microsoft Windows Native C, C++,
Visual Basic
· Microsoft .NET Family (C#, J#, VB)
· Java
· Mono
· Android
· PHP

Profile
Behavior

Quickly view / report on behaviors of
running applications. Profiling is
supported for these platforms:

(c) Sparx Systems 2022
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·

Test Use
Cases with
the
Testpoints
System

(c) Sparx Systems 2022

Microsoft Native C, C++, Visual Basic
Microsoft .NET Family (C#, J#, VB)
(including any unmanaged / managed
code mix)
Java
Mono

Testpoints Management provides a
facility to define the constraints on a
Class model as contracts. The contracts
provide the assets on which to create Test
domains. A single Testpoint domain can
then be used to test and report the
behavior of multiple applications. You
can also use the Execution Analyzer to
record a Use Case and generate a Test
Domain diagram with very little effort.
Any existing Testpoints are automatically
linked to the generated domain or the
Test Domain diagram can be used as the
context for new contract compositions.
How an application behaves for a given
Test domain can be seen immediately in
real time! Results are displayed in the
Testpoint report window every time a
contract is passed or failed. The
decoupling of test measurement from the
code-base has a number of benefits, one
of which is aiding the reconciliation of
Page 15 of 449
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multiple systems with a common Test
domain, rather than one another.
The Testpoint system supports these
contracts:
· Class invariants
· Method pre-conditions
· Method post-conditions
· Line conditions
Open
Console
Window

The Console window is a command line
interpreter through which you can quickly
create a terminal window to enable a
script engine and enter commands to act
on the script (JScript, JavaScript and
VBScript).

Object
Workbench

Create and work with objects created
within the Enterprise Architect modeling
environment using a dynamic Object
Workbench.
· Create objects from Class model
· Invoke methods and view results
· Workbench Class collaboration
· Pass objects as parameters to other
objects
· Full debugging features including
recording

(c) Sparx Systems 2022
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Run xUnit
Tests

Run nUnit and jUnit tests for Java and
Microsoft .NET
Record and document results.

Import Code
from
Analysis

Execution Recording and Profiling both
acquire a collection of relevant code files,
which you can reverse-engineer to the
current model in a single operation.

(c) Sparx Systems 2022
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Build and Debug

Enterprise Architect builds on top of its already exceptional
code generation, diagramming and design capabilities with a
complete suite of tools to build, debug, visualize, record,
test, profile and otherwise construct and verify software
applications. The toolset is intimately connected to the
modeling and design capabilities and provides a unique and
practical means of constructing software from a model and
keeping model and code synchronized.
Enterprise Architect helps you define 'Analyzer Scripts'
linked to Model Packages that describe how an application
will be compiled, which debugger to use and other related
information such as simulation commands. The Analyzer
(c) Sparx Systems 2022
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Script is the core configuration item that links your code to
the build, debug, test, profiling and deployment capabilities
within Enterprise Architect.
As a measure of how competent the toolset is, it should be
noted that Enterprise Architect is in fact built, debugged,
profiled, tested and otherwise constructed fully within the
Enterprise Architect development environment. Many of the
advanced debugging tools such as Action Points have been
developed to solve problems inherent in the construction of
large and complex software applications (such as Enterprise
Architect) and are routinely used on a daily basis by the
Sparx Systems development team.
It is recommended that new users take the time to fully
understand the use of the Analyzer Scripts and how they tie
the model to the code, to the compilers and to other tools
necessary for building software.

Integrating Model and Code
Model Driven Engineering is a modern approach to software
development and promises greater productivity and higher
quality code, resulting in systems getting to market faster
and with fewer faults. What makes this approach compelling
is the ability for the architecture and the design of a system
to be described and maintained in a model, and then
generated to programming code and schemas that can be
synchronized with and visualized within the model.
Enterprise Architect's Model Driven Development
(c) Sparx Systems 2022
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Environment (MDDE) supports this approach and provides
a set of flexible tools to increase productivity and reduce
errors. These include the ability to define the architecture
and design in models, generate code from these models,
synchronize the code with the models and maintain the code
in sophisticated code editors. Source code or binaries can
also be imported, and users can record and document
pre-existing or recently developed code. The Analyzer
Script tool helps you to describe how to build, debug, test
and deploy an application.
Facility

Description

Model
Driven
Development

Model Driven Development provides a
more robust, accessible and faster
development cycle than traditional
coding-driven cycles.
A well constructed model, intimately
linked with source code build, run,
debug, test and deploy capabilities
provides a rich, easily navigated and
easily understood target architecture.
Traceability, linkage to Use Cases,
Components and other model artifacts,
plus the ability to readily record and
document pre-existing or recently
developed code, make Enterprise
Architect's development environment
uniquely effective.
Enterprise Architect incorporates industry

(c) Sparx Systems 2022
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standard intelligent editing, debuggers
and modeling languages.
The Model
Driven
Development
Environment
(MDDE)

(c) Sparx Systems 2022

The MDDE provides tools to design,
visualize, build and debug an application:
· UML technologies and tools to model
software
· Code generation tools to
generate/reverse engineer source code
· Tools to import source code and
binaries
· Code editors that support different
programming languages
· Intelli-sense to aid coding
· Analyzer scripts that enable a user to
describe how to build, debug, test and
deploy the application
· Integration with compilers such as
Java, .Net, Microsoft C++
· Debugging capabilities for Java, .NET,
Microsoft C++ and others
· Advanced visualization, recording,
inspection, testing and profiling
capabilities

Page 21 of 449
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Analyzer Scripts
Analyzer Scripts are used by the Execution Analyzer. You
do not need to worry about creating these. They are not the
same type of script as JavaScript or PHP, but are managed
using a familiar user interface - a tree view - and you can
quickly locate the feature to change. Analyzer Scripts can be
shared by users of a community model and are easily
imported and exported as XML files.

A single project can have multiple configurations and these
can be found grouped together in the Analyzer window.

(c) Sparx Systems 2022
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Each Analyzer Script is defined for a Package, so projects
can co-exist quite happily. In many organizations, the
procedures to manage systems are distributed, and vary
from individual to individual and group to group. Analyzer
Scripts in an Enterprise Architect model can provide some
peace of mind to these organizations, by trusting a single,
shared and accountable procedure for building and
deploying any variety of configurations. All aspects of a
script are optional. You can, for instance, debug without
one; however, with a few lines they can enable these useful
features:
· Building
· Testing
· Debugging
· Recording
(c) Sparx Systems 2022
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Execution
Deployment
Simulation

Remote Script Execution
Various Analyzer Script sections such as Build and Run,
provide a 'Remote Host' field. This field is used to describe
the computer on which the script should run. In order to use
this feature, the Sparx Satellite service must be running on
the machine. The format of this field is hostname:port,
where hostname is the IP address or network name of a
Windows or Linux machine and port is the Port number that
the Satellite service is listening on. The primary goal of this
feature is to allow a user of Enterprise Architect running on
Linux to execute commands native to Linux.

(c) Sparx Systems 2022
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Managing Analyzer Scripts
The Execution Analyzer window enables you to manage all
Analyzer scripts in the model. You can use the window
toolbar buttons or script context menu options to control
script tasks. Scripts are listed by Package; the list only
shows Packages that have Analyzer scripts defined against
them. Each user can set their own active script, independent
of other users of the same model; one user activating a script
does not impact the currently active scripts for other users or
affect the scripts available to them. The active script governs
the behavior of the Execution Analyzer; when choosing the
build command from a menu, for example, or clicking the
Debug button on a toolbar.
There can be a lot of Packages with scripts listed in the
window. To help you locate and isolate a particular
Package, use the 'Filter Packages' context menu options,
described in the Context Menu Options table in this topic.
Note that when a script is highlighted in the Execution
Analyzer window, the window context menu options and
Execution Analyzer window toolbar buttons will operate on
the highlighted script. However, Execution Analyzer options
on any ribbon or floating toolbar, or in the Debugger (which
are not on the window) will always use the default Analyzer
script - the one that has the selected checkbox beside the
script name.

Access
(c) Sparx Systems 2022
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Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Shift+F12

Toolbar Options
Toolbar
Button

Action
Quick access to the Analyzer core
windows such as Call Stack or Local
Variables, plus the power features:
· Profiling
· Recording
· Testpoints
· Simulation
Create and edit a new Analyzer Script for
the selected Package, under either Linux
or WindowsTM.

(c) Sparx Systems 2022
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Export Scripts.
Export one or more Analyzer Scripts to
an XML file, which can be used to import
the scripts into another model.
The 'Execution Analyzer: Export' dialog
displays from which you select the script
or scripts to export, followed by a prompt
for the target file name and location.
Import Scripts.
Import one or more Analyzer Scripts into
the current model from a previously
exported XML file.
The 'Find Package' dialog displays, on
which you select the Package into which
to import the scripts, followed by a
prompt for the source filename and
location.
Execute the 'Build' command of the
active script.
Cancel the 'Build' command currently in
progress.
Execute the 'Run' command of the active
script.
(c) Sparx Systems 2022
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Execute the 'Test' command of the active
script.
Execute the 'Deploy' command of the
active script.

Context Menu Options
Right-click on the required script or Package to display the
context menus.
Option

Action

Add New
Script

Add a new script to the selected Package.
The Execution Analyzer window
displays, showing the 'Build' page.

Paste Script

Paste a copied script from the Enterprise
Architect clipboard into the selected
Package.
You can paste the copied script several
times; each copy has the suffix 'Copy'.
To rename the copied script, press F2 and
overtype the script name.

Export

Export scripts from the selected Package.

(c) Sparx Systems 2022
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Scripts

The 'Execution Analyzer: Export' dialog
displays, from which you select the script
or scripts to export, followed by a prompt
for the target filename and location.

Import
Scripts

Import scripts from a .XML file into the
selected Package.
A prompt displays for the source
filename and location.

Filter
Packages

Displays a submenu of options to:
· Enter the Package path against which
to filter the list of Packages - when you
select the 'Filter Packages' option, a
prompt displays to accept the
currently-selected Package path, or you
can remove the end elements of the
path to specify a larger set of Packages;
when you click on the OK button the
first Package in the list is expanded to
list the scripts it contains
· Switch between showing the full list of
Packages and hiding the full list of
Packages to expose only the
currently-selected Package
· Remove the currently-active filter to
show the full list of Packages

Select In

Highlight the selected Package in the

(c) Sparx Systems 2022
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Project
Browser

Browser window.
Display the Browser window, which is
now expanded to show the highlighted
Package.

Build

Execute the 'Build' command of the
selected script.

Clean

Execute the 'Clean' command of the
selected script.

Rebuild

Execute the 'Clean' and 'Build' commands
of the selected script.

Debug

Execute the 'Debug' command of the
selected script.

Run

Execute the 'Run' command of the
selected script.

Test

Execute the 'Test' command of the
selected script.

Deploy

Execute the 'Deploy' command of the
selected script.

Merge

Execute the 'Merge' source control
command of the selected script.

(c) Sparx Systems 2022
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Changes

Execute the 'Changes' source control
command of the selected script.

History

Execute the 'History' source control
command of the selected script.

Commit

Execute the 'Commit' source control
command of the selected script.

Working
Copy

Execute the 'Working Copy' source
control command of the selected script.

Repository

Execute the 'Repository' source control
command of the selected script.

Run
JavaScript

Execute the 'Run JavaScript' command of
the selected script. When this option is
selected, a job is created in the Job Queue
window.

Start

Start the simulation referenced by the

(c) Sparx Systems 2022
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Simulation

'Analyzer Script Simulation' page.

Run
Executable
Statemachine

Start a simulation of the selected
Executable Statemachine Artifact.

Edit

Open the selected script in the 'Analyzer
Scripts Editor'.

Copy

Copy the selected script to the Enterprise
Architect clipboard.

Paste

Paste the most-recently copied script to
the same Package as the selected script.
You can paste the copied script several
times; each copy has the suffix 'Copy'.
To rename the copied script, press F2 and
overtype the script name.

Delete

Delete the selected script; there is no
prompt for confirmation.
To delete a Package from the Execution
Analyzer window, delete the scripts from
the Package. When the last script is
deleted, the Package is no longer listed.

Package
Default

Set the selected script as the default script
for the Package.

(c) Sparx Systems 2022
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The icon to the left of the script changes
color; any previous Package default
reverts to normal.

(c) Sparx Systems 2022
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Analyzer Script Editor
The Analyzer Script Editor has a straightforward user
interface, with a tree view of the scripts on the left enabling
easy navigation of the script groups, and a content view on
the right in which you define and configure the scripts.

Access
From the 'Execution Analyzer' window, either:
· Double-click on a script to edit it or
· Right-click on a script and select the 'Edit' option
Ribbon

(c) Sparx Systems 2022

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer
Page 35 of 449
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Shift+F12

Execution Analyzer Scripts
Task - Page

Action

Build - Build

Enter the script or command to build the
application. This can be an Apache Ant
or Visual Studio command, but can also
be tailored depending on your
development environment. Note:
Remember to select a parser to get
directly to the source code in the event of
any errors. The parser field is on the same
page and offers support for many
languages.

Build - Clean

Enter the script or command to clean the
previous build. This is the command line
you would normally issue to build your
system. This can be an Apache Ant or
Visual Studio command depending on
your development environment.

(c) Sparx Systems 2022
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Test - Test

Enter the script or command to test the
application. This is typically where an
nUnit or jUnit invocation might be
configured, but it just as easily could be
any procedure or program.

Test Testpoints

Specify where the output from a
Testpoint run is sent.

Debug Platform

Specify the debugging platform, the
application to be debugged, and the mode
of debugging (attach to process or run).

Debug Tracepoints

Specify where the output from
Tracepoints encountered during a debug
session are sent.

Debug Workbench

For .NET projects, the assembly to load.
Not required for Java.

Debug Runtime
Host

Allows Enterprise Architect to launch the
program to be debugged using a
command line. This is typically used for
Mono or Java programs that use a socket
transport for debugging. This command is
executed prior to the Debugger being run.
The Port number specified in this
command should be the same value
passed to the 'Port' option in the Debug

(c) Sparx Systems 2022
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page. When the Debugger starts, it will
attempt to connect to the runtime on this
Port. If successful, it then binds any
breakpoints and resumes the
program,which it assumes to be
suspended. Java and Mono both have
command line options on the debugging
transport to initially suspend the process
till the Debugger connects.
Source
Control Merge

This is the script that executes when the
'Merge' option is chosen from the context
menu of an Analyzer Script. It provides a
place to run a program or shell script to
examine the differences between source
files.

Source
Control Changes

This is the script that executes when the
'Changes' option is chosen from the
context menu of an Analyzer Script. It
provides a place to run a source control
program such as 'svn' that might list
current changes to a source control
repository.

Source
Control History

This is the script that executes when the
'History' option is chosen from the
context menu of an Analyzer Script. It
provides a place to run a source control

(c) Sparx Systems 2022
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program such as 'svn' that might list a
history of changes to a source control
repository.
Source
Control Commit

This is the script that executes when the
'Commit' option is chosen from the
context menu of an Analyzer Script. It
provides a place to run a source control
program such as 'svn' that might commit
changes to a source control Working
Copy.

Source
Control Working
Copy

This is the script that executes when the
'Working Copy' option is chosen from the
context menu of an Analyzer Script. It
provides a place to run a source control
program such as 'svn' to perform actions
on the current working copy of a source
repository.

Source
Control Repository

This is the script that executes when the
'Repository' option is chosen from the
context menu of an Analyzer Script. It
provides a place to run a source control
program such as 'svn' to perform actions
on a source repository.

Code Miner Service

In this section you can choose how the
Code Miner service operates. You can

(c) Sparx Systems 2022

Page 39 of 449

Execution Analysis

3 October, 2022

choose either a remote server or to use
libraries locally.
Code Miner Libraries

This section provides a place for the
management of Code Miner libraries.
Here, you can create libraries based on a
project codebase or repository. Code
Miner libraries created here can be
searched using mFQL queries. Queries
composed in mFQL can be used to search
one or more libraries in a single
operation.

Private
Options Services

This is where the IP address and Port of
Enterprise Architect Satellite services for
Linux and Windows are configured.
These services provide enterprise-wide
support for system management functions
and remote debugging scenarios.

Job Settings

Most of the commands contained in an
Analyzer Script are executed as jobs in
the Job Queue. Each script can be
configured to post a notification to a
specified user group when a specified job
completes. The 'Job Settings' group
provides the 'Notifications' option, which
displays the fields through which you
enter the job identity as part of the text to

(c) Sparx Systems 2022
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display to the members of the Model
Mail user group, and the user group
name.

·

·

·

Run
JavaScript

(c) Sparx Systems 2022

Post on completion - select this
checkbox to enable the other two fields
Job Identity - Type in the text to
display, which should also identify the
job; for example: 'Installers Completed'
User Group - Click on the drop-down
arrow and select the appropriate Model
Mail user group

In this section you can create and store a
JavaScript that you can execute by
selecting the 'Run JavaScript' option from
the context menu of an Analyzer Script.
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When this option is selected, a job is
created in the Job Queue window.

(c) Sparx Systems 2022
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Run

Enter a command to run an application.

Deploy

Enter a script or command to deploy the
project. Build your jar file. Deploy to
your device, an emulator or Tomcat
server. Publish a web site. Its up to you.

Recording

Does your Sequence diagram resemble
the national grid? Reduce the clutter with
filters. Filters define exclusion zones in
your code base that can cut down
dramatically on any 'noise' that is being
recorded. Even accurate noise is not
always helpful.

Simulation

Complete the configuration for
Simulation Control.

(c) Sparx Systems 2022
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Build Scripts
The 'Build' page enables you to enter commands to build
your project. You can use Enterprise Architect Local Paths
and environment variables in composing your command
line(s). You can choose to create your own build script,
entering various shell commands. You can also choose to
simply run an external program or batch file such as an Ant
script.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Build > Build' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Build'
page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Analyzer
Context
Menu

Build
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Ctrl+Shift+F12

Build
Write your script in this text box, using the windows shell
commands; the format and content of this section depends
on the actual compiler you use to build your project. If the
path or arguments contain spaces, surround them with
quotes; for example: "c:\program files
(x86)\java\bin\javac.exe".
Here are some examples:
Visual Studio:
"C:\Program Files (x86)\Microsoft Visual Studio
9.0\Common7\IDE\devenv.com" /Rebuild Debug
RentalSystem.sln
Visual Studio using a Local Path:
"%VsCompPath%\devenv.exe" /build Debug Subway.sln
Java:
C:\Program Files (x86)\Java\jdk1.6.0_22\bin\javac.exe"
-g -cp "%classpath%;." %r*.java
Java using a Local Path:
"%JAVA%\bin\javac.exe" -g -cp "%classpath%;."
%r*.java
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Wildcard Java Builds (%r) - Source files in sub-folders
can be built using the %r token. The token has the effect of
causing a recursive execution of the same command on any
files in all sub-folders, as shown in the example.

Execute Command as
Click on the drop down arrow and select the mode of
executing the script:
· Batch File - Use this option to execute a shell script in a
system command window; environment variables can be
accessed by commands in this script
· Process - Use this option to execute the command as a
single program; the command should specify the path to
the program, plus any command line arguments

Default Directory
Browse for or type in the default directory path in which the
build script process will run.

Parse Output
Click on the drop-down arrow and select a method for
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automatically parsing the compiler output.
If you select this option, output from the script is logged in
the System Output window; Enterprise Architect parses the
output according to the syntax you specify.

Remote Host
Type in the ID of the remote host system and its port; for
example, mypc01:7777.
If you set this property to #SYSTEMHOST#, the script is
sent to the Windows Satellite Service when running on
Windows, and the Linux Satellite Service when running
under Wine. The service IDs and Ports are defined in the
'Private Options - Services' section of the Analyzer Scripts
Editor.

Deploy after Build
Check this box to cause the Deploy script to be executed
immediately after this Build script completes.

Notes
To execute the Build script, click on the Package in the
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Browser window and either:
· Right-click on any Toolbar and select 'Analyzer Toolbars |
Build', or
· Press Ctrl+Shift+F12 or
· Select the 'Execute > Source > Build > Build' ribbon
option
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Cleanup Script
Incremental builds are the practice of only building those
assets that have changed in some way. There are times,
however, when there is cause to build everything again from
scratch. This command is used for those occasions, to
remove the binaries and intermediary files associated with a
particular build or configuration. The project can then be
rebuilt. When you execute the 'Rebuild' menu option on a
script, the command(s) you specify in this field are
executed, followed immediately by the 'Build' command
from the same Analyzer script. Some compilers have
options do this for you. Visual studio for example has the
"/clean" command line switch.
This is an example script: devenv.com /Clean Debug
MyProject.sln

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Build > Clean' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Build > Clean'
page
Ribbon
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Analyzer > Edit Analyzer Scripts
Execute > Source > Build > Clean
Analyzer
Context
Menu

Clean

Keyboard
Shortcuts

Shift+F12

Aspects
Aspect

Detail

Clean

Enter the command to be executed when
you select 'Clean' from the script context
menu.

Execute
Command as

Click on the drop-down arrow and select
the appropriate option:
· Batch File - Use this option to create a
shell script that is executed in a system
command window; environment
variables can be accessed by
commands in this script
· Process - Use this option to run a single
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program - the command should specify
the path to the program, plus any
command line arguments; - if the path
or arguments contain spaces, surround
them with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"
Default
Directory

Defaults to the value entered for the
Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.

Parse Output

Click on the drop-down arrow and select
a method for automatically parsing the
compiler output.
If you select this option, output from the
script is logged in the System Output
window; Enterprise Architect parses the
output according to the syntax you
specify.

Remote Host

Type in the ID of the remote host system
and its port; for example, mypc01:7777.
If you set this property to
#SYSTEMHOST#, the script is sent to
the Windows Satellite Service when
running on Windows, and the Linux
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Satellite Service when running under
Wine. The service IDs and Ports are
defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.
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Test Scripts
These sections explain how to configure the 'Test' page of
an Analyzer Script for performing unit testing on your code.
Most users will apply this to NUnit and JUnit test scenarios.
Enterprise Architect accepts the output from these systems
and can automatically add to and manage each unit test case
history. To view the case history, you would select the test
case Class element and press Alt+2 > Testing.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Test > Test' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Test > Test'
page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Analyzer
Context
Menu

Test
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Shift+F12

Actions
Test Type the Test command or script in this
field. For example:
· NUnit - "C:\Program
Files\NUnit\bin\nunit-console.exe"
"bin\debug\Calculator.exe"
· JUnit - java junit.textui.Testrunner %N
The command listed in this field is
executed as if from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
surrounded in quotes.
If you include the string %N in your test
script it is replaced by the fully
namespace-qualified name of the
currently selected Class when the script is
executed.
Execute Click on the drop-down arrow and select
Command the appropriate option:
As · Batch File - Use this option to create a
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·

shell script that is executed in a system
command window; environment
variables can be accessed by
commands in this script
Process - Use this option to run a single
program - the command should specify
the path to the program, plus any
command line arguments; if the path or
arguments contain spaces, surround the
path with quotes - for example:
"c:\program files
(x86)\java\bin\javac.exe"

Default Defaults to the value entered for the
Directory Build script. If a value has not been set
for the Build script, browse for or type in
the default directory path in which the
Clean script process will run.
Parse When a parser is selected, output of nUnit
Output and jUnit tests can be parsed, saved and
managed from the model; (Alt+2 >
Testing). Be aware that output is only
captured when a parser is selected.
Remote Host Type in the ID of the remote host system
and its port; for example, mypc01:7777.
If you set this property to
#SYSTEMHOST#, the script is sent to
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the Windows Satellite Service when
running on Windows, and the Linux
Satellite Service when running under
Wine. The service IDs and Ports are
defined in the 'Private Options - Services'
section of the Analyzer Scripts Editor.
Build First Select to ensure that the Package is
compiled each time you run the test.
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Testpoints Output
The 'Testpoints' page of the Analyzer Script helps you to
configure the output of a Testpoint run.
By default the output is logged to the System Output
window, as in this example.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Test > Testpoints' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Test >
Testpoints' page
Ribbon
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Execute > Tools > Analyzer > View
Analyzer Scripts
Keyboard
Shortcuts

Shift+F12

Options
Option

Description

Output

You can select from two options:
· 'Screen' (the default) - The output is
directed to the 'Testpoints' tab of the
System Output window
· 'File' - The output is directed to file

Folder

Click on the folder to use for Testpoint
log files.

Filename

Enter the name to use for the Testpoint
log files.

Overwrite

When this option is selected, the file
specified is overwritten each time a
Testpoint run is performed.
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Auto Number When this option is selected, the
Testpoint output is composed of the
filename you specify and the number of
the Test run; each time you perform a
Test run the number is incremented.
Prefix trace
output with
function
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Debug Script
The process of configuring the Debug section of an
Analyzer Script is usually a one-time affair that rarely has to
be revisited. So once you have your script working, you
probably won't have to think about it again. The details you
provide are not complicated, yet defining a script provides
access to a great many benefits such as:
· Debugging
· Sequence diagram recording
· Executable StateMachine execution and simulation
· Test domain authoring and recording
· Behavioral profiling of processes on a variety of runtimes
All you need to do is select the appropriate platform and
enter some basic details. The debugger platforms you can
use include:
· Java
· Java Debug Wire Protocol (JDWP)
· Microsoft .NET Debugger
· Microsoft Native Code Debugger (C++, C, VB)
· Mono
· The PHP Debugger
· The GNU Debugger (GDB)

Access
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Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

F6

Notes
·

An Analyzer script is not necessary for debugging
Enterprise Architect model scripts such as JavaScript or
VBScript
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Operating System Specific
Requirements
The Enterprise Architect debugger is able to operate on a
number of different platforms. This table describes the
individual requirements for debugging on each platform.

Platforms
Platform
Microsoft
.NET

Detail
·

·

Java
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Microsoft™ .NET Frameworks 4.0, 3.5
and 2.0
Language support: C, C#, C++, J#,
VB.NET

Java SE Development Kit from
Oracle™ (version 5.0 minimum)
(either 32 bit or 64 bit JDK)
The Java Platform Debugger Architecture
(JPDA) was introduced in Java SE
version 5.0. The JPDA provides two
protocols for debugging; the Java Virtual
Machine Tools Interface (JVMTI), and
the Java Debug Wire Protocol (JDWP).
Enterprise Architect's debugger supports
·
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both protocols.
GNU
Debugger
(GDB)

Enterprise Architect supports debugging
using the GNU Debugger, which enables
you to debug your applications under
Linux either locally or remotely.
Requires GDB version 7.0 or higher.
The source code file path must not
contain spaces.

Windows for
Native
Applications

Enterprise Architect supports debugging
native code (C, C++ and Visual Basic)
compiled with the Microsoft™ compiler
where an associated PDB file is available.

PHP

Enterprise Architect enables you to
perform local and remote debugging of
PHP scripts in web servers.
Requires web server to be configured to
support PHP.
Requires PHP to be configured to support
XDebug PHP (3rd party PHP extension).

Notes
·

The debugging facility is available in all editions of
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Enterprise Architect
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UAC-Enabled Operating Systems
The Microsoft operating system Windows 7 provides User
Account Control (UAC) to manage security for applications.
The Enterprise Architect Visual Execution Analyzer is
UAC-compliant, and users of UAC-enabled systems can
perform operations with the Visual Execution Analyzer and
related facilities under accounts that are members of only
the Users group.
However, when attaching to processes running as services
on a UAC-enabled operating system, it might be necessary
to log in as an Administrator.

Log in as Administrator
Ste Action
p
1

Before you run Enterprise Architect, right-click on
the Enterprise Architect icon on the desktop and
select the 'Run as administrator' option.

Alternatively
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Edit or create a link to Enterprise Architect and configure
the link to run as an Administrator.
Ste Action
p
1

Right-click on the Enterprise Architect icon and
select the 'Properties' option.
The Enterprise Architect 'Properties' dialog displays.

2

Click on the Advanced button.
The 'Advanced Properties' dialog displays.

3

Select the 'Run as administrator' checkbox.

4

Click on the OK button, and again on the 'Enterprise
Architect Properties' dialog.
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WINE Debugging
Configure Enterprise Architect to debug
under WINE
Ste Action
p
1

At the command line, run $ winecfg.

2

Select the 'Applications' tab. Add the Enterprise
Architect executable 'EA.exe' from the Enterprise
Architect installations folder. Then add these
programs from the VEA sub directories:
· SSampler32.exe
· SSampler64.exe
· SSProfiler32.exe
· SSProfiler64.exe

3

Select each program in turn, then switch to the
'Libraries' tab. Ensure these values are listed with a
(native, built-in) precedence:
· dbghelp
· msxml4
· msxml6
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4

Copy the application source code plus executable(s)
to your bottle.
The path must be the same as the compiled version;
that is:
If Windows source = C:\Source\SampleApp, under
Crossover it must be C:\Source\SampleApp.

5

Copy any Side-By-Side assemblies that are used by
the application.

Permissions
An installation of Enterprise Architect contains some native
Linux programs that provide building and debugging
services to Enterprise Architect under Wine. These
programs need to checked using the Linux file system or
shell to ensure they have the 'Execute' permission set
appropriately. The programs are located in the
"VEA/x86/linux" subdirectory of the Enterprise Architect
installation.

Access Violation Exceptions
Due to the manner in which WINE handles direct drawing
and access to DIB data, an additional option is provided on
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the drop-down menu on the Debug window toolbar to
ignore or process access violation exceptions thrown when
your program directly accesses DIB data.
Select this option to catch genuine (unexpected) access
violations; deselect it to ignore expected violations.
As the debugger cannot distinguish between expected and
unexpected violations, you might have to use trial and error
to capture and inspect genuine program crashes.

Notes
·
·

·

If WINE crashes, the back traces might not be correct
If you are using MFC remember to copy the debug
side-by-side assemblies to the C:\window\winsxs
directory
To add a windows path to WINE, modify the Registry
entry:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\
Control\Session Manager\Environment
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Java
This section describes how to set up Enterprise Architect for
debugging Java applications and Web Servers.
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General Setup for Java
The general setup for debugging Java Applications supports
two options:
· Debug an Application
· Attach to an application that is running

Option 1 - Debug an Application
Field

Action

Debugger

Select Java.

x64

Select this checkbox if you are debugging
a 64 bit application.
Deselect the checkbox if you are
debugging a 32 bit application.

Mode

Select Run.

Default
Directory

This path is added to the class path
property when the Java Virtual Machine
is created.

Application
Class

Identify the fully qualified Class name to
debug; the Class must have a method
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declared with this signature:
public static void main(String());

Command
Line
Arguments

Specify any parameters to be passed to
the main method of the Application
Class.
Parameters containing spaces should be
surrounded with double quotes.

Java Virtual
Machine
Options

Specify command line options for Virtual
Machine creation.
You also must provide a parameter for
the Java Runtime Environment (JRE) as
the path to be searched for the jvm.dll;
this is the DLL supplied as part of the
runtime environment or JDK from Sun
MicrosystemsTM.
The JRE parameter can be either:
· An Enterprise Architect-defined Local
Path
· An absolute file path (with no double
quotes) to the installation folder of the
Java JDK to be used for debugging
The JRE parameter must point to the
installation folder for the Java JDK. A
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JDK installation is necessary for
debugging to succeed. The JRE should
not point to the installation of the public
Java Runtime Environment, if that is
installed. Environment variables can be
used when specifying the VM startup
options, such as classpath.
For example, using:
· An Enterprise Architect Local Path
JAVA and an environment variable
classpath:
·

Or an absolute path to the JDK
installation directory and an
environment variable classpath:

In these two examples, the debugger will
create a virtual machine using the JDK
located at the value of the JRE parameter.
If no classpath is specified, the debugger
always creates the virtual machine with a
class path property equal to any path
contained in the environment variable
plus the path entered in the default
working directory of this script.
If source files and .class files are located
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under different directory trees, the
classpath property MUST include both
root path(s) to the source and root path(s)
to binary class files.

Option 2 - Attach to Virtual Machine
There is very little to specify when attaching to a VM;
however, the VM must have the Sparx Systems debugging
agent loaded.
Field

Action

Debugger

Select Java

Mode

Select Attach to Virtual Machine
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Advanced Techniques
In addition to the standard Java debugging techniques, you
can:
· Attach to Virtual Machine
· Internet Browser Java Applets
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Attach to Virtual Machine
You can debug a Java application by attaching to a process
that is hosting a Java Virtual Machine; you might want to do
this for attaching to a webserver such as Tomcat or JBOSS.
The Java Virtual Machine Tools Interface from Sun
Microsystems is the API used by Enterprise Architect; it
allows a debugging agent to be specified when the JVM is
created.
To debug a running JVM from Enterprise Architect, the
Sparx Systems' debugging agent must have been specified
as a startup option to the JVM when it was started; how this
is accomplished for products such as Tomcat and JBOSS
should be provided by that product's own documentation.
For java.exe, the command line option to load the Enterprise
Architect debugging agent could be (depending on your
environment):
· -agentpath:"c:\program files\sparx
systems\ea\VEA\x86\SSJavaProfiler32"
· -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"
· -agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"
The appropriate option will depend on your operating
system and whether you are working on a 32 bit application
or a 64 bit application.
Alternatively, if you add the appropriate VEA directory to
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your PATH environment variable you can choose to use:
· -agentlib:SSJavaProfiler32
· -agentlib:SSJavaProfiler64
It is not necessary to configure an Analyzer Script when you
attach to a Virtual Machine; you can just use the Attach
button on one of the Analyzer toolbars.
If you configure an Analyzer Script, there are only two
things that must be selected:
· Select 'Java' as the debugging platform
· Choose the 'Attach to Virtual Machine' option
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Internet Browser Java Applets
This topic describes the configuration requirements and
procedure for debugging Java Applets running in a browser
from Enterprise Architect.

Attach to the browser process hosting the
Java Virtual Machine (JVM) from Enterprise
Architect
Ste Action
p
1

Ensure binaries for the applet code to be debugged
have been built with debug information.

2

Configure the JVM using the Java Control Panel.

3

In the 'Java Applet Runtime Settings' panel, click on
the View button.

4

On the installed version to use, include one of these
options in the 'Runtime Parameters' field, depending
on your environment and whether you are working
on a 32 bit application or a 64 bit application:
-agentpath:"c:\program files\sparx
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systems\ea\VEA\x86\SSJavaProfiler32"
-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x86\SSJavaProfiler32"
-agentpath:"c:\program files (x86)\sparx
systems\ea\VEA\x64\SSJavaProfiler64"
5

In this field add the required Class paths.
At least one of these paths should include the root
path of the source files to use in debugging.

6

Set breakpoints.

7

Launch the browser.

8

Attach to the browser process from Enterprise
Architect.
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Working with Java Web Servers
If you are debugging Java web servers such as JBOSS and
Apache Tomcat (both Server configuration and Windows
Service configuration) in Enterprise Architect, apply these
configuration requirements and procedures.
Note: The debug and record features of the Visual
Execution Analyzer are not supported for the Java server
platform 'Weblogic' from Oracle.

Attach to process hosting the Java Virtual
Machine from Enterprise Architect
Ste Action
p
1

Build binaries for the web server code to be
debugged, with debug information.

2

Launch the server with the 'Virtual Machine startup'
option, described in Server Configuration.

3

Import source code into the Enterprise Architect
Model, or synchronize existing code.

4

Set breakpoints.
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5

Launch the client.

6

Attach to the process from Enterprise Architect.

Server Configuration
The configuration necessary for the web servers to interact
with Enterprise Architect must address these two essential
points:
· Any VM to be debugged, created or hosted by the server
must have the Sparx Systems Agent command line option
specified or in the VM startup option (that is:
-agentlib:SSJavaProfiler32 or
-agentlib:SSJavaProfiler64)
· The CLASSPATH, however it is passed to the VM, must
specify the root path to the Package source files
The Enterprise Architect debugger uses the java.class.path
property in the VM being debugged, to locate the source file
corresponding to a breakpoint occurring in a Class during
execution; for example, a Class to be debugged is called:
a.b.C
This is located in physical directory:
C:\source\a\b
So, for debugging to be successful, the CLASSPATH must
contain the root path:
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c:\source

Analyzer Script Configuration
Using the 'Debug' tab of the 'Build Script' dialog, create a
script for the code you have imported and:
· Select the 'Attach to process' radio button and, in the field
below it, type 'attach'
· In the 'Use Debugger' field, click on the drop-down arrow
and select 'Java'
All other fields are unimportant; the 'Directory' field is
normally used in the absence of any Class path property.

Run the Debugger
The breakpoints could show a question mark. In this case
the Class might not have been loaded yet by the VM. If the
question mark remains even after you are sure the Class
containing the breakpoint has been loaded, then either:
· The binaries being executed by the server are not based on
the source code
· The debugger cannot reconcile the breakpoint to a source
file (check Class paths), or
· The JVM has not loaded the Sparx Systems agent
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Ste Action
p
1

Run the server and check that the server process has
loaded the Sparx Systems Agent:
DLL SSJavaProfiler32.DLL or SSJavaProfiler64
Use 'Process Explorer' or similar tools to prove that
the server process has loaded the agent.

2

In Enterprise Architect, open the source code and set
some breakpoints.

3

Click on the Run Debug button in Enterprise
Architect.
The 'Attach To Process' dialog displays.

4

Select the server process hosting the application.

5

Click on the OK button.
A confirmation message displays in the Debug
window, stating that the process has been attached.
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JBOSS Server
In this JBoss example, for a 32 bit application, the source
code for a simple servlet is located in the directory location:
C:\Benchmark\Java\JBOSS\Inventory
The binaries executed by JBOSS are located in the
JAW.EAR file in this location:
C:\JBOSS\03b-dao\build\distribution
The Enterprise Architect debugger has to be able to locate
source files during debugging; to do this it also uses the
CLASSPATH, searching in any listed path for a matching
JAVA source file, so the CLASSPATH must include a path
to the root of the Package for Enterprise Architect to find
the source during debugging.
This is an excerpt from the command file that executes the
JBOSS server; the Class to be debugged is at:
com/inventory/dto/carDTO
Therefore, the root of this path is included in the
JBOSS_CLASSPATH.

Example Code
RUN.BAT
------------(c) Sparx Systems 2022

Page 84 of 449

Execution Analysis

3 October, 2022

set SOURCE=C:\Benchmark\Java\JBOSS\Inventory
set JAVAC_JAR=%JAVA_HOME%\lib\tools.jar
if "%JBOSS_CLASSPATH%" == ""
(
set
JBOSS_CLASSPATH=%SOURCE%;%JAVAC_JAR%;%
RUNJAR%;
)
else
(
set
JBOSS_CLASSPATH=%SOURCE%;%JBOSS_CLASSPA
TH%;%JAVAC_JAR%;%RUNJAR%;
)
set JAVA_OPTS=%JAVA_OPTS% -agentpath:"c:\program
files\sparx systems\vea\x86\ssjavaprofiler32"
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Apache Tomcat Server
The Apache Tomcat Server can be configured for debugging
using the Java debugger in Enterprise Architect. This
example shows the configuration dialog for Apache Tomcat
7.0 on a PC running Windows 7.

These three points are important:
· The 'Java Virtual Machine' specifies the runtime from an
installation of the Java JDK
· The source path to any servlet to be debugged is added to
Java Classpath; in this case we add the path to the Tomcat
servlet:
c:\tomcat\webapps\servlet\WEB-INF\src
· The 'Java Options' include the path to the Sparx Systems
debugging agent:
(c) Sparx Systems 2022
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-agentpath:c:\program files (x86)\sparx
systems\vea\x86\ssjavaprofiler32

(c) Sparx Systems 2022
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Apache Tomcat Windows Service
Configuration
For users running Apache Tomcat as a WindowsTM service,
it is important to configure the service to enable interaction
with the Desktop; failure to do so causes debugging to fail
within Enterprise Architect.

Select the 'Allow service to interact with desktop' checkbox.
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.NET
This section describes how to configure Enterprise Architect
for debugging .NET applications. It includes:
· General Setup for .NET
· Debugging an Unmanaged Application
· Debug COM Interop
· Debug ASP .NET
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General Setup for .NET
This is the general setup for debugging Microsoft .NET
applications. You have two options when debugging:
· Debug an application
· Attach to an application that is running

Option 1 - Debug an application
Field

Action

Debugger

Select Microsoft .NET as the debugging
platform.

x64

Select this checkbox if you are debugging
a 64 bit application.
Deselect the checkbox if you are
debugging a 32 bit application.

Mode

Select the Run radio button.

Default
Directory

This is set as the default directory for the
process being debugged.

Application
Path

Select and enter either the full or the
relative path to the application
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executable.
· If the path contains spaces, specify the
full path; do not use a relative path
· If the path contains spaces, the path
must be enclosed by quotes
Command
Line
Arguments

Parameters to pass to the application at
start up.

Show
Console

Create a console window for the
debugger; not applicable to attaching to a
process.

Symbol
Search Paths

Specify any additional paths to locate
debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running
Field

Action

Debugger

Select Microsoft .NET as the debugging
platform.
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x64

Select this checkbox if you are debugging
a 64 bit application.
Deselect the checkbox if you are
debugging a 32 bit application.

Mode

Select the Attach to Process radio button.
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Debugging an Unmanaged Application
If you are debugging managed code using an unmanaged
application, the debugger might fail to detect the correct
version of the Common Language Runtime (CLR) to load.
You should specify a config file if you don’t already have
one for the debug application specified in the Debug
command of your script.
The config file should reside in the same directory as your
application, and take the format:
name.exe.config
where 'name' is the name of your application.
The version of the CLR you specify should match the
version loaded by the managed code invoked by the
debuggee.
In the sample code that follows, "clr_version" represents the
version of the CLR targeted by your plug-in or COM code.

Sample Config File
<configuration>
<startup>
<requiredRuntime version="clr_version"/>
</startup>
</configuration>
(c) Sparx Systems 2022
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Debug COM Interop
Enterprise Architect enables you to debug .NET managed
code executed using COM in either a Local or an In-Process
server.
This feature is useful for debugging Plug-ins and ActiveX
components.

Debug .NET Managed Code Executed Using
COM
Ste Action
p
1

Create a Package in Enterprise Architect and import
the code to debug.

2

Ensure the COM component is built with debug
information.

3

Create a Script for the Package.

4

In the 'Debug | Platform' page, you can select to
either attach to an unmanaged process or specify the
path to an unmanaged application to call your
managed code.
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Add breakpoints in the source code to debug.

Attach to an Unmanaged Process
If you are using:
· An In-Process COM server, attach to the client process
· A Local COM Server, attach to the server process
Click on the Debug window Run button (or press F6) to
display a list of processes from which you can choose.

Notes
·

Detaching from a COM interop process you have been
debugging terminates the process; this is a known issue
for Microsoft .NET Framework, and information on it can
be found on many of the MSDN .NET blogs
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Debug ASP .NET
Debugging for web services such as ASP requires that the
Enterprise Architect debugger is able to attach to a running
service.
Begin by ensuring that the directory containing the ASP
.NET service project has been imported into Enterprise
Architect and, if required, the web folder containing the
client web pages.
If your web project directory resides under the website
hosting directory, you can import from the root and include
both ASP code and web pages at the same time.
It is necessary to launch the client first, as the ASP .NET
service process might not already be running; load the client
using your browser - this ensures that the web server is
running.
In the debug set up you would then select the 'Attach' radio
button. When this choice is selected, the debugger will
prompt you each time for the process to debug.
Click on the Debug window Run button to start the
debugger; the 'Attach To Process' dialog displays.
The name of the process varies across Microsoft operating
systems, as explained in the ASP .NET SDK; for example,
on Windows XP, the name of the process resembles
aspnet_wp.exe, although the name could reflect the version
of the .NET framework that it is supporting.
There can be multiple ASP.NET processes running under
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XP; you must ensure that you attach to the correct version,
which would be the one hosting the .NET framework
version that your application runs on; check the web.config
file for your web service to verify the version of .NET
framework it is tied to.
The Debug window Stop button should be enabled and any
breakpoints should be red, indicating they have been bound.
You can set breakpoints at any time in the web server code.
You can also set breakpoints in the ASP web page(s) if you
imported them.

Notes
Some breakpoints might not have bound successfully, but if
none at all are bound (indicated by being dark red with
question marks) something has gone out of synchrony; try
rebuilding and re-importing source code
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The Mono Debugger
Mono is a software platform sponsored by the .NET
Foundation to facilitate cross-platform development. It is
popular with game developers for its rich gaming,
API-based and portability features.
Enterprise Architect provides support to the Mono
community by providing a modern environment for both
modeling and developing software. Existing projects can be
imported, built and debugged natively on both Linux and
Windows.

Overview
Debugging under Mono involves the cooperation of three
processes. The Mono runtime manages the application and
communicates using a socket protocol with the Enterprise
Architect Debugger, which in turn communicates with
Enterprise Architect acting as the front end. When you
launch Mono you need to direct it to support debugging,
which you achieve using a command line directive in which
you name the host and Port number that Mono should listen
on. The host can be omitted, in which case Mono will accept
connections from any IP address. The host can have the
value 'localhost' to restrict connections to the same machine.
The Port number is a number of your choosing.
The host and Port number are the important pieces of
information, as they are used when configuring the Analyzer
(c) Sparx Systems 2022
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Script.

Requirements for Windows
·
·

Enterprise Architect (version 14 minimum)
Mono for Windows (version 5.4 minimum)

Requirements for Linux
·
·
·

Enterprise Architect (version 14 minimum)
Mono for Linux (version 5.4 minimum)
Wine for Linux

The Runtime Host Page
This page is optional and is only useful where Mono and
Enterprise Architect will be running on the same machine. It
provides the ability to run Mono first with the required
debugging directives, before the Enterprise Architect
debugger is started. After the debugger connects, it resumes
the Mono runtime, which has been started as suspended. If
the application runs on a different machine from the
Enterprise Architect you are using, you should clear this
section.
(c) Sparx Systems 2022
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Debugging Configuration Linux
Debugger Configuration
This section describes the Debug section of an Analyzer
Script in respect to debugging Mono under Linux. Fields
that are not listed here are not required.

Debugger

Select 'Mono'.

Default
Directory

This is the fully qualified native Linux
path where the application is located in
Unix format.

Connection

·
·

·

·

(c) Sparx Systems 2022

port: the debugging Port
host: the name or IP address of the
machine where Mono runs ('localhost'
if the machine is the same)
localpath: the root path of the source
code in Windows format; this is the
path to the source files that you use to
set breakpoints in the code editor in
Enterprise Architect
remotepath: the root path of the source
code in Unix format, this being the path
to the source files used to build the
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program under Linux

·

·

·

·

These paths are returned during debug
events, and are then mapped to the
local path, so that Enterprise Architect
can display the source file during a
breakpoint or step - both parameters
can specify the same physical source
file root, but must use the Windows or
Unix format for each field
shutdown: (true or false); when true the
VM is terminated when the Debugger
is stopped
timeout: the timeout in milliseconds for
socket calls
output: the Wine / Windows path of the
log file to write to
logging: (true or false); when true,
extra messages are logged in the Debug
window and socket messages are
logged to the specified output file

Starting Mono Automatically
You can configure Enterprise Architect to start Mono for
you when you start the debugger. You do this by
(c) Sparx Systems 2022
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configuring the 'Runtime Host' page of your Analyzer
Script. The format of the commands is described here:
cd path-to-program
/usr/bin/mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program
where:
- path-to-program is the directory path where the program is
located
- host is one of these:
· localhost
· an IP address
· a networked machine name
- port is the Port for the socket
- program is the name of the application (such as
MonoProgram.exe)

Starting Mono Manually using the Command
Line
You can start Mono manually from a console. Locate the
program in your file explorer, then open a console at that
location. The format of the command line is described here:
/usr/bin/mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
(c) Sparx Systems 2022
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ver=y,suspend=y program
where host is one of these:
· localhost
· an IP address
· a networked machine name
port is the Port for the socket and program is the name of
the application (for example, MonoProgram.exe).
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Debugging Configuration Windows
Debugger Configuration
This section describes the Debug section of an Analyzer
Script in respect to debugging Mono under Windows.
Fields that are not listed here are not required.
Field

Description

Debugger

Select 'Mono'.

x64

Select if the program to be debugged is a
64 bit executable.

Run or
Attach

Choose 'Run' to name the program to
launch. Choose 'Attach' if you will
always attach to a running process.

Default
Directory

The default directory that the program
will take when it runs.

Application
Path

The full path of the Mono application.

Command
Line
Arguments

Any parameters to pass to the program. If
the parameters contain spaces, surround
them in double quotes (")
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Starting Mono Automatically
You can configure Enterprise Architect to start Mono for
you when you start the debugger. You do this by
configuring the 'Runtime Host' page of your Analyzer
Script. The format of the commands is described here:
cd path-to-program
mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program
where:
- path-to-program is the directory path where the program is
located
- host is one of these:
· localhost
· an IP address
· a networked machine name
- port is the Port for the socket
- program is the name of the application (such as
MonoProgram.exe)

Starting Mono Manually using the command
(c) Sparx Systems 2022
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line
You can start Mono manually from a console. Locate the
program in your file explorer, then open a console at that
location. The format of the command line is described here:
mono --debug
--debugger-agent=transport=dt_socket,address=host:port,ser
ver=y,suspend=y program
where host is one of these:
· localhost
· an IP address
· a networked machine name
port is the Port for the socket and program is the name of
the application (for example, MonoProgram.exe).
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The PHP Debugger
The Enterprise Architect PHP Debugger enables you to
debug PHP.exe scripts. This section discusses basic set up
and the various debugging scenarios that are commonly
encountered; the scenarios concern themselves with the
mapping of file paths, which is critical to the success of a
remote debugging session.
· Script Setup
· Local Windows Machine (Apache Server)
· Local Windows Machine (PHP.exe)
· Remote Linux Machine (Apache Server)
· Remote Linux Machine (PHP.exe)

Setup and Scenarios
Scenario

Details

Script Setup

An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the toolbar of the
Execution Analyzer.
Select PHP.XDebug as the debugging
platform; when you select this platform
the property page displays these
connection settings:
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·

·

·

Local
Machine
Apache
Server
(c) Sparx Systems 2022

host - localhost - The adaptor that
Enterprise Architect listens on for
incoming connections from PHP
localpath - %LOCAL% - Specifies the
local file path to be mapped to a remote
file path; this is a remote debugging
setting - for local debugging, clear the
value, the value is a placeholder and
you should edit it to fit your particular
scenario
remotepath - %REMOTE% - Specifies
the remote file path that a local file
path is to be mapped to; this is a remote
debugging setting - for local
debugging, clear the value, the value is
a placeholder and you should edit it to
fit your particular scenario
logging - Enter true or false to enable
logging of communication from
XDebug server
output - names the file path on the
remote machine to be used with the
logging option; this file will always be
overwritten

In this situation, consider this
configuration:
· O/S: Windows7
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Network computer name: MyPC
· Network share MyShare mapped to
c:\myshare
· Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts
· Apache document root is set to
//MyPC/MyShare/apache
In this scenario an Analyzer Script for the
connection parameters might be
configured as:
· host: localhost
· port: 9000
· localpath: c:\myshare\apache\
· remotepath: MyPC/MyShare/apache/
·

Local
Machine
PHP.EXE

In this scenario an Analyzer Script for the
connection parameters might be
configured as shown, as file paths always
map to same physical path:
· host: localhost
· port: 9000
· localpath:
· remotepath:

Remote
Linux

In this situation consider this
configuration:
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Local Machine:
· O/S: Windows7
· Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts
Remote Machine:
· O/S: Linux
· Apache document root is set to
home/apache/htdocs
· Source files in Apache are located at
home/apache/htdocs/myapp/scripts
In this scenario an Analyzer Script for the
connection parameters might be
configured as:
· host: localhost
· port: 9000
· localpath: c:\myshare\apache\
· remotepath: home/apache/htdocs/

Remote
Linux
Machine
PHP.exe

(c) Sparx Systems 2022

In this situation consider this
configuration:
· Local Machine
· O/S: Windows7
· Source files in Enterprise Architect
have been imported from
c:\myshare\apache\myapp\scripts
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Remote Machine
· O/S: Linux
· Source files in Apache located at
home/myapp/scripts
In this scenario an Analyzer Script for the
connection parameters might be
configured as:
· host: localhost
· port: 9000
· localpath: c:\myshare\apache\
· remotepath: home/
·

PHP Global
variables

(c) Sparx Systems 2022

When you are at a breakpoint, you can
examine the values of PHP globals using
the Analyzer Watches window. To list
every global, type either 'globals' or
'superglobals' into the field. To show an
individual item, enter its name. This
image shows the value of the PHP
environment variable $_SERVER being
displayed.
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PHP Debugger - System Requirements
This topic identifies the system requirements and operating
systems for the Enterprise Architect PHP debugger.

System Requirements:
·
·
·
·

Enterprise Architect version 9
PHP version 5.3 or above
PHP zend extension XDebug 2.1 or above
For web servers such as Apache, a server version that
supports the PHP version

Supported Operating Systems:
·
·
·
·
·
·

Client (Enterprise Architect)
Microsoft Windows XP and above
Linux running Crossover Office
Server (PHP)
Microsoft Windows XP and above
Linux

(c) Sparx Systems 2022
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PHP Debugger Checklist
This topic provides a troubleshooting guide for debugging
PHP scripts in Enterprise Architect.

Check Points
Check Point
System
Requirements

Details
·
·
·

Enterprise
Architect

(c) Sparx Systems 2022

Apache HTTP Web Server version 2.2
PHP version 5.3 or above
XDebug version 2.1.1

The model has an Analyzer Script
configured to use the PHP XDebug
platform
· PHP source code has been imported
into the model (for recording and
testpoints)
· When the PHP XDebug platform is
selected from the 'Analyzer Script'
dialog, default runtime settings are
listed in the 'Connection' field:
localpath:%LOCAL%
remotepath:%REMOTE%
Either define local paths for these default
·
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variables or edit the script to provide
actual paths.
For example: local source, remote source
localpath:c:\code
samples\vea\php\sample
remotepath:webserver/sample
· 'webserver' is a network or local share
· 'sample' is a folder below share
PHP

(c) Sparx Systems 2022

In order to debug PHP scripts in
Enterprise Architect, it is a requirement
that the PHP is configured properly to
load the XDebug extension.
Settings similar to these should be used:
· [xdebug]
· xdebug.extended_info=1
· xdebug.idekey=ea
· xdebug.remote_enable=1
· xdebug.remote_handler=dbgp
· xdebug.remote_autostart=1
· xdebug.remote_host=X.X.X.X
· xdebug.remote_port=9000
· xdebug.show_local_vars=1
The IP address X.X.X.X refers to and
should match the host specified in the
model Analyzer Script.
The IP address is the address XDebug
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connects with and the same address the
Enterprise Architect PHP agent listens
on.
Apache

For debugging using Apache, these lines
should be present in the Apache
configuration file, httpd.conf:
LoadModule php5_module
"php_home/php5apache2_2.dll"
AddHandler application/x-httpd-php
.php
PHPIniDir "php_home"
The value "php_home" is the PHP
installation path (the path where php.ini
and apache dll exist).

Troubleshoot
ing

To prevent both PHP and Apache
timeouts during a debugging session,
these settings might require modification.
The settings were used while developing
the PHP Debugging agent in Enterprise
Architect.

PHP

File: php.ini
; Enterprise Architect prevents PHP
timeouts when debugging PHP
extensions
max_execution_time = 0

(c) Sparx Systems 2022
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; Enterprise Architect prevents web
server timeouts when debugging PHP
extensions
max_input_time = -1
; Enterprise Architect logs errors
display_errors = On
; Enterprise Architect displays startup
errors
display_startup_errors = On
Apache

(c) Sparx Systems 2022

File: httpd.conf
; Enterprise Architect prevents timeouts
while debugging php extensions
Timeout 60000
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The GNU Debugger (GDB)
When debugging your applications you can use the GNU
Debugger (GDB), which is portable and runs on Unix-like
systems such as Linux, as well as on Windows. The GDB
works for many programming languages including Ada,
Java, C, C++ and Objective-C. Using the GDB, you can
debug your applications either locally or remotely.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Debug > Platform' page
or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Platform' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Context
Menu

Browser window | Right-click on
Package | Execution Analyzer

Keyboard
Shortcuts

Shift+F12

(c) Sparx Systems 2022
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Set up the GNU Debugger
Task

Details

Set up Script

An Analyzer Script is a basic requirement
for debugging in Enterprise Architect;
you create a script using the Execution
Analyzer toolbar.
On the 'Platform' page of the Execution
Analyzer Script Editor, in the 'Debugger'
field click on the drop-down arrow and
select 'GDB'.

Define
Connection
Settings

The property panel displays a number of
connection settings for which you
provide values.
· path - <path> - The complete file path
of the GDB executable; you only
specify this if the GDB cannot be
found in the system path
· source - <path>, <path> - The path in
which the debugger will search for
source files, if they do not reside in the
executable directory
· remote - F - Set for remote debugging;
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·

·

·

·

·

otherwise leave blank
port - <nnnnn> - The Port to connect to
on the remote server
host - localhost - The host name to
connect to
fetch - T - Set to retrieve the binary
from the remote system
dumpgdb - <path> - The filename to
write the GDB output to
initpath - <path> - The complete file
path to the gbinit file

Notes
·

A requirement of the GDB is that your source code file
path does not contain spaces; the debugger will not run
correctly with spaces in the file path

(c) Sparx Systems 2022
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The Android Debugger
If you are developing Java applications running on Android
devices or emulators, you can also debug them. The Local
and Remote machines can be on either a 32 bit platform or a
64 bit platform.

System Requirements
On the Remote machine, this software is required:
· Android SDK, which includes the android debug bridge,
ADB (you need to be familiar with the SDK and its tools)
(c) Sparx Systems 2022
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Java JDK (32 and 64 bit support)
Port Forwarding software (3rd party)

On the Local machine, this software is required:
· Enterprise Architect Version 10 or higher

Analyzer Script Settings
Field/Button

Action

Debugger

Click on the drop-down arrow and select
Java (JDWP).

Run

Click on this radio button.

Default
Directory

Not applicable - leave blank.

Application
path

Not applicable - leave blank.

Command
Line
Arguments

Not applicable - leave blank.

Build first

Not applicable - leave blank.
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Show
console

Not applicable - leave blank.

Show
diagnostic
messages

Not applicable - leave blank.

Connection

Not applicable - leave blank.

Port

This is the application port,
forward-assigned using adb or other
means, through which Enterprise
Architect and the Android Virtual
Machine (VM) can communicate.

Host

Host computer (defaults to localhost)
If Android is running on an emulator on a
device attached to a networked computer,
enter the network name here.
By default, debugging will attempt to
connect to the Port you specify on the
local machine.

Source

This is the source equivalent of the
classpath setting in Java.
The root to each source tree should be
listed. If more than one is specified, they
should be separated by a semi-colon; that
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is:
c:\myapp\src;c:\myserver\src
You must specify at least one root source
path.
When a breakpoint occurs the debugger
searches for the java source in each of the
source trees listed here.
Logging

Enables logging additional information
from debugger
possible values: true,false,1,0,yes,no

Output

Specifies the full name of the local log
file to be written.
The folder must exist or no log will be
created.
The log file typically contains a dump of
bytes sent between debugger and VM.

Platform

If you are debugging Java running under
any android scenario, select Android.
For all other scenarios, select Java.

(c) Sparx Systems 2022
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Configure Ports for Debugging - Port
Forwarding (Local)
The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged can be assigned using ADB,
which is supplied with the Android SDK.
Before debugging, start the application once in the device.
When the app starts, discover its process identifier (pid):
adb jdwp
The last number listed is the pid of the last application
launched; note the pid and use it to allow the debugger to
connect to the VM:
· adb forward tcp:port jdwp:pid
- port = Port number listed in analyzer script
- pid = process id of the application on the device

Configure Ports for Debugging - Port
Forwarding (Remote)
To debug remotely, the same procedure should be followed
as for the local machine, but the communication requires
additional forwarding as the socket created using the adb
forward command will only listen on the local adapter. The
socket is bound to the localhost, and attempts to connect to
this Port will be met with 'connection refused' messages.
(c) Sparx Systems 2022
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In order to achieve remote debugging it is necessary to have
a proxy running on the remote machine that listens to all
incoming connections and forwards all traffic to the adb
Port; there are numerous software products available to do
this.
Remote debugging with Enterprise Architect will not work
unless you have configured a proxy Port forwarder.
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Java JDWP Debugger
Java provides two main debugging technologies: an
in-process agent-based system called the Java Virtual
Machine Tools Interface (JVMTI) and a socket-based
paradigm called the Java Debug Wire Protocol (JDWP). A
Java Virtual Machine can name either one of these but not
both, and the feature must be configured when the JVM is
started.

System Requirements
1. The Enterprise Architect JDWP debugger will only be
able to communicate with a JVM started with the 'JDWP'
option. Here is an example of the command line option:
java
-agentlib:jdwp=transport=dt_socket,address=localhost:90
00,server=y,suspend=n -cp "c:\java\myapp;%classpath%"
demo.myApp "param1" "param2"
2. The Virtual Machine should not be currently attached to a
debugger.
3. It is not possible for a VM to be debugged by Enterprise
Architect and Eclipse at the same time.

Analyzer Script Settings
(c) Sparx Systems 2022
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Field/Button

Action

Debugger

Click on the drop-down arrow and select
Java (JDWP).

Run

Click on this radio button to run the
debugger when the script is executed.

Default
Directory

Not applicable - leave blank.

Application
path

Not applicable - leave blank.

Command
Line
Arguments

Not applicable - leave blank.

Build first

Not applicable - leave blank.

Show
console

Not applicable - leave blank.

Show
diagnostic
messages

Not applicable - leave blank.

Connection

Not applicable - leave blank.
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Port

Set the application Port forward-assigned
to the VM process during start-up, in the
Java command-line options.

Host

Set the host computer (defaults to
localhost)
If VM is running on a networked
computer, enter the network name or url
here.
By default debugging will attempt to
connect to the Port you specify on the
local machine.

Source

This is the source equivalent of the
classpath setting in Java.
List the root to each source tree; specify
at least one root source path. If you
specify more than one, separate them
with a semi-colon; for example:
c:\myapp\src;c:\myserver\src
When a breakpoint occurs the debugger
searches for the Java source in each of the
source trees listed here.

Logging

Enable or disable logging of additional
information from the debugger.
Possible values include:
· true
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·
·
·
·

false
1
0
yes
no

Output

Specify the full name of the local log file
to be written. If the folder does not
already exist, no log will be created.
The log file typically contains a dump of
bytes sent between the debugger and VM.

Platform

Select Java.

Configure Ports for Debugging
The debugger can only debug one VM at a time; it uses a
single Port for communication with the VM. The Port for
the application to be debugged is assigned when the VM is
created.

Local Debugging
Where both Enterprise Architect and the Java VM are
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running on the same machine, you can perform local
debugging. It is necessary to launch the VM with the JDWP
transport enabled - see the documentation on Java Platform
Debugger Architecture (JPDA) at Oracle for the command
line option specifications. For example:
java
-agentlib:jdwp=transport=dt_socket,address=localhost:9000,
server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%" samples.MyApp
"param1" "param2"
In this example the values for the Analyzer script would be
'host: localhost' and 'port:9000'.

Remote Debugging
Where Enterprise Architect is running on the local machine
and the Java VM is running on a remote machine, you can
perform remote debugging. It is necessary to launch the VM
with the JDWP transport enabled - see the documentation on
JPDA at Oracle for the command line option specifications.
Here is an example, where the remote computer has the
network name testmachine1:
java
-agentlib:jdwp=transport=dt_socket,address=9000,server=y,
suspend=n -cp "c:\samples\java\myapp;%classpath%"
samples.MyApp "param1" "param2"
Note the absence of a host name in the address. This means
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the VM will listen for a connection from any machine. In
this example the values for the Analyzer script would be
'host: testmachine1' and 'port: 9000'.
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Tracepoint Output
The Tracepoints page of the Analyzer Script enables you to
direct where the output from any Trace statements goes
during a debug session.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Debug > Tracepoints' page
or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Tracepoints' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer > select and
run script

Context
Menu

Browser window | Right-click on
Package | Execution Analyzer

Keyboard
Shortcuts

Shift+F12
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Tracepoint properties
Field

Detail

Output

You can select from two options:
· 'Screen' (the default) - The output is
directed to the Debug window
· 'File' - The output is directed to file

Folder

Enter the folder to use for Trace
statement log files.

Filename

Enter the name to use for the Trace
statement log files.

Overwrite

If selected, the specified file is
overwritten each time a debug session is
started.

Auto Number If selected, the Trace log file is composed
of the filename you specify and a
number.
Each time you start a debug session, the
number is incremented.
Prefix trace
output with
(c) Sparx Systems 2022
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Workbench Setup
This topic describes the requirements for setting up the
Object Workbench on Java and Microsoft .NET.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Debug > Workbench' page
or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Debug >
Workbench' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Shift+F12

Platforms
Platform
(c) Sparx Systems 2022
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Platforms
Supported

The Workbench supports these platforms:
· Microsoft .NET (version 2.0 or later)
· Java (JDK 1.4 or later)

Microsoft
.NET
Workbench

The .NET workbench requires an
assembly, which is used to create the
workbench items.
You specify the path to the assembly on
the 'Workbench' page of the Analyzer
Script.
There are two constraints in using the
.NET workbench:
· Members defined as struct in managed
code are not supported
· Classes defined as internal are not
supported

Java
Workbench

The Java workbench uses the Virtual
Machine settings configured in the
Analyzer Script 'Debug' page to create
the JVM.
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Microsoft C++ and Native (C, VB)
You can debug native code only if there is a corresponding
PDB file for the executable. A PDB file is created as a result
of building the application.
The build should include full debug information and there
should be no optimizations set.
The script must specify two things to support debugging:
· The path to the executable
· Microsoft Native as the debugging platform
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General Setup
This is the general setup for debugging Microsoft Native
Applications (C++, C, Visual Basic). You have two options
when debugging:
· Debug an application
· Attach to an application that is running

Option 1 - Debug an application
Field

Action

Debugger

Select Microsoft Native as the debugging
platform.

x64

Select this checkbox if you are debugging
a 64 bit application.
Deselect the checkbox if you are
debugging a 32 bit application.

Mode

Select the Run radio button.

Default
Directory

This is set as the default directory for the
process being debugged.

Application

Select and enter either the full or the
relative path to the application
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Path

executable.
· If the path contains spaces, specify the
full path; do not use a relative path
· If the path contains spaces, the path
must be enclosed by quotes

Command
Line
Arguments

Parameters to pass to the application at
start up.

Show
Console

Create a console window for the
debugger; not applicable for attaching to
a process.

Symbol
Search Paths

Specify any additional paths to locate
debug symbols for the debugger; separate
the paths with a semi-colon.

Option 2 - Attach to an application that is
running
Field

Action

Debugger

Select Microsoft Native as the debugging
platform.
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x64

Select this checkbox if you are debugging
a 64 bit application.
Deselect the checkbox if you are
debugging a 32 bit application.

Mode

Select the Attach to Process radio button.

Symbol
Search Paths

Specify any additional paths to locate
debug symbols for the debugger.
You could specify a symbol server here if
you prefer; separate the paths with a
semi-colon or comma.
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Debug Symbols
For applications built using Microsoft Platform SDK, Debug
Symbols are written to an application PDB file when the
application is built.
The Debugging Tools for Windows, an API used by the
Visual Execution Debugger, uses these symbols to present
meaningful information to Execution Analyzer controls.
These symbols can easily get out of date and cause aberrant
behavior - the debugger might highlight the wrong line of
code in the editor whilst at a breakpoint; it is therefore best
to ensure the application is built prior to any debugging or
recording session.
The debugger must inform the API how to reconcile
addresses in the image being debugged; it does this by
specifying a number of paths to the API that tell it where to
look for PDB files.
For system DLLs (kernel32, mfc90ud) for which no debug
symbols are found, the Call Stack shows some frames with
module names and addresses only.
You can supplement the symbols translated by passing
additional paths to the API; you pass additional symbol
paths in a semi-colon separated list in the 'Debug' tab.
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Merge Script
A Merge command in an Analyzer Script gives users an
additional command to perform some action. The merge
action is dependent on your requirements.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Merge' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Merge' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Source > Merge

Keyboard
Shortcuts

Ctrl+Alt+M
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Code Miner Script
The Code Miner system uses a set of databases to provide
fast and comprehensive access to information derived from
existing source code. The Intelli-sense features of Enterprise
Architect's code editors and its search tools can make use of
the information mined from these databases.
Through the Code Miner script pages, you can specify
which Code Miner databases to use with a particular project
and you can create, update and add new databases to the
Code Miner library. The 'Services' page allows you to
specify a local Code Miner library, or that you want to
access the library available through the Sparx Intel Service.
Different Code Miner details can be specified for each
Analyzer Script, so the Code Miner libraries that are used
are determined by the active Analyzer Script.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Code Miner' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Code Miner'
page
Ribbon
(c) Sparx Systems 2022
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Analyzer Scripts > Double-click on
Script name > Code Miner > Service
Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts >
Double-click on Script name > Code
Miner > Service
Keyboard
Shortcuts

Shift+F12

Sparx Intel Service
A Code Miner Library can be used locally, or it can be
deployed to a server location where it can service multiple
clients. You select the scenario to use on the 'Code Miner
Service' page of the Analyzer Script.

(c) Sparx Systems 2022

Page 147 of 449

Execution Analysis

3 October, 2022

Code Miner Libraries
The Code Miner Database Libraries are a collection of
databases containing information derived from source code.
Together, these databases form the Code Miner Library used
by the Intelli-sense features of Enterprise Architect.
Usually, a library would be created for each framework or
project. The Code Miner Libraries page allows new
databases to be created, and existing databases to be added,
updated or removed from a library.
Code Miner Query Libraries are a collection of functions,
written in Code Miner's mFQL language, bundled together
into one source file.
The Code Miner Database Library and Query Library for a
given Analyzer Script are specified on the 'Code Miner |
Libraries' page of the Script Editor.
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Services Script
The 'Services' page of an Analyzer Script describes the
default ports used when scripts are created by various Visual
Execution Analyzer functions (Import project, Generate
Executable StateMachine). You can update any of the Port
specifications on this page.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Private Options | Services' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Private
Options | Services' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Shift+F12
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Run Script
This section describes how to create a command for running
your executable code.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Run' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Run' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Ctrl+Alt+N

Script elements
Element
(c) Sparx Systems 2022
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Command

This is the command that is executed
when you select the 'Execute > Run >
Start' ribbon option; at its simplest, the
script would contain the location and
name of the file to be run.

Examples

These two examples show scripts
configured to run a .Net and a Java
application in Enterprise Architect.
.Net:
C:\benchmark\cpp\example_net_1\release
\example.exe
Java:
customer
The command listed in this field is
executed as if from the command prompt;
as a result, if the executable path or any
arguments contain spaces, they must be
enclosed by quotes.

Notes
·

Enterprise Architect provides the ability to start your
application normally OR with debugging from the same
script; the 'Analyzer' menu has separate options for
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starting a normal run and a debug run
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Deploy Script
These sections explain how to create a command script for
deploying the current Package. The script can be executed
by selecting the 'Execute > Source > Build > Deploy' ribbon
option or by pressing Ctrl+Shift+Alt+F12.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Deploy' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Deploy' page
Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Ctrl+Shift+Alt+F12

Actions
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Detail

Execute
Process
Command as: If the deployment is handled externally,
enter the path to the program or batch file
to run, followed by any parameters; the
program is launched in a separate
process.
Example:
C:\apache-ant-1.7.1\bin\ant.cmd
myproject deploy
Batch File
When using this option, you can enter
multiple commands that are then
executed as a single script in a command
console; you have access to any
environment variables available in a
standard command console.
Example:
@echo on
IF NOT EXIST "%1%" GOTO
DEPLOY_NOWAR
IF "%APACHE_HOME%" == ""
GOTO DEPLOY_NOAPACHE
xcopy /L "%1%"
"%APACHE_HOME%\webapps"
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GOTO DEPLOY_END
rem
rem NO WAR FILE
rem
:DEPLOY_NOWAR
echo "%1% WAR file not found"
GOTO DEPLOY_END
rem
rem NO APACHE ENVIRONMENT
VARIABLE
rem
:DEPLOY_NOAPACHE
echo "APACHE_HOME environment
variable not found"
:DEPLOY_END
pause
Parse Output
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Selecting a Parser from the list causes
output of the deploy script to be captured;
the output is parsed according to the
syntax selected from the list.
To display the System Output window,
select the 'Start > All Windows > Design
> Explore > System' ribbon option.
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Recording Scripts
The beauty of recording is not really that we always get to
see the bigger picture, but a chance to see a smaller picture
that has some truth to tell. We have all seen Sequence
diagrams that are less than helpful. (The same message
appearing 100 times in succession on a diagram does tell us
something, but not much.) Fortunately Enterprise Architect
takes care of this first point through the use of fragments.
Repeating behaviors are identified as Patterns and
represented once as a fragment on the Sequence diagram.
The fragment is labeled according to the number of
iterations. The recording history, of course, always shows
the entire history. We also need tools to help us focus the
recording on particular areas of interest and reduce the noise
from others. We can use filters to do this. With filters, you
can exclude any Classes, functions, or even modules from
any recording. You can create multiple sets of filters and use
them with marker sets to target different Use Cases.

Access
On the Execution Analyzer window, either:
· Locate and double-click on the required script and select
the 'Recording' page or
· Click on
in the window Toolbar, select the Package in
which to create a new script, and select the 'Recording'
page
(c) Sparx Systems 2022
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Ribbon

Develop > Source Code > Execution
Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer

Keyboard
Shortcuts

Shift+F12

Filter Strings
Element

Discussion

Filtering

If the 'Enable Filter' checkbox is selected
on the 'Recording' page of the Execution
Analyzer Script Editor, the debugger
excludes calls to matching methods from
the recording. The comparison is
case-sensitive.
To add a value, click on the 'New'
('Insert') icon in the right corner of the
'Exclusion Filters' box, and type in the
comparison string; each filter string takes
the form:
class_name_token::method_name_token
The class_name_token excludes calls to
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all methods of a Class or Classes that
have a name matching the token; the
string can contain the wildcard character
* (asterisk).
The method_name_token excludes calls
to methods having a name that matches
the token; again, the string can contain
the wildcard character *.
Both tokens are optional; if no Class
token is present, the filter is applied only
to global or public functions (that is,
methods not belonging to any Class).
Example

In this Java example, the debugger would
exclude:
· Calls to the OnDraw method for the
Class
Example.common.draw.DrawPane
· Calls to any method of any Class
having a name beginning with
Example.source.Collection
· Calls to any constructor for any Class
(such as <clint> and <init>)

In this Native Code example, the
debugger would exclude:
(c) Sparx Systems 2022
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·
·
·

·

Calls made to Standard Template
Library namespace
Calls to any Class beginning with TOb
Calls to any method of Class CLock
Calls to the method GetLocation for
Class CTrain
Calls to any Global or Public Function
with a name beginning with Get

Filters
Use Filter
Entry

To Filter

::Get*

All public functions having a name
beginning with 'Get' from the recording
session (for example, GetClientRect in
Windows API).

*::Get*

All methods beginning with 'Get' in any
Class.
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CClass::Get*

All methods beginning with Get for the
CClass Class.

CClass::*

All methods for CClass Class.

ATL*
std*

All methods for Classes belonging to
Standard Template and Active Template
Libraries.

CClass::GetN The specific method(s) GetName for the
ame
CClass Class.
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The Job Queue Window
The Job Queue window streamlines the process of working
with Analyzer Scripts, which originally were worked on
individually and if no other script was being executed. In
versions of Enterprise Architect from Release 16.0 onwards,
when an Analyzer Script context menu option is executed
(for example, 'Build') it is placed in a job queue; multiple
jobs can be queued, and other work performed while the
jobs are processed.
The name of the Analyzer Script is used as the name of the
job. An Analyzer Script can have multiple sections, such as
Build, Test, Run and Deploy, and each section is assigned as
a task of the job.

The output from each job executed from the Job Queue
window is captured to the 'Job History' tab in the System
Output window.

Access
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Execute > Tools > Analyzer > View Job
Queue
Start > All Windows > Design > Explore
> System > Job History

Job Queue Columns
Column

Description

Name

The name of the Analyzer Script for
which the job has been added to the Job
Queue. If the job has been executed, the
name will have a tick(for successful
completion) or exclamation mark (for
failure) in front of it.

Task

The section of the Analyzer Script that
the job is executing - for example, Build
or Deploy.

Status

The completion status of the job whether the job completed successfully
('OK') or failed.

Errors

If the job has been executed and failed,
the number of errors that arose.
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Completed

The date and time at which the job
completed.

Host

If the job is run remotely, the IP address
or host name of the remote machine.

Recvd

If the job is run remotely, any return
message from the host machine.

Context Menu Options
Right-click on a job name, or on the background of the
window, to display the 'Job Queue' context menu.

Option

Description

View Log

Select this option to display the 'Job
History' tab of the System Output
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window, for a job that has been executed.
Cancel Job

Right-click on a job name and click on
this option, as necessary and at any time,
to cancel the selected JavaScript task.
The cancellation is indicated in the Job
Queue window by a 'no entry' icon next
to the job name.

In the 'Job History' tab of the System
Output window, the output is terminated
with a 'Script Cancelled' message.

Delete Job
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Job Queue.
Re-Run Job

Select this option to execute the selected
completed job again.

Re-Run
Selected Jobs

(Ctrl+click on a number of required jobs.)
Select this option to execute all the
selected completed jobs again.

Re-Run
Completed
Jobs

Select this option to execute all the
completed jobs in the current list again.

The Job History Tab
The output from each job executed from the Job Queue
window is captured to the 'Job History' tab in the System
Output window. From there, any job log can be viewed at
your discretion, by selecting it from the drop-down list in
the toolbar. If the job has failed and there are error
messages, you can skip from message to message using the
red arrow icons. These icons are disabled if there are no
active error messages.
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Job Queue Toolbar Options
Option

Description
Click on a job name and click on this
icon to pause or resume the selected job.
Click on a job name and on one of these
two arrows to move the job up or down in
the job queue, making it earlier or later in
the order of processing.
Click on a job name for a job that has not
yet started, and on this icon to delete that
job from the Job Queue window.
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Click on the up or down arrow to set the
number of jobs that can run concurrently,
up to a maximum of 8.
The count defaults to 1 so that the Job
Queue will process jobs one at a time,
First In First Out.
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Build Application
This topic explains how to execute a Build script on your
application, within Enterprise Architect.

Access
Ribbon

Execute > Source > Build > Build

Keyboard
Shortcuts

Ctrl+Shift+F12

Other

'Build' toolbar >
Execution Analyzer window |

Action
When you select the 'Build' option, it executes the 'Build'
command in the script selected in the Execution Analyzer
window. The progress and outcome of the build operation
are displayed in the 'Build' tab of the System Output
window.
You can quickly visit the line of code for any compilation
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error appearing by double-clicking the error.
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Locate Compiler Errors in Code
When you build an application using an Analyzer Script,
compiler output is logged in the System Output window.
You can double-click on any error message that appears
here and be taken to the source code. When you do, the
cursor is positioned on the line containing the error.

Tip
If output is missing, check that a language parser is
mentioned in the Analyzer Script (Shift+F12).

Access
Start > All Windows > Design > Explore
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Ribbon

> System

Keyboard
Shortcuts

Ctrl+Shift+8
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Debugging

Enterprise Architect is more than a drawing tool - it also
provides every feature that you might expect in an IDE.
Comprehensive debugging environments and tools for many
major platforms are made available. Integrating the
debugging capability within the modeling tool allows code
to be developed, built and managed by its authors. Working
and collaborating in an integrated model has made actions
count and every action accountable in ways that are just not
possible using other tool chains.

Features
Speed
Debuggers in Enterprise Architect are quick! Stepping
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through programs will not take all day.
The Recording program can be executed without manual
stepping.
Support
· C++, C and Visual Basic
· Microsoft .NET, ASP.NET WCF
· Java, using socket transport (JDWP) or in memory model
(JVMIT)
· Android on an emulator or device
· JavaScript, VBScript and JScript
· PHP scripts on Apache web servers
· Remote Linux GDB processes using Enterprise Architect
on Windows
· Simulation - debug simulations in UML and BPMN
· Executable StateMachines - debug an executing
StateMachine
Isolation
The debuggers operate out-of-process from Enterprise
Architect, isolating it from side effects.
Efficiency
Starting and stopping the debugger is quick and painless. It
does not hold you back. Designed to be a responsive UI, the
main UI thread is isolated from duties that are not its
responsibility.
Productivity
Switch from modeling to requirements, from raising a
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change request to tracking code changes in a model shared
across an organization, to profiling recent code changes. All
in the one tool.

Notes
·

The debug and record features of the Visual Execution
Analyzer are not available for the Java server platform
'Weblogic' from Oracle
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Run the Debugger
Enterprise Architect provides a number of ways to start and
control a debug session. There is the main Debug window,
as well as a Debug toolbar and the 'Run' panel in the
'Execute' ribbon. It is always best to display the Debug
window whenever you are running a debug session, as this
is where all debug output is captured.

Access
Ribbon

Execute > Run > Start
Execute > Tools > Debugger > Start
Debugging

Keyboard
Shortcuts

Alt+8
(displays the Debug window)
F6
(begins execution of the
application being debugged)

Toolbar

Explore > Portals > Show Toolbar >
Debug

Using the Debug window
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Action

Detail

Start the
Debugger

When an Analyzer script has been
configured to support debugging, you can
start the debugger in these ways:
· From the ribbon, select 'Execute > Run
> Start > Run'
· From the ribbon, select 'Execute >
Tools > Debugger > Start Debugging'
· On the 'Debug' toolbar, click on the
button, or
· Press F6
You can also launch the debugger for any
script through its context menu in the
'Analyzer Script Window', or press
Shift+F12
If you have no Analyzer Script, it is still
possible to debug a running application
by attaching to that process directly:
· From the ribbon, select 'Execute >
Tools > Debugger > Attach to Process',
or
· On the 'Debug' toolbar, click on the
(Attach) button and choose the
debugging platform manually

Pause/Resum

You can pause a debugging session, or
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e Debugging

resume the session after pausing, in these
ways:
· From the ribbon, select 'Execute > Run
> Pause'
· On the 'Debug' toolbar, click on the
button

Stop the
Debugger

The debugger normally ends when the
current debug process terminates;
however, some applications and services
(such as Java Virtual Machine) might
require the debugger to be manually
stopped. To stop debugging, either:
· On the 'Debug' toolbar, click on the
(Stop) button
· Press Ctrl+Alt+F6
· Select the drop-down arrow on the
'Execute > Run > Stop' ribbon option
The ribbon option displays a short menu
providing three ways to terminate
debugging the application.

·
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·

·

default when you just click on the
ribbon icon)
Detach - stops the Debugger but leaves
the process running
Quit Application - stops the Debugger
and posts a WM_QUIT message to the
main window of the process, if it has
one

Step Over
Lines of
Code

To step over the next line of code:
· From the ribbon, select 'Execute > Run
> Step Over', or
· On the 'Debug' toolbar, click on the
(Step Over) button, or
· Press Alt+F6

Step Into
Function
Calls

To step into a function call:
· From the ribbon, select 'Execute > Run
> Step In', or
· On the 'Debug' toolbar, click on the
(Step In) button, or
· Press Shift+F6
If no source is available for the target
function then the Debugger returns
immediately to the caller.

Step Out Of
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From the ribbon, select 'Execute > Run
> Step Out'
· On the 'Debug' toolbar, click on the
(Step Out) button, or
· Press Ctrl+F6
If the debugger steps out into a function
with no source code, it will continue to
step out until a point is found that has
source code.
·

Show
Execution
Point

While the Debugger is paused, to return
to the source file and line of code that the
Debugger is about to execute:
· From the ribbon, select 'Execute > Run
> Start > Show Execution Point'
· On the 'Debug' toolbar, click on the
(Show Execution Point) button.
The appropriate line is highlighted, with a
pink arrow in the left margin of the
screen.

Output

During a debug session, messages display
in the Debug window detailing:
· Startup of session
· Termination of session
· Exceptions
· Errors
· Trace messages, such as those output
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using Java System.out or .NET
System.Diagnostics.Debug
If you double-click on a debug message,
either:
· A pop-up displays with more complete
message text, or
· If there has been a memory leak, the
file is displayed at the point at which
the error occurred
Save Output
(and Clear
Output)

You can save the entire contents of the
Debug output to an external .txt file, or
you can save selected lines from the
output to the Enterprise Architect
clipboard.
To save all of the output to file, click on
the
(Save output to file) button.
To save selected lines to the clipboard,
right-click on the selection and select the
'Copy Selected to Clipboard' option.
When you have saved the output or
otherwise do not want to display it any
more, right-click on the current output
and select the 'Clear Results' option.

Switch to
Profiler

If you are running a debug session on
code, you can stop the debug session and
immediately switch to a Profiling session.
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To switch from the Debugger to the
Profiler:
· From the ribbon, select 'Execute >
Tools > Debugger > Switch to Profiler'
· On the Debug window, click on the
'
| Switch to Profiler' option, or
· On the Debug toolbar, click on the '
| Switch to Profiler' option
The Profiler attaches to the
currently-running process.
This facility is not available for the Java
debuggers.
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Breakpoint and Marker Management
Breakpoints work in Enterprise Architect in the same way as
in any other Debugger. Markers are similar to breakpoints,
but in Enterprise Architect they have special powers. Simply
put, markers perform actions - such as recording execution
and analysis - that breakpoints do not. The action of a
breakpoint is always to stop the program.
You set any marker or breakpoint in the Source Code editor,
where they are visible in the left margin. Clicking in this
margin will add a breakpoint at that line. Breakpoints and
markers are interchangeable - you can change a breakpoint
into a marker and vice versa, using its 'Properties' dialog.
You can quickly view and edit a breakpoint or marker's
properties using Ctrl+click either on its icon in the editor
margin or in the Breakpoints and Markers window.
Breakpoints are maintained in sets. There is a default set for
each model and each breakpoint typically resides there, but
you can save the current breakpoint configuration as a
named set, create a new set and switch between them.
Breakpoint sets are shared; that is, they are available to the
model community. The exception is the Default set which is
a private and personal set allocated to each user of any
model.

Access
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Execute > Windows > Breakpoints
Simulate > Dynamic Simulation >
Breakpoints

Breakpoint and Marker Options
Option

Detail

Delete a
breakpoint or
marker

To delete a specific breakpoint:
· If the breakpoint is enabled, click on
the red breakpoint circle in the left
margin of the Source Code Editor, or
· Right-click on the breakpoint or marker
in the Source Code Editor, the
Breakpoints folder or the Breakpoints
& Markers window and select the
'Delete' option, or
· Select the breakpoint in the 'Debug
Breakpoints' tab and press the Delete
key

Delete all
breakpoints

Click on the Delete all breakpoints button
( ).
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Breakpoint
properties

In the Breakpoints window or code
editor, use the marker's context menu to
bring up the properties. Here you can
change the marker type, add or modify
constraints and enter trace statements.
(Useful shortcut: hold the Ctrl key while
clicking the marker, to quickly show its
properties.)

Disable a
breakpoint

Deselect the checkbox against the
breakpoint or marker.

Enable a
breakpoint or
marker

Select the checkbox against the
breakpoint or marker.

Disable all
breakpoints

Click on the

Enable all
breakpoints

Click on the Enable all breakpoints
button ( ).

Break when
memory
address is
modified

Click on the Data breakpoint button ( ).

Identify or
change the

Check the
field in the
Breakpoints & Events window toolbar.
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marker set

If necessary, click on the drop down
arrow and select a different marker set.
The Default set is normally used for
debugging and is personal to your user
ID; other marker sets are shared between
all users within the model.

Change how
breakpoints
and markers
are grouped
on the
Breakpoints
& Events
window

The breakpoints and markers can be
grouped by Class or by code file. To
group the items, click on the down arrow
on the
icon in the toolbar, and click
on the appropriate option. If you do not
want to group the items, click on the
selected option to deselect it; the
breakpoints and markers are then listed
by line number.

Breakpoint States
State

Remarks
Debug Running: Bound
Debug Not Running: Enabled
Debug Running: Disabled
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Debug Not Running: Disabled
Debug Running: Not bound - this usually
means that a module is yet to be loaded.
Also, dlls are unloaded from time to time.
Debug Not Running: N/a
Debug Running: Failed - this means the
debugger was unable to a match this line
of code to an instruction in any of the
loaded modules. Perhaps the source is
from another project or the project
configuration is out of date. Note, that if
the module date is earlier than the
breakpoint's source code date you will see
a notification in the debugger window.
The text is red in color so they will stand
out. This is clear sign that the project
requires building.
Debug Not Running: N/a

(c) Sparx Systems 2022

Page 187 of 449

Execution Analysis

3 October, 2022

Setting Code Breakpoints
Normal Breakpoints are typically set on a line of source
code. When the Debugger hits the indicated line during
normal execution, the Debugger halts execution and
displays the local variables, call stack, threads and other
run-time information.

Set a breakpoint on a line of code
Ste Action
p
1

Open the source code to debug in the integrated
source code editor.

2

Find the appropriate code line and click in the left
margin column - a solid red circle in the margin
indicates that a breakpoint has been set at that
position.

If the code is currently halted at a breakpoint, that
point is indicated by a blue arrow next to the marker.
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Alternatively, you can set the Breakpoint marker (or
other marker) by right-clicking on the left margin on
the required line, to display the breakpoint/marker
context menu; select the appropriate marker type.
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Trace Statements
A Trace Statement is a message that is output during
execution of a debug session. Trace statements can be
defined in Enterprise Architect without requiring any
changes to your application source code.
Tracepoint Markers are set in the code editor. Like
breakpoints, they are placed on a line of code. When that
line of code executes, the debugger evaluates the statement,
the result of which is logged to the Debug window (or to file
if overridden by the Analyzer script).

Access
Any existing Trace statements can be viewed and managed
in the Breakpoints & Markers window. The Breakpoints &
Markers window can be displayed using either of the
methods outlined here.
Ribbon

Execute > Windows > Breakpoints

Add a Tracepoint Marker
Ste Action
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p
1

Open the source code to debug in the source code
editor.

2

Find the appropriate code line, right-click in the left
margin and select the 'Add Tracepoint Marker'
option.
If a marker is already there, press Ctrl+click to show
the Breakpoint Properties window.

3

Ensure the 'Trace statement' checkbox is selected.

4

In the text field under the 'Trace statement'
checkbox, type the required Trace statement.

5

Click on the OK button. A Tracepoint Marker is
shown in the left margin of the code editor.

Specifying a Trace Statement
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A trace statement can be any freeform text. The value of any
variables currently in scope can also be included in a trace
statement by prefixing the variable name with a special
token.
The available tokens are:
· $ - when the variable is to be interpreted as a string
· @ - when the variable is a primitive type (int, double,
char)
Using our example in the image, we could output the
number of people getting off a train by using this statement:
There were @Passengers before @PeopleOFF got off the
train at $Arriving.Name Station
In addition to tracing the values of variables from your code,
you can use the $stack and $frame keywords in your Trace
statement to print the current stack trace; use:
· $stack - to print all frames, or
· $frame[start](count) - print a specific number of frames
from the stack starting at a given frame; for example,
$frame[0](5) will print the current frame and 4 ancestors

Notes
·

Trace statements can be included on any type of
breakpoint or marker.
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Break When a Variable Changes Value
Data breakpoints can be set on a pre-determined memory
variable to cause the debugger to halt execution at the line
of code that has just caused the value of the variable to
change. This can be useful when trying to track down the
point at which a variable is modified during program
execution, especially if it is not clear how program
execution is affecting a particular object state.

Access
Ribbon

Execute > Windows > Local Variables :
Right-click on variable > Break When
Variable is Modified or
Execute > Windows > Watches :
Right-click on variable > Break When
Variable is Modified

Other

In a code editor window: Right-click on
the variable of interest | Break when item
modified

Capture changes to a variable using data
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breakpoints
Ste Detail
ps
1

Set a normal breakpoint in the code so you can
choose a variable. Then run the debugger (F6).

2

When the program has hit the breakpoint, select the
variable of interest and from its context menu, select
the 'Break When Variable is Modified' option.

3

There are no breakpoint indicators in the code, but
data breakpoints are easily recognizable in the
Breakpoints & Events window, being a blue icon
with a white diamond. Enterprise Architect displays
the name of the variable and its address instead of a
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line number.

4

With the data breakpoint set, you can disable any
other breakpoints you might have. The program will
stop at any line of code that changes this variable's
value. Now run your program.

5

When this variable is modified, the debugger halts
and displays the current line of code in the editor.
This is not the line that caused the break, but the line
of code following the event. The event is logged to
the Debug window.

Now we know how and where this value (its State)
has changed. For example, the statement at line 58
has just updated the number of Passengers.
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Having discovered this and other places where this
value is being changed, be sure to get rid of the
notification before moving on. You can delete the
data breakpoint quickly by selecting it in the
Breakpoints window and pressing the Delete key.
You can also use the right-click context menu to do
this.

Notes
·

This feature is not presently supported by the Microsoft
.NET platform
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Trace When Variable Changes Value
When your code executes, it might change the value of a
variable. It is possible to capture such changes and the
variable's new value, on the Debug window. You can then
double-click on the change record to display the line of code
that caused the change, in the Code Editor.

Access
Ribbon

Execute > Windows > Local Variables :
Right-click on variable > Trace When
Variable is Modified or
Execute > Windows > Watches :
Right-click on variable > Trace When
Variable is Modified

Other

In Code Editor | Right-click on variable |
Trace When Variable Modified

Set up Trace
The variable you are tracing must be in scope, so to identify
and select it, set a normal breakpoint on the line of code
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where you know that the variable will exist. When the
debugger reaches this breakpoint, locate the variable and use
its context menu to enable the trace.
To locate a variable:
· If you see the variable in the source code, hover over it,
right-click and select the 'Display variable' option;
Enterprise Architect will locate it
· If the variable is in scope (a local, or 'this' or a member of
'this'), look for it in the Locals Window ('Execute >
Windows > Local Variables')
· If the variable is global (C, C++), display the Watches
window ('Execute > Windows > Watches') and search for
it by name
· If the variable is a Class static member, display the
Watches window ('Execute > Windows > Watches') and
enter its fully qualified name
Once trace is enabled, you can disable all other breakpoints
and let the program run. Each time the variable changes
value, it will be logged to the 'Output' tab of the debugger.
Check the change in value and double-click on the line to
display the code in the Code Editor.

Notes
·

·

The debugger does not halt when the change event occurs,
it only logs the change
This facility is available on the Microsoft Native and Java
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platforms
Microsoft .NET does not support breakpoints on values
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Detecting Memory Address Operations
Being able to detect where and when an area of memory is
being read or written can be a great help for investigators,
even when the code base is well understood. Without this
tool, a C++ developer could have a potentially daunting task
of tracking where and when a global variable is accessed,
and debugging those functions. Data breakpoints allow a
C++ programmer to track when a variable / memory
location is read or when it is written. When the operation is
detected, the debugger will halt the execution and the line of
code following the operation will be displayed in the code
editor.

Access
Ribbon

Execute > Windows > Breakpoints

Detect operation on memory address
Ste Action
p
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1

Click the

2

Enter the memory address to watch. You can copy
an address from the Locals (Local Variables)
window.

3

Select the operation to detect. If you select 'Write',
the debugger will break when the address is written
to. If you choose 'Read / Write', the debugger will
notify you when the address is read or when it is
written.

4

Select the action to perform. If you choose 'Break',
the debugger will halt the program and the line of
code will be shown in the editor. If you choose
'Trace', the debugger will not halt execution, but log
any operation on the address as it occurs. This output
is displayed in the Debugger Window.

5

The data breakpoint is added to the Breakpoints and
Markers window.
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6

You can use the context menu on the data breakpoint
to check the value at the memory address.

7

To delete a data breakpoint, select it in the
Breakpoints and Markers window and press the
Delete key. Alternatively, deselect the checkbox next
to it. Data breakpoints are deleted when they are
disabled; they do not persist as other breakpoints do.

System Requirements
Memory address breakpoints are supported in the C/C++
native debugger.
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Breakpoint Properties
Breakpoints have a number of additional properties that
determine what occurs when executing the line of code that
the breakpoint applies to.
These properties define:
· The action to be performed
· The line of code that the breakpoint applies to
· Constraints that determine whether or not the action is
performed when the breakpoint is hit
· Trace information to be output when the breakpoint is hit

Access
There are several ways to display the 'Breakpoint Properties'
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dialog:
Code Editor

·

·
·

Breakpoints
& Markers
window

·

Right-click on a breakpoint marker |
Properties or
Ctrl+Click on breakpoint marker or
Right-click on code that has a
breakpoint marker | Breakpoint |
Properties
Right-click on breakpoint | Properties

Options
Field

Details

Action

The behavior when the breakpoint is hit.

Line

The line of source code that this
breakpoint applies to.

Stack Height

For Stack Capture markers, the number of
caller frames to record. To record the
entire Stack, set the value to 0.
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Constraints

Defines the condition under which the
breakpoint action will be taken. For
normal breakpoints this would be the
condition that halts execution. In this
example, for a normal breakpoint,
execution would stop at this line when
the condition evaluates to True.
Constraints are evaluated each time the
line of code is executed.
(this.m_FirstName="Joe") AND
(this.m_LastName="Smith")

Trace
statement

A message output to the Debug window
when the breakpoint is hit. Variables
currently in scope can be included in a
trace statement output by prefixing the
variable name with a $ token for string
variables, or an @ token for primitive
types such as int or long. For example:
Account $pAccount->m_sName has a
balance of @pAccount->m_fBalance
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Failure to Bind Breakpoint
A breakpoint failure occurs if there is a problem in binding
the breakpoint. Breakpoint failures are most often caused by
source files being changed without the application being
rebuilt. Breakpoints can sometimes bind to a different line,
causing them to be moved. If a breakpoint cannot be bound
to the binary at this line or the three lines following it, it is
displayed with a question mark.
A warning message displays in the 'Details' column of the
Breakpoints & Events window, identifying the type of
problem:
· The source file for the breakpoint does not match the
source file used to build the application image
· The time date stamp on the file is greater than that of the
image
A warning message is also output to the Debug window.
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Debug a Running Application
Rather than starting a process explicitly from within
Enterprise Architect, you might want to debug an
application (process) that is already running on your system.
In this case you can use the debugging capability to attach to
the process that is already running. Provided you have the
appropriate debug information written into the running
process, and/or associated debug files (such as .PDB files),
the debugger binds to that process and initiates a debug
session.
You can also 'detach' from the process after you have
completed your inspection and leave the process to run as
normal.

Access
Ribbon

Execute > Run > Start > Attach to
Process

Debugger
Window

The debugger window toolbar has an
Attach button

Stages
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Stage

Description

Show
Processes

When you select to debug another
process, the 'Attach To Process' dialog
displays.
You can limit the processes displayed
using the radio buttons at the top of the
dialog; to find a service such as Apache
Tomcat or ASP.NET, select the System
radio button.

Select
Debugger

When you select a process, you might
have to choose the debugger from the
Debugger dropdown list; however, if the
selected Package has already been
configured in an Analyzer Script, then the
debugger listed in the script is preset on
the dialog.

Process
Selection

Once you double-click on a process
containing debug information, and
Enterprise Architect is attached to the
process:
· Any breakpoints encountered are
detected by the debugger
· The process is halted when a
breakpoint is encountered, and
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Detach From
Process
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Debug window

To detach from a process, click on the
(Debug Stop) button.
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View the Local Variables
The Locals window displays variables of the executing
system. Whether you are recording C#, debugging Java,
C++ or VBScript, debugging an Executable StateMachine,
or running a simulation, this window is where the system's
variables are located. Current values are only displayed
when a program is halted. This occurs when a breakpoint is
encountered during debugging, when you step over a line of
code or when you step between States in a simulation.

Access
Ribbon

Execute > Windows > Local Variables
Simulate > Dynamic Simulation > Local
Variables

Context
Menu

In Code Editor | Right-click on any
variable identifier > Display Variable

Icons
The value and type of any in-scope variable is displayed in a
tree; each variable has a colored box icon that identifies the
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type of variable:
· Blue - Object with members
· Green - Arrays
· Pink - Elemental types
· Yellow - Parameters
· Red - Workbench instance

Finding variables
The easiest way to find a variable is to first locate it in the
code editor and use the right-click context menu on the
variable, selecting 'Display Variable'. Enterprise Architect
will find and reveal any variable in scope, including deeply
nested members. If the variable is found in a different scope
(global, file, module, static), it will be displayed in the
Watches window (see View Variables in Other Scopes).
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Persistent View
The examination of variables usually involves digging
around in the tree to expose the values of interest. It can be
annoying then, having gone through that trouble, to step to
the next line of code, only to have those variables buried
from sight again due to a change in context. The Locals
window has a persistent view that lingers for a while after a
run or step command. When you step through a function in
Enterprise Architect, the variables structure persists line
after line. This makes stepping through a function quick and
easy.

What changed
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As part of the persistent view, the Locals window tracks
changes to values and highlights them.

Context Menu
Facility

Detail

Break When
Variable is
Modified

Set data breakpoints on the selected
memory variable to halt debugger
execution at the line of code that has just
caused the value of the variable to
change.

View
Memory at
Address

Display the raw values in memory at the
selected address, in hex and ASCII.

Show in
String
Viewer

Display the variable string in the 'String
Viewer' dialog.
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Dump
Variable
Members to
File

Capture and store the selected variables
to a separate location; a browser displays
to select the appropriate .txt file name and
file path.

Save
Snapshot of
Variable

Capture the value of a variable at a
specific point in the life of that variable.

Compare
Variable
Snapshots

Compare the values of a variable at
different points in the life of that variable.

Copy

Copy the selected variable to the
Enterprise Architect clipboard.

Add Instance
Run State to
Diagram

If you have opened a model diagram
containing an Object of the Class for
which the source code is being debugged,
this option updates that Object with the
Run State represented by the variable
value.

Set
Conditional
Breakpoint

Add a breakpoint at the current execution
position with a constraint for this variable
matching its current value.
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View Content Of Long Strings
For efficiency, the Locals window only shows partial
strings. However, you can display the entire contents of a
string variable using the 'String Viewer'.

This example shows the value of a variable holding the
contents of an XML schema file.

(c) Sparx Systems 2022

Page 218 of 449

Execution Analysis

3 October, 2022

Access
From Code
Editor or
Locals
window
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Right-click on string variable | Show in
String Viewer
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View Debug Variables in Code Editors
When a breakpoint occurs, you will see all the local
variables in that window. You can also inspect variables in
the Source Code Editor by hovering your mouse over the
reference. Here are some examples.

Note: The variable does not have to be one of the local
variables. It can have a file or module scope.
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Variable Snapshots
It is possible to take a 'snapshot' of a variable when your
program hits a breakpoint and use this snapshot to see how
the value of the variable changes at different points in its
life. The debugger does not copy the value of the selected
variable only; for complex variables it copies the values of
the selected variable and of each of its hierarchy of members
until it can no longer find any more debug information for a
member or no more members can be found.

Capture Variable Snapshot
Ste Action
p
1

In the Code Editor, set two breakpoints: one at the
start of a function and another at the end of the
function.

2

At the start breakpoint, right-click on a variable in
the Locals window and select the 'Save Variable
Snapshot' menu option.

3

Run the application.

4

When the end breakpoint is reached, right-click on
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the variable in the Locals window and select the
'Compare Variable Snapshots' option.
A dialog displays that shows the original value from
the first snapshot and the current value from the
second snapshot as illustrated in this diagram taken
from the EA.Example model.

Save Variable Snapshot to File
You can save the state of a variable to file using its
right-click context menu.
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This is an excerpt of the file contents.
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Actionpoints
Actionpoints are breakpoints that can perform actions.
When a breakpoint is hit, the Actionpoint script is invoked
by the debugger, and the process continues to run.
Actionpoints are sophisticated debugging tools, and provide
expert developers with an additional command suite. With
them, a developer can alter the behavior of a function,
capture the point at which a behavior changes, and
modify/detect an object's state. To support these features,
Actionpoints can alter the value of primitive local and
member variables, can define their own
'user-defined-variables' and alter program execution.

User-Defined Variables in Actionpoints and
Breakpoints
User Defined Variables (UDVs):
· Provide the means for setting a UDV primitive or string in
Actionpoint statements
· Can be used in condition statements of multiple
markers/breakpoints
· Can be seen easily in the same Local Variables window
· The final values of all UDVs are logged when debugging
ends.
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In the UDV syntax, the UDV name:
· Must be preceded by a # (hash) character
· Is case-insensitive

Actionpoint Statements
Actionpoint statements can contain set commands, goto
commands and jmp commands.

set command
Sets variable values. An Actionpoint statement can contain
multiple 'set' commands, all of which should precede any
'goto' command.
The 'set' command syntax is:
set LHS = RHS
Where:
· LHS = the name of the variable as a:
- user defined variable (UDV) such as #myval
- local or member variable such as strName or
this.m_strName
· RHS = the value to assign:
- As a literal or local variable
- If a literal, as one of: integer, boolean, floating point,
char or string
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set command - Variable Examples
UDV
Examples

Local Variable Examples

set #mychar
= 'a'

set this.m_nCount=0

set #mystr =
"a string"

set bSuccess=false

set #myint =
10
set #myfloat
= 0.5
set #mytrue =
true

goto command
This command switches execution to a different line number
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in a function. An Actionpoint statement can contain only
one goto command, as the final command in the statement.
The goto command syntax is:
goto L
Where L is a line number in the current function.
The goto command uses breakpoints to achieve its goal,
which causes a slight delay in code execution. This can be
noticeable in regions of code that are executed very
frequently, so you might prefer to use the jmp command in
such code, to achieve the same diversion of execution but
with less delay.

jmp command
The jmp command is effectively the same as the goto
command.
jmp 125
goto 125
Both these commands cause the execution to be changed to
line 125.
However the jmp statement internally uses instrumentation
to direct the program to move execution, whereas the goto
statement uses breakpoints to do that, which causes a delay
in processing. The difference is, therefore, superior
performance for the jmp statement, especially where regions
of code are executed very frequently.
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Integer operators
Where a User Defined Variable (UDV) exists and it is of
type int, it can be incremented and decremented using the
++ and -- operators. For example:
1. Create a UDV and set its value and type to a local integer
variable.
AP1: set #myint = nTotalSoFar
2. Increment the UDV.
AP2: #myint++
3. Decrement the UDV.
AP3: #myint--

Timer operations
Actionpoints can report elapsed time between two points.
There is only one timer available, which is reset or started
with the startTimer command. The current elapsed time can
then be printed with the printTimer command. Finally, the
total elapsed time is printed and the timer ended with the
endTimer command.

Example Actionpoint Conditions
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With Literals and constants:
· (#mychar='a')
· (#mystr <> "")
· (#myint > 10)
· (#myfloat > 0.0)
With Local Variables:
· (#myval == this.m_strValue)
· (#myint <> this->m_nCount)
· (#myint != this->m_nCount)

Instruction Recording
Instruction recording can be useful for detecting changes to
a known behavior; the point in execution (B) that diverges
from a previous execution(s) (A). The commands are:
· recStart - starts recording or starts comparing if a previous
recording exists
· recStop - ends recording
· recPause - pause recording
· recResume - resumes recording
The recStart command begins recording instructions.
Executed instructions are then stored. When a recStop
command is encountered, the recording is saved. There can
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only be one saved recording at any one time between two
Actionpoints. When a recStart is encountered and a
previous recording exists, the debugger will begin
comparing each subsequent instruction with its recording. It
could perform many comparisons. If and when a difference
is detected, the debugger will break and the line of code
where the behavior changed will be displayed in the code
editor. The iteration of the comparison is also printed.
The recording is stored in memory by default, but it can also
be stored to a file with the command syntax:
recStart filesspec
For example:
recStart c:\mylogs\onclickbutton.dat
When a recStart command is encountered that specifies a
file, and that file exists, it is loaded into memory and the
debugger will immediately enter comparison mode.

Expressions
There is no implicit precedence in Breakpoint, Actionpoint
and Testpoint conditional expressions. In complex
expressions, the use of parentheses is mandatory. See these
examples:
Type

Example

Actionpoint

(#myint=1) AND (#mystr="Germany")
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UDV
example
Local
variables
examples

(this.m_nCount > 10) OR (nCount%1)
(this.m_nCount > 10) OR (bForce)

Equality
operators in
conditional
expressions

<>
- Not Equal
!= - Not Equal
==
- Equal
= - Equal

Assignment
operator in
Actionpoint

= - Assigns RHS to LHS

Arithmetic
operators in
conditional
expressions

/ - division
+ - plus
- - minus
* - multiplication
% - modulus

Logical
operators in
conditional
expressions

AND - both must be true
OR - one must be true
&& - both must be true
|| - one must be true
^ - exclusive OR (only one must be true)
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View Variables in Other Scopes
Access
Ribbon

Execute > Windows > Watches

Other

Execution Analyzer window toolbar :
| Watches

Views
View

Description

Watches

The Watches window is most useful for
native code (C, C++, VB) where it can be
used to evaluate data items that are not
available as Local Variables - data items
with module or file scope and static Class
member items.
You can also use the window to evaluate
static Class member items in Java and
.NET
To add a watch, type the name of the
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variable to watch in the toolbar, and press
the Enter key.
To examine a static Class member
variable in C++, Java or Microsoft .NET,
enter its fully qualified name:
CMyClass::MyStaticVar
To examine a C++ data symbol with
module or file scope, just enter its name.
Variables are evaluated by looking at the
current scope; that is, the module of the
current stack frame (you can change the
scope at a breakpoint by double-clicking
the frame in the Call Stack).
If the global variable exists in a different
module, you can examine the variable by
prefixing the module name to the variable
modulename!variable_name
It is quite easy to mistype data item
names, so if you make or find an error,
highlight the string, press F2 and retype
the text. This also speeds up the
resolution of named items in the
debugger, by breaking a search when
matching item are discovered.
History
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the Up arrow key and Down arrow key
inside the toolbar text box. The history
will also persist for the user across any
instance of Enterprise Architect or model
on the same machine.
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View Elements of Array
You can use the Watches window to inspect one or more
specific elements of an array.
In the field to the left of the Watches window toolbar, type
the variable name of the array followed by the start element
and the number of elements to display. The start element is
enclosed in square brackets and the count of elements is
enclosed in parentheses; that is:
variable[start_element](count_of_elements)
For example, Points[3](2) displays the fourth and fifth
elements of the Points array, as illustrated.

If you entered Points[3] the Watches window would show
the third array element only.

Access
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Ribbon

Execute > Windows > Watches

Other

Execution Analyzer window toolbar :
| Watches
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View the Call Stack
The Call Stack window is used to display all currently
running threads in a process. It can be used to identify which
thread is operational, immediately before program failure
occurs.
When a Simulation is active, the Call Stack will show the
current execution context for the running simulation. This
will include a separate context stack for each concurrent
simulation 'thread'.
A stack trace is displayed whenever a thread is suspended,
through one of the step actions or through encountering a
breakpoint. The Call Stack window can record a history of
stack changes, and enables you to generate Sequence
diagrams from this history.

Access
Ribbon

Execute > Windows > Call Stack

Other

Execution Analyzer window toolbar :
| Call Stack

Use to
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View stack history to understand the execution of a
process
View threads
Save a call stack for later use
Record call stack changes for Sequence diagram
generation
Generate a Sequence diagram from the call stack
View the related code line in the Source Code Editor

Facilities
Facility
Indicators

Description
·

·

·

Save a Call
Stack to a
.TXT File
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A pink arrow highlights the current
stack frame
A blue arrow indicates a thread that is
running
A red arrow indicates a thread for
which a stack trace history is being
recorded

Not currently available.
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Record a
Thread in a
Debug
Session

To record the execution of a thread and
direct the recording to the Record &
Analyze window, right-click on the
thread in the Call Stack and select the
appropriate context menu option:
· 'Record' - to manually record the
current thread during the debug session
Used in conjunction with the 'step'
buttons of the debugger; each function
that is called due to a step command is
logged to the Record & Analyze
window
· 'Auto-Record' - to perform
auto-recording during a debug session
When you select this icon, the
Analyzer begins recording and does not
stop until either the program ends, you
stop the debugger or you click on the
'Stop' icon

Stop
Recording

If you have started a manual or automatic
recording of a thread you can stop it
before completion; select the thread
(indicated by a red arrow) and either:
· Click on the
(Stop Recording)
button in the toolbar or
· Right-click and select the 'Stop' option

Generate a

To generate Sequence diagram from the
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Sequence
Diagram
from the Call
Stack

Call Stack trace, either:
· Click on the
(Generate Sequence
Diagram of Stack) button, or
· Right-click and select the 'Generate
Sequence Diagram' option

Copy Stack
to Recording
History

To add the stack details immediately to
the Record & Analyze window (for later
generation of Sequence diagrams) either:
· Click on the
button, or
· Right-click and select the 'Copy Stack
to Record History' option

Toggle Stack
Depth

To toggle between showing the full stack
and showing only frames with source,
click on the
(Toggle Stack Depth)
button.

Display
Related Code
in Source
Code Editor

Double-click on a thread/frame to display
the related line of code in the Source
Code Editor; local variables are also
refreshed for the selected frame.
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Create Sequence Diagram of Call Stack
The Call Stack window records a history of stack changes
from which you can generate Sequence diagrams.

Access
Ribbon

Execute > Windows > Call Stack

Other

Execution Analyzer window toolbar :
| Call Stack

Use to
Record Call Stack changes for Sequence diagram
generation
· Generate a Sequence diagram from the Call Stack
To generate a Sequence diagram from the current Stack,
click on the (Generate Sequence Diagram of Stack)
button on the Call Stack window toolbar.
This immediately generates a Sequence diagram in the
Diagram View.
·
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Inspect Process Memory
Using the Memory Viewer, you can display the raw values
of memory in hex and ASCII. You can manually define the
memory address in the 'Address' field (top right), or
right-click on a variable in the Locals window or Watches
window and select the 'View Memory at Address' option.

Access
Ribbon

Execute > Windows > Memory Viewer

Other

Execution Analyzer window toolbar :
| Memory Viewer
From Locals window or Watches window
: Right-click on a variable | View
Memory at Address

Notes
·

The Memory Viewer is available for debugging Microsoft
Native Code Applications (C, C++, VB) running on
Windows or within WINE on Linux
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Show Loaded Modules
For .NET and native Windows applications, you can list the
DLL's loaded by the debugged process, using the Modules
window. This list can also include associated symbolic files
(PDB files) used by the debugger.

Access
Ribbon

Execute > Windows > Modules

Modules Window display
Column

Description

Path

Shows the file path of the loaded module.

Load
Address

Shows the base memory address of the
loaded module.

Modified
Date

Shows the local file date and the time the
module was modified.
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Debug
Symbols

Shows:
· The debug symbols type
· Whether debug information is present
in the module, and
· Whether line information is present for
the module (required for debugging)

Symbol File
Match

Indicates the validity of the symbol file; if
the value is false, the symbol file is out of
date.

Symbol Path

Shows the file path of the symbol file,
which must be present for debugging to
work.

Modified
Date

Shows the local file date and time the
symbol file was created.
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Process First Chance Exceptions
Access
Ribbon

Execute > Tools > Debugger > Process
First Chance Exceptions

Other

Debug window toolbar :
First Chance Exceptions

| Process

Processing Elements
Element

Description

Debug
Process

When an application is being debugged
and the debugger is notified of an
exception, the application is paused and
the debugger responds in the way it is
configured to do; it either:
· Resumes the application and leaves the
exception to the application to manage,
or
· Keeps the application suspended and
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passes the exception to the appropriate
routines for automatic resolution or
manual intervention
Second
Chance
Exceptions

The Enterprise Architect debugger
defaults to the first listed behavior.
If the application can handle the
exception, it continues to process; if it
cannot handle the exception, the
debugger is notified again and this time it
must suspend the application and resolve
the exception condition.
In this behavior, because the debugger
has encountered the exception twice, it is
known as a second-chance exception; in
this case, if the exception does not halt
execution, it is ignored and you avoid
spending time on conditions that do not
impact the overall outcome of processing.
You might work this way on large or
complex systems that invariably involve
exception conditions somewhere in the
processing paths.

First Chance
Exceptions

However, if you want to examine every
exception that occurs as soon as it occurs,
you can set the debugger to adopt the
second behavior.
Because the debugger responds to the
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exception on first contact, it is known as
a first-chance exception.
You might work this way with individual
functions or routines that must work
cleanly or not at all.
Selection
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Select the 'Process First Chance
Exceptions' option to debug exceptions
on first contact.
Deselect the option to process exceptions
only if the application fails when they
occur.
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Just-in-time Debugger
You can register the Enterprise Architect debugger as the
operating system Just-in-time debugger, to be invoked when
an application running outside Enterprise Architect on the
system either encounters an exception or crashes. When you
do so, an application crash will cause Enterprise Architect to
be opened, and the source and reason for the crash
displayed.

Access
Ribbon
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Execute > Tools > Debugger > Set as JIT
Debugger
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Services
Enterprise Architect provides two services to facilitate
remote script execution and remote debugging. The services
primarily support Enterprise Architect running on Linux to
allow users to run native Linux shell scripts and debug
Linux programs. The Satellite service supports Analyzer
Scripts while the Agent service supports debugging.

Access
Ribbon

Execute > Tools > Services

The Satellite Service
The Satellite service is responsible for executing Analyzer
Scripts on the machine on which it is running. The feature
can help Linux users to execute native Linux programs and
shell commands directly, bypassing Wine. The service can
be managed from the ribbon, and it can also be run
independently from a terminal.
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The Linux Shell
The default shell used by Enterprise Architect is 'bash'. To
override the Linux Shell used by Enterprise Architect, open
a Linux terminal, run 'wine regedit ' and add a string value
to this registry key:
HKEY_CURRENT_USER\Software\Sparx
Systems\EA400\EA\Options
where:
· key name: "LINUX"
· key value: path
and path is the Linux path to the shell program "/bin/bash",
for example.

Permissions
Under Linux you must check that the service programs have
the appropriate permissions. The programs are located under
the Enterprise Architect installation folder, in the sub
directory 'VEA/x86/linux'. Check that each of the programs
in this directory has the execute permission set for the
owner.

Notes
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The Satellite services are enabled in the Unified and
Ultimate Editions of Enterprise Architect

The Agent Service
The Agent service is responsible for managing debugging
sessions for Enterprise Architect's GDB debugger. The
service allows Enterprise Architect users to debug Linux
programs. The service can be managed from the ribbon. It
can also be run independently from a terminal.

The Services Menu
Option

Description

View Status
of all
Service(s)

Displays a View that lists the status of
each Enterprise Architect service named
in the config file, and its state.

Satellite
Service
Start

(c) Sparx Systems 2022

Starts the service. The service listens on
the Satellite Port configured in any
Analyzer Script Services Page.
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Stop

Stops the service.

Test

Tests the status of the Satellite Service,
whether it is running or not.

Agent
Service
Start

Starts the service. The service listens on
the Agent Port configured in an Analyzer
Script Services Page.

Stop

Stops the service.

Test

Tests the status of the Agent Service,
whether it is running or not.

Code Miner
Service
Start
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This option reads the current Service
Configuration file and starts services that
are configured to run, and stops running
services that are not configured to run. A
service is configured if:
1. It is named in the config file.
2. It has the attribute status:ON.
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Stop All

This option stops any services that are
currently running.

Edit
Configuratio
n File

This option prompts for the Service
Configuration file to use, then opens that
file in an Enterprise Architect text editor.
The system remembers where the file is
held.
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This option automatically starts services
having the 'status:ON' attribute when the
model opens.

The messages logged to the System
Output window here when the model is
opened indicate that the service was
already running.
Auto Stop on
Close
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This option automatically stops running
services when Enterprise Architect is
closed down.
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Analyzer Services Window
The Analyzer Services window displays the status of each
of:
· The services being managed by the active Analyzer Script
(maintained through the 'Execute > Tools > Analyzer'
ribbon option)
· Any local services managed separately using the service
configuration file (available from the 'Execute > Tools >
Services > Code Miner Service > Edit Configuration File'
ribbon option)

The window lets you see at a glance which intel service you
are using, for example, or that the Windows service you use
to work in Enterprise Architect is running.
All of the data in the window is read-only, but you can edit
the service by clicking on the Edit button. This displays the
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'Private Options - Services' page of the Analyzer Scripts
Editor window, which you can update as required.

Access
Ribbon

Execute > Tools > Services > View
Status of All Services
Start > All Windows > Execute >
Analyze | Analyzer Services

Keyboard
Shortcuts

Alt+4 | Analyze | Analyzer Services

Analyzer Services Window Fields
Field

Description

Computer

The work station on which the services
are running.

System

The operating system under which the
work station is running.

EA

The release number and build number of
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the version of Enterprise Architect you
are using.
Model

The name of the model in which you are
currently working.

Type

The type of service. The services listed as
type 'Sparx' are Enterprise Architect
Services.

O/S

The operating system under which the
service runs.

Name

The name and description of the service.
· The Linux Satellite Service is managed
automatically by Enterprise Architect
when the application is running on
Linux under WINE
· The Windows Satellite Service is an
optional service that is typically used in
WINE installations to help build Visual
Studio Projects on a remote Windows
machine such as a VM (Virtual
Machine); the service only runs on
Windows and is managed locally using
Windows Services on the machine
itself

Source

The script group or configuration file
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defining the service.
Status

The status of the service.
When you first open the window, each
service initially has the Status 'Test' as the
system assesses the service. The Status
then changes to the appropriate value,
such as 'Running' or 'Stopped'.

Edit

Click on this button to view or edit the
service definition.
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Recording

Sequence diagrams are a superb aid to understanding
behavior. Class Collaboration diagrams also can be helpful.
In addition to these, sometimes a Call Graph is just what we
need. Then again, if you have this information available,
you could use it to document a Use Case, and why not build
a Test domain while you are at it? The Enterprise Architect
Analyzer can generate all of these for you and from a single
recording. It does this by recording a running program, and
it works on all of the most popular platforms.

Access
Ribbon
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Overview
At its simplest, a Sequence diagram can be produced in very
few steps, using even a brand new model. You do not even
have to configure an Analyzer Script. Open the Enterprise
Architect code editor (Ctrl+Shift+O), place a recording
marker in a function of your choice, and then attach the
Enterprise Architect Debugger to a program running that
code. Any time that function is called, its behavior will be
captured to form a recording history. From this history these
diagrams can be easily created.

The Sequence diagram from the Example Model recording.

(c) Sparx Systems 2022

Page 263 of 449

Execution Analysis

3 October, 2022

The Class Collaboration diagram from the same recording.

The Test Domain diagram from the same recording.
Of course, an Analyzer Script is still the best idea, and
opens up an incredibly rich development environment, but it
is worth noting that significant results can be obtained
without one. This is also true of the Enterprise Architect
Debugger and Profiler tools.
A point of interest: you can view a thread's behavior while it
is recorded. Showing the Call Stack during a recording will
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show updates to a thread's stack in real-time, much like an
animation. It is a good feedback tool and in some
circumstances it might be all that is required.

Features at a glance
Diagram Generation
· Sequence diagram
· Class Collaboration diagram
· Test Domain diagram
· State Transition capture
· Call Graph
Control
· Support multi-threaded and single-threaded models
· Support stack depth control
· Support filters to restrict capture
· Filter wildcard support
· Real-time stack update
Integration
(c) Sparx Systems 2022
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Class Model
Test Domain
StateMachine
Executable StateMachines
Unit Tests

Platforms
·
·
·
·
·
·

Microsoft .NET
Microsoft Native
Java
PHP
GDB
Android

Requirements
·

Recording is available to users of all editions of
Enterprise Architect

Notes
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The debug and record features of the Visual Execution
Analyzer are not supported for the Java server platform
'Weblogic' from Oracle
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How it Works
This topic explains how the Visual Execution Analyzer
generates Sequence diagrams.

Explanation
Points

Detail

Usage

The Visual Execution Analyzer enables
you to generate a Sequence diagram from
recordings of the live execution of an
application. As the application runs, the
history of each thread is recorded. This
history can be used to generate the
Sequence diagram.
This is a Sequence diagram generated
from a program that calculates the price
of books:
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How does the recorder know what to
record?
· The recorder works from recording
markers; these are placed by you in the
functions of interest
Call Stacks in Java can stretch further
than the eye can see. How can we restrict
the recording to just ten frames?
· The recorder is controlled by the depth
either set on the recorder toolbar or
associated with a Marker Set stored in
the model
Its the real
thing
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In recording, the target application is not
modified; no instrumentation of any
image or module occurs at all. A
recording produced using a 'Release'
Page 269 of 449

Execution Analysis

3 October, 2022

build of a program is a trustworthy
document of what a program did.
Where do
you start
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We have a very large server application;
so where do we start? If you have little or
no understanding of the program you
intend to record and little or no model to
speak off, you might be best starting with
the Profiler. Running the Profiler whilst
using a program in a specific manner can
quickly identify Use Cases from the entry
points and Call Graphs presented. Having
that knowledge can enable you to focus
on areas that are uncovered and record
those functions.
If you have the source code, all you need
to do is place a recording marker in a
function that interests you. We
recommend against placing multiple
recording markers in multiple functions at
the same time. In practice this has shown
to be less helpful. Where do you place a
recording marker? For windows UI
programs, and in relation to some
business use case, you might start by
placing one in the event handlers for a
message that seems most pertinent. If you
are investigating a utility function, just
set a method recording marker at or
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somewhere near the start.
For services, daemons and batch
processes you might want to profile the
program once for each behavior of
interest and use the report to explore
those areas uncovered.
Tip

Scenarios

It's a good idea to have a quick glance at
the Breakpoints and Markers window
before debugging, and check that the
markers listed here are what you are
expecting.
·

·

·

·

·
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Microsoft Native C and C++, VB
(Windows programs, Window
Services, Console programs, COM
servers, IIS ISAPI modules, Legacy)
Microsoft .NET
(ASP.NET, Windows Presentation
Foundation (WPF), Windows Forms,
Workflow Services, devices,
emulators)
Java
(Apps, Applets, Servlets, Beans)
Android
(using Android debug bridge for
devices and emulators)
PHP
(Web site scripts)
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GDB
(Windows / Linux interopability)
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The Recording History
When the execution analysis of an application encounters
user-defined recording markers, all information recorded is
held in the Record & Analyze window.

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder

Facilities
Facility

Information/Options

Information
Display

The columns in the Record & Analyze
window are:
· Sequence - The unique sequence
number
· Threads - The operating system thread
ID
· Delta - The elapsed thread CPU time
since the start of the sequence
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Method - There are two Method
columns: the first shows the caller for a
call or for a current frame if a return;
the second shows the function called or
the function it is returning to
Direction - Stack Frame Movement,
can be Call, Return, State, Breakpoint
or Escape (Escape is used internally
when producing a Sequence diagram,
to mark the end of an iteration)
Depth - The stack depth at the time of a
call; used in the generation of Sequence
diagrams
State - The state between sequences
Source - There are two Source
columns: the first shows the source
filename and line number of the caller
for a call or, if a return, for a current
frame; the second shows the source
filename and line number of the
function called or function returning
Instance - There are two Instance
columns, which only have values when
the Sequence diagram produced
contains State Transitions; the values
consist of two items separated by a
comma - the first item is a unique
number for the instance of the Class
that was captured, and the second is the
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actual instance of the Class
For example: supposing a Class
'CName' has an internal value of 4567
and the program created two instances
of that Class; the values might be:
- 4567,1
- 4567,2
The first entry shows the first instance
of the Class and the second entry
shows the second instance
Operations
on
Information

The Record & Analyze window toolbar
provides a range of facilities for
controlling the recording of the execution
of an Analyzer script.
You can perform a number of operations
on the results of a recording, using the
Record & Analyze window context
menu, once the recording is complete.

Notes
·

The checkbox against each operation is used to control
whether or not this call can be used to create a Sequence,
Test Domain Class or Collaborative Class diagram from
this history
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In addition to enabling or disabling the call using the
checkbox, you can use context menu options to enable or
disable an entire call, all calls to a given method, or all
calls to a given Class
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Diagram Features
When you generate a Sequence diagram, it includes these
features:

Features
Feature

Detail

References

When the Visual Execution Analyzer
cannot match a function call to an
operation within the model, it still creates
the Sequence but also creates a reference
for any Class that it cannot locate.
It does this for all languages.

Fragments

Fragments displayed in the Sequence
diagram represent loops or iterations of a
section(s) of code.
The Visual Execution Analyzer attempts
to match function scope with method
calls to as accurately as possible represent
the execution visually.

States

If a StateMachine has been used during
the recording process, any transitions in
State are presented after the method call
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that caused the transition to occur.
States are calculated on the return of
every method to its caller.
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Setup for Recording
This section explains how to prepare to record execution of
the application.

Steps
Step
Prerequisites - To set up the environment for recording
Sequence diagrams you must:
· Have completed the basic set up for Build & Debug and
created Execution Analysis scripts for the Package
· Be able to successfully debug the application
Narrow the focus of a recording by applying filters.
Control the detail of a recording by adjusting the stack
depth.
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Control Stack Depth
When recording particularly high-level points in an
application, the Stack Frame count can result in a lot of
information being collected; to achieve a quicker and clearer
picture, it is better to limit the stack depth on the toolbar of
either:
· The Breakpoint and Markers window or
· The Record & Analyze window

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder

Set the recording stack depth
You set the recording stack depth in the numerical field on
the toolbar of the Breakpoints & Markers window or the
Record & Analyze window:
By default, the stack depth is set to three frames. The
maximum depth that can be entered is 30 frames.
(c) Sparx Systems 2022
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The depth is relative to the stack frame where a recording
marker is encountered; so, when recording begins, if the
stack frame is 6 and the stack depth is set to 3, the Debugger
records the frames 6 through 8.
For situations where the stack is very large, it is
recommended that you first use a low stack depth of 2 or 3.
From there you can gradually increase the stack recording
depth and insert additional recording markers to expand the
picture until all the necessary information is displayed.
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Place Recording Markers
This section explains how to place recording markers, which
enable you to silently record code execution between two
points. The recording can be used to generate a Sequence
diagram.
As this process records the execution of multiple threads, it
can be particularly useful in capturing event driven
sequences (such as mouse and timer events).

Access
Ribbon

Execute > Windows > Breakpoints

Actions
Action
Different recording markers can be used for recording the
execution flow; see the related links for information on
the properties and usage of these markers.
Manage breakpoints in the Breakpoint & Markers
(c) Sparx Systems 2022

Page 282 of 449

Execution Analysis

3 October, 2022

window.
Activate and deactivate markers.
Working with Marker Sets - when you create a breakpoint
or marker, it is automatically added to a marker set, either
the Default set or a set that you create for a specific
purpose.

Notes
·

The Breakpoint and Marker Management topic (Software
Engineering) describes a different perspective
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Set Record Markers
Markers are set in the source code editor. They are placed
on a line of code; when that line of code executes, the
Execution Analyzer performs the recording action
appropriate to the marker.

Access
Use one of the methods outlined here, to display the Code
Editor window and load the source code associated with the
selected Class or Class element.
Ribbon

Execute > Source > Edit > Edit Element
Source
Execute > Source > Edit > Open Source
File

Keyboard
Shortcuts

On an element press Ctrl+E or F12
To bring up the 'Open Source File'
browser press Ctrl+Alt+O

Set a recording marker
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Ste Action
p
1

Open the source code to debug, in the integrated
source code editor.

2

Find the appropriate code line and right-click in the
left (Breakpoint) margin to bring up the
breakpoint/marker context menu; select the required
marker type:

3

If a Start Recording Marker has been set, you must
also set an End Recording Marker.
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Marker Types
Markers are really fantastic. Unusual by their very light
footprint when used with care, their impact on the
performance of the programs being recorded can be
negligible. Markers come in several flavors (well colors
actually) and more are always being added. They are placed
and are visible in the left margin of the editor, so you will
need to have some source code.

Use to
·
·
·
·
·
·
·

Record a single function
Record parts of a function
Use Cases spanning multiple functions
Record call stacks
Generate Sequence diagrams
Generate Test Domain diagrams
Generate Class Collaboration diagrams

Reference
Marker
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Place the markers at the start and end
lines of the code to record. These need
not be within the same function.

When the program encounters a start
recording marker, a new recording is
initiated (the camera starts rolling!).
When an end marker is encountered, the
current recording ends (it's a take). How
you use these markers is up to you and
your knowledge of the system under your
care.
Advanced Stuff (nested markers):
If a Start recording marker is encountered
while a recording is in progress, but
where capture is inhibited by the Stack
depth value in use, a separate recording
will be initiated. Each recording is kept
on a stack. When one ends, it is removed.
This technique can be used in Enterprise
Architect to record and render scenes in
very complex systems. It resembles
splicing short scenes from a video to
create a trailer. If you only want to record
(c) Sparx Systems 2022
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a single function, you should use an Auto
record marker.
Method Auto
Record
marker

A Method Auto Record marker enables
you to record a particular function. The
debugger will automatically end the
recording when the function completes.
This is good because recording is an
intensive operation.
The function marker combines a Start
Recording marker and an End Recording
marker in one, so recording is executed
after the marker point, and always stops
when this function exits.

Recording markers can be nested. When
a new Method Auto Record marker is hit
while recording, the stack depth to record
to will be extended to include the current
method and the required depth from that
function.
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Stack
Auto-Capture
marker
Stack markers enable you to capture any
unique stack traces that occur at a point in
an application; they provide a quick and
useful picture of where a point in an
application is being called from.
To insert a marker at the required point in
code, right-click on the line and select the
'Add Stack Auto Capture Marker' option.
Each time the debugger encounters the
marker it performs a stack trace; if the
stack trace is not in the recording history,
it is copied, and the application continues
running.
Limiting the
recording
depth
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You can limit the depth of frames in any
recording using the stack depth control on
either the recorder and breakpoints
toolbars.
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The Breakpoints and Markers Window
Using the Breakpoints & Markers window, you can apply
control to Visual Execution Analysis when recording
execution to generate Sequence diagrams; for example, you
can:
· Enable, disable and delete markers
· Manage markers as sets
· Organize how markers are displayed, either in list view or
grouped by file or Class

Access
Ribbon
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Execute > Windows > Breakpoints
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Working with Marker Sets
Marker sets enable you to create markers as a named group,
which you can reapply to a code file for specific purposes.
You can perform certain operations from the Breakpoints &
Markers window alone, but to understand and use markers
and marker sets you should also display the appropriate
code file in the 'Source Code Viewer' (click on the Class
element and press F12).

Access
Ribbon

Execute > Windows > Breakpoints :
toolbar icon

Using Marker Sets
Action

Details

Example of
Use

You might create a set of Method Auto
Record markers to record the action of
various functions in the code, and a set of
Stack Capture markers to record the
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sequence of calls that cause those
functions to be called.
You could then create Sequence diagrams
from the recordings under each set.
Create a
Marker Set

To create a marker set from the
Breakpoints & Markers window, click on
the drop-down arrow on the
icon and
select the 'New Set' option.
The 'New Breakpoint Marker Set' dialog
displays; in the 'Enter New Set Name'
field, type a name for the set, and click on
the Save button.
The set name displays in the text field to
the left of the 'Set Options' icon.
Alternatively, you can select the 'Save as
Set' option from the 'Set Options'
drop-down to make an exact copy of the
currently-selected set, which you can then
edit.

Accessing
Sets

To access a marker set, click on the
drop-down arrow on the text field to the
left of the 'Set Options' icon, and select
the required set from the list.
The markers in the set are listed in the
Breakpoints & Markers window.
You would normally load a marker set
prior to the point at which an action is to
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be captured.
For example, to record a sequence
involving a particular dialog, when you
begin debugging you would load the set
prior to invoking the dialog; once you
bring up the dialog in the application, the
operations you have marked are recorded.
Add Markers
to Set

To add markers to a marker set, add each
required marker to the appropriate line of
code in the 'Source Code Viewer'.
The marker is immediately added to
whichever set is currently listed in the
Breakpoints & Markers window.
Each marker listed on the dialog has a
checkbox in the 'Enabled' column;
newly-added markers are automatically
enabled, but you can disable and
re-enable the markers quickly as you
check the code.

Storage of
Sets

When you create a marker set it is
immediately saved within the model; any
user using the model has access to that
set.
However, the Default set, which always
exists for a model, is a personal
workspace, is not shared and is stored
external to the model.
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Delete a
Marker from
a Set

Right-click on the marker and select the
'Delete Breakpoint' option.

Delete a Set

If you no longer require a marker set,
access it on the Breakpoints & Markers
window and select the 'Delete Selected
Set' option from the 'Set Options'
drop-down list.
You can also clear all user-defined
marker sets by selecting the 'Delete all
sets' option; a prompt displays to confirm
the deletion.

Notes
·

Marker Sets are very simple and flexible but, as they are
available for use by any user of the model, they can be
easily corrupted; consider these guidelines:
- When naming a set, use your initials in the name and
try to indicate its use, so that other model
users can recognize its owner and purpose
- When using a set other than Default, avoid excessive
experimentation so that you don't add
lots of ad-hoc markers to the set
- Make sure you are aware of which marker set is
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exposed in the Breakpoints & Markers window
as you can easily inadvertently add markers to the set
that are not relevant to the code file the
set was created for
- In any set, if you have added markers that don't have
to be kept, delete them to maintain the
purpose of the set; this is especially true of the
Default set, which can quickly accumulate
redundant ad-hoc markers
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Control the Recording Session
The Record & Analyze window enables you to control a
recording session. The control has a toolbar, and a history
window that displays the recording history as it is captured.
Each entry in this window represents a call sequence made
up of one or more function calls.

Access
Open the Record & Analyze window using one of the
methods outlined here.
You must also open the Execution Analyzer window
('Execute > Analyzer | Analyzer Scripts'), which lists all the
scripts in the model; you must select and activate the
appropriate script for the recording.
Ribbon
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Execute > Tools > Recorder > Open
Recorder
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Recorder Toolbar
You can access facilities for starting, stopping and
moderating an execution analysis recording session through
the Record & Analyze toolbar.

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder
Explore > Portals > Show Toolbar >
Record

Buttons
Button

Description
Display a menu of options for defining
what the recording session operates on.
· Attach to Process - enabled even if no
Analyzer Script exists, this option
displays a dialog through which you
select a process to record and a

(c) Sparx Systems 2022

Page 297 of 449

Execution Analysis

3 October, 2022

·

·

·

·

·
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debugging platform to use; you can
also optionally select a record marker
set and/or a StateMachine to use during
the recording
Generate Sequence Diagram from
Recording - generate a Sequence/State
diagram from the Execution Analyzer
trace
Generate Testpoint Diagram from
History - generate a Test Domain
diagram from the Execution Analyzer
trace, that can be used with the
Testpoint facility
Generate Class Diagram from History generate a Collaboration Class diagram
from the Execution Analyzer trace,
depicting only those Classes and
operations involved in the recorded
action (Use Case)
Generate Call Graph from History generate a dynamic Call Graph from
the recording history, as you might see
in the VEA Profile workspace
execution analysis layout; this can be
more useful than the Sequence diagram
in identifying the unique call stacks
involved
Generate All - generate the Sequence,
Testpoint and Collaboration Class
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·

·

·

diagrams together from the Execution
Analyzer trace
Save as Artifact - create an Artifact
element that contains the current
recording history, under the
currently-selected Package in the
Browser window; if you subsequently
drag this Artifact element onto a Class
diagram and double-click on it, the
history recorded in the Artifact is
copied back into the Record & Analyze
window
Load Sequence History from file select an XML file from which to
restore a previously-saved recording
history
Save Sequence History to file - save
the recording history to an XML file

Select the recording stack depth for the
marker set; that is, the number of frames
from the point at which recording began.
Launch and record the application
described in the script; you can optionally
select a record marker set and/or a
StateMachine to use during the recording.
The icon is enabled when the active
Analyzer Script is configured for
(c) Sparx Systems 2022
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debugging.
Perform ad-hoc manual recording of the
current thread during a debug session.
Use this function with the 'step' buttons of
the debugger; each function that is called
due to a step command is logged to the
history window.
The icon is enabled if no recording is
taking place and you are currently at a
breakpoint (that is, debugging).
Perform ad-hoc auto-recording during a
debug session.
When you click on this icon, the
Analyzer begins recording and does not
stop until either the program ends, you
stop the debugger or you click on the
Stop icon.
This icon is enabled if no recording is
taking place and you are currently at a
breakpoint (that is, debugging).
Step into a function, record the function
call in the History window, and step back
out.
Enabled for manual recording only.
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Stop recording the execution trace.
Display the 'Synchronize Model' dialog
through which you can synchronize the
model with the code files generated
during a Record Profile operation.
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Working With Recording History
You can perform a number of operations on or from the
results of a recording session, using the Record & Analyze
window context menu.

Options
Option

Action

Show Source
for Caller

Display the source code, in the Source
Code Viewer, for the method calling the
sequence.

Show Source
for Callee

Display the source code, in the Source
Code Viewer, for the method being called
by the sequence.

Generate
Diagram for
Selected
Sequence

Generate a Sequence diagram for a single
sequence selected in the recording
history.

Generate
Sequence
Diagram

Generate a Sequence diagram including
all sequences in the recording history.
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Clear

Clear the recording history currently
displayed in the Record & Analyze
window.

Save
Recording
History to
File

Save the recording history to an XML
file.
A browser window displays, on which
you specify the file path and name for the
XML file.

Load
Recording
History From
File

Load a previously saved recording
history from an XML file.
A browser window displays, on which
you specify the file path and name for the
XML file to load.

Disable All
Calls

Disable every call listed in the Record &
Analyze window.

Disable This
Call

Disable the selected call.

Disable This
Method

Disable the selected method.

Disable This
Class

Disable the selected Class.

Disable All

Disable every call listed in the Record &
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Calls Outside
This Call

Analyze window except for the selected
call.

Enable All
Calls

Enable every call listed in the Record &
Analyze window.

Enable This
Call

Enable the selected call.

Enable This
Method

Enable the selected method.

Enable This
Class

Enable the selected Class.

Help

Display the Help topic for the Record &
Analyze window.
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Start Recording
When you are recording execution flow as a Sequence
diagram, you start the recording by selecting the 'Recording'
icon on the Record & Analyze window toolbar. The 'Record'
dialog displays with the recording options set to the
defaults; that is, the current Breakpoint and Markers Set, the
filters defined in the current Analyzer Script and the
recording mode as basic.

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder :

Record Dialog Options
Field/Button

Detail

Recording
Set

Recording markers determine what is
recorded.
If you have a recording set to use, click
on the drop-down arrow and select it.
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Additional
Filters

Filters are used by the debugger to
exclude matching function calls from the
recording history. Recording filters are
defined in the Analyzer Script.
In the 'Additional Filters' field you can
add other filters for this specific run. if
you specify more than one filter, separate
them with a semi-colon.

Basic
Recording
Mode

In basic mode the debugger records a
history of the function calls made by the
program whenever it encounters an
appropriate recording marker.

Track
Instances of
Named
Classes

In Track Instances mode the debugger
also captures the creation of instances of
the Classes you specify. It then includes
that information in the history. The
resulting Sequence diagram can then
show lifelines for each instance of that
Class with, where appropriate, function
calls linked to the lifeline.

Track State
Transitions

The recording can also capture changes in
State using a specified StateMachine
diagram. The StateMachine diagram must
exist as a child of a Class.
The Execution Analyzer captures
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instances of that Class and calculates the
State of each instance whenever a
function in the current recording
sequence returns.
OK
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Click on this button to start the debugger.
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Step Through Function Calls
The 'Step Through' command can be executed by clicking
on the Step Through button on the Record & Analyze
window toolbar.
Alternatively, press Shift+F6 or select the 'Execute > Run >
Step In' ribbon option.
The 'Step Through' command causes a 'Step Into' command
to be executed; if any function is detected, then that function
call is recorded in the History window.
The Debugger then steps out, and the process can be
repeated.
This button enables you to record a call without having to
actually step into a function; the button is only enabled
when at a breakpoint and in manual recording mode.

(c) Sparx Systems 2022

Page 308 of 449

Execution Analysis

3 October, 2022

Nested Recording Markers
When a recording marker is first encountered, recording
starts at the current stack frame and continues until the
frame pops, recording additional frames up to the depth
defined on the Recording toolbar. Consider this call
sequence:
A -> B -> C -> D -> E -> F -> G -> H -> I -> J -> K -> L ->
M -> N -> O -> P -> Q -> R -> S -> T -> U -> V -> W -> X
-> Y -> Z
If you set a recording marker at K and set the recording
depth to 3, this would record the call sequence:
K -> L -> M
If you also wanted to record the calls X, Y and Z as part of
the Sequence diagram, you would place another recording
marker at X and the analyzer would record:
K -> L -> M -> X -> Y -> Z
However, when recording ends for the X-Y-Z component
(frame X is popped), recording will resume when frame M
of the K-L-M sequence is re-entered. Using this technique
can help where information from the recorded diagram
would be excluded due to the stack depth, and it lets you
focus on the particular areas to be captured.
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Generating Sequence Diagrams
This topic describes what you might do with the recording
of an execution analysis session.

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder

Reference
Action

Detail

Generate a
diagram

Select the appropriate Package in the
Browser window, in which to store the
Sequence diagram.
To create the diagram from all recorded
sequences, either:
· Click on the 'Recorder Menu' icon
( ) in the Record & Analyze window
toolbar, and select the 'Generate
Sequence Diagram from Recording'
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option, or
· Right-click on the body of the window
and select the 'Generate Sequence
Diagram' option
To create the diagram from a single
sequence, either:
· Click on the 'Recorder Menu' icon
( ) in the Record & Analyze window
toolbar, and select the 'Generate
Sequence Diagram from Recording'
option, or
· Right-click on the sequence and select
the 'Generate Diagram from Selected
Sequence' option
Save a
recorded
sequence to
an XML file

Click on the sequence, click on the
'Recorder Menu' icon ( ) in the Record
& Analyze window toolbar, and select
the 'Save Sequence History to File'
option.

Access an
existing
sequence
XML file

Either:
· Click on the
in the Record &
Analyze window toolbar, and select the
'Load Sequence History from File'
option, or
· Right-click on a blank area of the
screen and click on the 'Load Sequence
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From File' option
The 'Windows Open' dialog displays,
from which you select the file to open.

Use to
·

·
·
·
·

Generate a Sequence diagram from a recorded execution
analysis session, for:
all recorded sequences or
a single sequence in the session
Save the recorded sequence to file
Retrieve the saved recording and load it into the Record &
Analyze window
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Reporting State Transitions
This section describes how you can generate Sequence
diagrams that show transitions in state as a program
executes.

Use to
Generate Sequence diagrams that report user-defined
transitions in state as a program executes (as shown in the
example generated diagram)
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Topic
Create a StateMachine under the Class to be reported.
Set the constraints against each State to define the change
in state to be reported.
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Reporting a StateMachine
The Execution Analyzer can record a Sequence diagram, we
know that. What you might not know is that it can use a
StateMachine at the same time to detect State transitions
that might occur along the way. These States are represented
at the point in time on the lifeline of the object. The
transitions also are apparent from the lifelines. Any invalid
or illegal transition will be highlighted with a red border.
Have a look.

Process
Firstly you model a StateMachine for the appropriate Class
element.
You then compose the expressions that define each State
using the 'Constraints' tab of each State.
These simple expressions are formed using attribute names
from Class model and actual code base. They are not OCL
statements. Each expression should appear on a separate
line.
m_strColor == "Blue"
You then use the Recorder window to launch the debugger.
The Recorder window Run button is different from the
button on other debugger toolbars.
The Recorder window will allow you to browse for a
StateMachine if you do not know the StateMachine name.
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The 'State Transition' dialog presents a list of StateMachines
for the entire model, in which you locate and select the
appropriate diagram (see the example).
When you generate the Sequence diagram, it depicts not
only the sequence but changes in State at the various points
in the sequence; each Class instance participating in the
detection process is displayed with its own lifeline.

Example
The Stations StateMachine shows the different States within
the Melbourne Underground Loop subway system.
A train traveling on the subway network can be stopped at
any of the stations represented on the StateMachine.
The Stations StateMachine is a child of the CTrain Class.

When you browse for the diagram in the 'State Transition
Recorder' dialog, the hierarchy shows only the root Package,
parent Class and child SubMachine and diagram; no other
model components are listed.
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Recording and Mapping State Changes
This topic discusses how to set constraints against each
State in the StateMachine under a Class, to define the
change in state to be recorded.

Example
This example of a State 'Properties' dialog is for the State
called Parliament; the 'Constraints' tab is open to show how
the State is linked to the Class CXTrain.
A State can be defined by a single constraint or by many; in
the example, the Parliament State has two constraints:

The values of constraints can only be compared for
elemental, enum and string types
The CXTrain Class has a member called Location of type
int, and a member called Departing.Name of type CString;
what this constraint means is that this State is evaluated to
True when:
· an instance of the CXTrain Class exists and
· its member variable Location has the value 0 and
· the member variable Departing.Name has the value
Parliament
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Operators in Constraints
There are two types of operator you can use on constraints
to define a State:
· Logical operators AND and OR can be used to combine
constraints
· Equivalence operators {= and !=} can be used to define
the conditions of a constraint
All the constraints for a State are subject to an AND
operation unless otherwise specified; you can use the OR
operation on them instead, so you could rewrite the
constraints in the example as:
Location=0 OR
Location=1 AND
Departing.Name!=Central
Here are some examples of using the equivalence operators:
Departing.Name!=Central AND
Location!=1

Notes
·

Quotes around strings are optional; the comparison for
strings is always case-sensitive in determining the truth of

(c) Sparx Systems 2022

Page 319 of 449

Execution Analysis

3 October, 2022

a constraint
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State Analyzer
The State Analyzer is a feature that can analyze, detect and
record states for instances of a Class. The feature works by
combining a state definition (defined on a Class as a
constraint) and markers called State points. It is available for
any languages supported by the Execution Analyzer,
including Microsoft.NET, Mono, Java and native C++.
We begin by selecting a Class and composing our state
definition.

We can get a picture of all the state definitions we've
defined by placing the Class on a diagram and linking to the
Class notes that themselves link to a particular state
(c) Sparx Systems 2022
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definition constraint. We explain how to do that in a later
section.

State points are set by placing one or more markers in
relevant source code.

The program to be analyzed is run using the State Analyzer
control. When the Execution Analyzer encounters any State
point, the current instance of the Class is analyzed. Where
the value domain of the instance matches the state
definition, a state is recorded. Each time the instance varies,
new states are thus detected. The control lists each state as
it is discovered. Under each state the control lists the
discrete set of transitions to other states made by instances
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of the class.

The information can be used to create a StateMachine.

Using the same information we can easily produce a Heat
Map. This example shows a 'Train' Class, its 'Bulletin' State
Definition (as a linked note), and the Heat Map it produced.
The Figures in the map are percentages. From the map we
can observe that trains were in the 'In Transit' state 46% of
the time.
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This is the analysis for the 'Bulletin' State Definition that
produced our Heat Map.

Access
Ribbon
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Execute > Tools > Recorder > Open
Recorder > State Analyzer
Design > Element > Editors >
Constraints
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State Definitions
State Definitions are composed in the Constraints properties
of a Class element. The constraint type should be named
StateDefinition.name, where 'name' is your choice of title
for the definition. These titles are listed in the combo box of
the State Analyzer whenever a Class is selected. You select
a single definition from this combo box prior to running the
program. The State Definition in our example is named
'StateDefinition.Location'. It defines states based on the
location of instances of the CTrain Class.
State Definitions are composed of one or more
specifications. Each state specification begins with the
keyword 'statedef' which is then followed by one or more
statements. Statements define the constraints that describe
the state, and optionally a variable whose value can be used
to name the state. Statements are enclosed in curly brackets
and are terminated with a semi colon as shown:
statedef {
Location=0;
Departing.Name;
}
Naming states using variables
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In this example, 'Location' is a constant and
'Departing.name' is a variable. An additional statement
follows the constraints and instructs the name of the State to
be assigned from the variable value. Here is the definition
with the naming directive.
statedef {
Location=0;
Departing.Name;
}
name=Departing.Name;
Naming states using literals
In this example the State Definition only contains constants
and the state is named using a literal.
statedef {
Location=100;
}
name='Central';
A single State Definition defining multiple State
specifications.
statedef {
Passengers > 100;
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}
name=Busy;
statedef {
Passengers >= 50;
}
name=Quiet;
statedef {
Passengers < 50;
}
name=Very Quiet;
statedef {
Passengers = 0;
}
name=Idle;

Default State
A State definition can specify a default 'catch all' state that
will describe the state of an instance when no other state
holds true. You define a default state for the definition with
a statement resembling this:
statedef {
Location=0;
(c) Sparx Systems 2022

Page 327 of 449

Execution Analysis

3 October, 2022

Departing.Name;
}
name=Departing.Name;
default=Moving;
In this example, while execution is in progress any instance
detected having a non-zero 'Location' attribute will be
recorded as being in the 'Moving' state.
You can choose to exclude the recording of the default state
by disabling the 'Include default state' option on the drop
down menu of the State Analyzer toolbar. This would
exclude transitions to any 'default' state being recorded.

Creating Notes on a Class element that
display State Definitions
This section describes how to create the Class diagram that
shows all the State Definitions defined for the Class.

Actions
Display a
Class
(c) Sparx Systems 2022

Open an existing Class diagram or create
a new one.
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diagram

Create a link
to the Class
element

Drag the Class of interest on to the
diagram as a link.

Create a note
element

Create a note element on the diagram and
link it to the class.

Link the note
to the State
Definition

Select the link between the Note and the
Class and, using its context menu, select
the 'Link Note to Element Feature' option.

Choose the
definition to
display on
the Note

From the element dialog, choose
'Constraints' from the drop combo. Any
defined State Definitions will be listed for
you to choose from.

Repeat
(c) Sparx Systems 2022

Repeat the procedure for any other State
Definitions on the class.
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Synchronization
The recording produces a number of assets, the recording
history being the main one. Recording also identifies a set of
source code files. This set can be used to produce Class and
Test Domain diagrams, but can also be used to synchronize
your model.
A synchronized model provides quick and accurate
navigation between diagram elements and the Class model.

Access
Ribbon

Execute > Tools > Recorder > Open
Recorder > Toolbar
button

Context
Menu

Right-click on the Record & Analyze
window | Synchronize Model with Source
Code

Synchronize Model
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Field/Button

Action

Package

Click on the Select button and select the
target Package into which to
reverse-engineer the code files.

Files/Action

Lists the files identified during one or
more recording(s). The appropriate action
is listed next to each file.

Select All

Click on this button to select the
checkbox against every file in the 'Files'
list.

Select None

Click on this button to clear the checkbox
against every file in the 'Files' list.

OK

Click on this button to start the operation.
The progress of the synchronization will
be displayed.
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Click on this button to abort
synchronization and close the dialog.
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Visualize Run State
You can record the state transitions of a single object by
taking multiple snapshots of the object's run state at key
points in its lifetime. To do this simply drag the local or
member variable on to an Object diagram.
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Object Workbench
The Object Workbench is an Enterprise Architect debugging
tool that helps you create objects from your Class model.
The Workbench allows multiple instances of any Class to
coexist in the same session. Each Object can serve as the
target of a method you want to invoke. They can also
participate as parameters in methods you invoke. The Object
Workbench is supported for the Java and Microsoft .NET
platforms.

Workbench Tasks
Task
Provides a guide and the requirements for using the
Object Workbench.
Explains what Workbench objects are, and how to create
them.
Explains how to execute methods on a Workbench Object
and provides information on passing arguments.
Explains stepping through a method's execution using the
Debugger.
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Explains how to record a method and produce a Sequence
diagram.
Explains how to delete a Workbench Object once you are
finished with it.
Explains how to shut down the Debugger and close the
Workbench once you have finished with it.
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Using the Workbench
Using the Object Workbench is straightforward. From your
Class model, select the Classes to workbench and drag them
individually on to the Workbench window. You might have
to choose a constructor if more than one exists, then simply
give the variable a name. The Object workbench prepares
the required runtime, loads any required modules and
instantiates the objects for you. Executing a method is a
matter of selecting from a list. Parameters can be entered
where required. Workbench objects themselves can be used
as parameters either singly or as object arrays.

Access
Ribbon

Execute > Tools > Tester > Open Object
Workbench

Analyzer Script Requirements
An Analyzer Script that has been configured for debugging
is required. It should specify this information:
· The debugger to match your project
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For Microsoft .NET, the location of the assembly that will
be hosted by the Object Workbench
For Java, the location of the JDK and additional class
paths to use

Checklist
·

·

Select the intended Workbench Class and press F12; the
source code should be displayed in a code editor
Press Shift+F12 to build the project; the output from the
build should show successful compilation
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Creating Objects
This topic explains how to create a workbench instance for a
Class from your model.

Access
Ribbon

Execute > Tools > Tester > Open Object
Workbench

Keyboard
Shorcuts

Ctrl+Shift+J

Other

Drag a Class directly from the Browser
window onto the Workbench window

Tasks
Task

Detail

Creating an
Object on the
Workbench

Select the Class in the Browser window
and drag it on to the Workbench window.
The 'Workbench' dialog displays.
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Type in a name for the new instance. The
name should be unique for the
Workbench.
Click on the Create button.
Choosing a
Constructor

The 'Constructor' dialog is displayed
where a choice of constructor exists.

Select the constructor from the
drop-down list.
Enter
Parameters
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Provide values for the selected
constructor's parameters:
· Strings as arguments - Surround values
with quotes where appropriate, or
where the value would conflict with the
name of a Workbench object
· Objects as arguments - Enter the name
of the Workbench object
· String array arguments take text values
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separated by commas:

·

one,two,three,"a book","a bigger
book"
Object arrays as arguments take object
names separated by commas; supply
the named Workbench objects
separated by commas, for example:
Tom,Dick,Harry

Invoke
Constructor
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Click on the Invoke button to create the
instance. The object can be recognized by
its name in the Workbench window.

Page 341 of 449

Execution Analysis

3 October, 2022

Invoking Methods
Access
On the Workbench window, right-click on the instance on
which to execute a method, and select 'Invoke'.
Ribbon

Execute > Tools > Tester > Open Object
Workbench

Actions
Action

Details

Choose
Method

Select a method from the list and click on
the Invoke button.
Note that all methods listed are public;
private methods are not available.

(c) Sparx Systems 2022

Page 342 of 449

Execution Analysis

3 October, 2022

Provide
Arguments

In this image, the method to be invoked
takes an array of objects as its only
argument. You construct this argument
by naming the other instances on your
Workbench that you want to pass to the
method.

Argument
Types

These are the parameter types supported
by the Workbench:
· Strings
· Numbers
· Objects
· String Arrays
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Argument
Syntax

·

·

·

·

Object Arrays
Strings as arguments - Surround strings
with quotes where necessary; for
example, to avoid conflict with
Workbench object names
String Arrays as arguments - Enter the
elements that compose the array,
separated by commas; for example:
"A maths book","A geography
book","A computer book"
Objects as arguments - Type the
Workbench object name as the
argument; the debugger checks any
name entered in an argument against its
list of Workbench instances, and will
substitute that instance in the actual call
to the method
Object Arrays as arguments - Enter the
Workbench objects' names to satisfy
the argument, separated by commas:
Tom,John,Peter

Invoke
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Click on the Invoke button to execute the
method.
Output confirming this action is
displayed in the Debug window.
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Setting Properties
For languages that support properties, we can set the value
of an Object's property in the same manner in which we
invoke a method. Select the instance in the Workbench, and
use its context menu to select the 'Invoke' option. You will
find the properties exposed by the Class listed
alphabetically, along with its methods. You will be
prompted to provide the new value of the property. Type the
value as you would have entered it for the parameter in a
method call. This image demonstrates changing the
Occupation property of a Person called Bertie; Bertie being
a type of Person.
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Debugging and the Workbench
While you are working in the Workbench, you might want
to debug one or more methods you are developing or
investigating. This can easily be accomplished. The same
features of Enterprise Architect's Execution Analyzer are
available to users of the Object Workbench. Debugging can
be performed during object construction and destruction as
well as during the execution of a method. To gain access to
the debugger, simply place a breakpoint at the points at
which to step through the code. You could also set the
condition on these breakpoints to only break under certain
conditions.

When debugging, the states of objects are inspected using
the debugger controls. Here we use the Locals window to
examine the state of our object while execution is halted.
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When the program resumes, the Object on the Workbench
will reflect any changes in state.
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Recording and the Workbench
While you are working in the Workbench, you might want
to produce a Sequence diagram for one or more methods
you are developing or investigating. This can easily be
accomplished. The same features of Enterprise Architect's
Execution Analyzer are available in the Object Workbench.
You might even begin a Workbench session by recording a
Sequence diagram first off, as a means of visualizing what
you plan to work on.

Set the Recording Marker

Invoke the Method
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View the Recording History

Generate the Sequence Diagram
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Deleting Objects
You can easily delete an object by selecting it in the
Workbench, right-clicking on it and selecting the 'Delete'
option.
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Closing the Workbench
To shut down the Workbench perform any of these actions:
· Choose 'Reset' from the Object Workbench context menu
· Press the Stop button on any debugger toolbar
· Delete all objects on the Workbench
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Profiling

During the lifetime of software applications, it is not
uncommon to investigate application tasks that are
determined to be performing slower than expected. You
might also simply want to know what is going on when you
'press this button'! You can work this out quite quickly in
Enterprise Architect by using its Profiler. Results can
usually be produced in a few seconds and you will quickly
be able to see the actions that are consuming the application
and the functions involved. In the Execution Analyzer, the
feature employs two separate strategies; Process Sampling
and Process Hooking. In one, samples are taken at regular
intervals to identify CPU-intensive patterns, while in the
other, the process is hooked to record demands made on
memory. Data is analyzed to produce a weighted Call
Graph. Behaviors are usually identifiable as root nodes
(entrypoints) in the graph, or branches near these points. All
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reports can be reviewed on demand. They can be saved to
file within the model, both as Artifact elements and as
Model Library posts.

Access
Ribbon

Execute > Tools > Profiler

Other

Execution Analyzer toolbar : Analyzer
Windows | Profiler

Call Sampling

The Profiler is controlled using its toolbar buttons. Here you
can attach the Profiler to an existing process (or JVM), or
launch the application for the active Analyzer Script. The
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Profiler window displays the details of the target process as
it is profiled. These details provide feedback, letting you see
the number of samples taken. You also have options for
pausing and resuming capture, clearing captured data and
generating reports. You can gain access to the reporting
feature by pausing the capture - the reporting feature is
disabled whilst data capture is in progress.

Weighted Call Graph

This detailed report shows the unique set of Call
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Stacks/behaviors as a weighted Call Graph. The weight of
each branch is depicted by a hit count, which is the total hits
of that branch plus all branches from this point. By
following the hit trail, you can quickly identify the areas of
code that occupied the program the most during the capture
period.

Stack Profile

Stack Profiles are taken to discover the different ways
(stacks) and the count of ways that a particular function is
invoked during the running of the program. Unlike the other
profiler modes, this profile is activated through the use of a
Profile Point, which is a special kind of breakpoint marker.
The marker is set in the source code like any other
breakpoint. When the breakpoint is encountered by the
program, the stack is captured. When you later produce the
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report, the stacks are analyzed and a weighted call graph
produced. The graph shows the unique stacks that were
involved in that function during the time the profiler was
running, The 'Hit Count' column indicates the count of times
that same stack occurred.

Memory Profiles
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The Memory Profile tracks allocations, ignoring when
memory is freed. It uses this information to rate the
executing code's demands for memory, in terms not of the
amount of memory but of the frequency of demands. The
Allocations figure is the total number of memory allocations
requested. The Stack Holdings is the number of stack traces
taken at those times, and the Heap Holding figure is the total
amount of memory obtained by these calls. Note that
profiling can be turned on and off on demand. There is also
no need to rebuild your program to get it to work as there is
no linkage involved.
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Memory Graph

This example is of a report produced from Profiling a
demonstration program in the Xerces project from Apache.
The program iterates over the Document Object Model
(DOM) for a provided XML file.

Function Summary Report

This summary report lists the functions and only those
functions executed during the sample period. Functions are
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listed by total invocations, with a function that presents
twice in separate Call Stacks appearing before a function
that appears just the once.

Function Line Report

This detailed report shows the source code for a function
line by line displaying beside it the total times each was
executed. We uncovered code using this report, that exposed
case statements in code that never appeared to be executed.

Support
The Profiler is supported for programs written in C, C++,
Visual Basic, Java and the Microsoft .NET languages.
Memory profiling is currently available for native C and
C++ programs.
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Notes
·

·

The Profiler is available in the Enterprise Architect
Professional Edition and above
The Profiler can also be used under WINE (Linux and
Mac) for Profiling standard Windows applications
deployed in a WINE environment
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System Requirements
Using the Profiler, you can analyze applications built for
these platforms:
· Microsoft TM Native (C++, C, Visual basic)
· Microsoft .NET (supporting a mix of managed and
unmanaged code)
· Java

Microsoft Native applications
For C, C++ or Visual Basic applications, the Profiler
requires that the applications are compiled with the
Microsoft TM Native compiler and that for each application or
module of interest, a PDB file is available. The Profiler can
sample both debug and release configurations of an
application, provided that the PDB file for each executable
exists and is up to date.

Microsoft .NET applications
For Microsoft .NET applications, the Profiler requires that
the appropriate Microsoft .NET framework is installed, and
that for each application or module to be analyzed, a PDB
file is available.
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Java
For Java, the Profiler requires that the appropriate JDK from
Oracle is installed.
The classes of interest should also have been compiled with
debug information. For example: "java -g *.java"
· New instance of application VM is launched from
Enterprise Architect - no other action is required
· Existing application VM is attached to from within
Enterprise Architect - the target Java Virtual Machine has
to have been launched with the Enterprise Architect
profiling agent
These are examples of command lines to create a Java VM
with a specific JVMTI agent:
1. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program
Files (x86)\Sparx Systems\EA\vea\x86\ssamplerlib32"
myapp
2. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program
Files (x86)\Sparx Systems\EA\vea\x64\ssamplerlib64"
myapp
(Refer to the JDK documentation for details of the
-agentpath VM startup option.)
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Getting Started
The Profiler can be used to investigate performance issues,
providing four separate tools for you to choose from,
namely:
· Call Graph
· Stack Profile
· Memory Profile
· Memory Leaks
You select these tools from the Profiler toolbar.

Access
Ribbon

Execute > Tools > Profiler

Tools
Tool

Description

Call Graph

Analyzes performance by taking samples
during an activity in a program. Each
sample represents a stack. The samples
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are taken at intervals controlled using the
toolbar. In this scenario, poor
performance is rated by the patterns of
behavior that repeat the most during the
sample time period. This figure is used to
weight the Call Graph produced.
Memory
Profile

Analyzes performance by hooking the
memory allocations made by a program.
In this scenario, poor performance is
rated by the activities making the most
requests for memory. This figure is used
to weight the Call Graph produced.

Stack Profile

The Stack Profiler enables you to set a
marker in your source code so that
whenever execution hits that marker, a
full stack trace is captured. As the
application continues executing and the
marked position is accessed from a
variety of places within the running
executable, a very detailed and useful
picture is built up showing hot spots and
usage scenarios for a particular point in
code.
The Stack Profile report, like the Memory
Profile report, is displayed in 'reverse
stack' order. This means that the root of
the report is always a single node (in this
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case the marker) and the tree then fans
out to show all the various places the
marked position has been accessed from.
Memory
Leaks

Analyzes memory leaks by hooking the
memory operations performed by a
program. What is produced is a Call
Graph presenting the Call Stacks that
allocated memory for which a free
operation was not detected.

Toolbar Buttons
Button

Action
Displays a menu of options for managing
your Profiling session.
Launches the configured application to be
profiled. By default, this is the
application configured in the active
Analyzer Script.
Indicates the state of the sampler. When
green, sampling is enabled; when red,
sampling is disabled.
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Stops the Profiler process; if any samples
have been collected, the Report button
and Discard Data button are active.
Generates a report from the current data
collection.
Displays the Profiling tool in use, which
determines the fields shown in the
Profiler window. Click on the drop-down
arrow and select a different tool, which
changes the window fields.
Discards the collected data. You are
prompted to confirm the discard.
Displays the Help topic for this window.
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Call Graph

·

·
·
·
·

Quickly discover what a program is doing at any point in
time
Easily identify performance issues
Be surprised how quickly you can realize improvements
See your improvements at work and have the evidence
Support for C/C++, .NET and Java platforms

Usage
The 'Call Graph' option is typically used in situations where
an activity is performing slower than expected, but it can
also be used simply to better understand the patterns of
behavior at play during an activity.

Operation
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The Profiler operates by taking samples - or Call Stacks - at
regular intervals over a period of time; the interval is set
using the Profiler toolbar. You use the Profiler to run a
particular program, or you can attach to an existing process.
The Profiler capture is controlled, and you can pause and
resume capture at any time. You can also elect to have
capture initiated immediately when the Profiler is started. If
necessary, you can discard any captured samples and start
again during the same session. If you cannot continue with
the same session, restarting the Profiler is quick and easy.
Note that the 'Process Time (estimated)' field shows an
estimate of how long the process being profiled has been
running, taking into account the interruptions to the process
by the Profiler in collecting samples.

Results
Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It is up to you to decide how long
you let the Profiler run. You might know when an activity is
finished, or it might be apparent for other reasons. The
reason you are here might be that an activity is not
completing at all.
The Report button will be enabled by either pausing capture
or stopping the Profiler altogether.
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Results are displayed in a Report view. The report opens
with three tabs initially visible: the Call Graph, the
Summary Report (Function Summary) and the Hit Analysis
tabs. The reports can be saved to file, stored in the model as
Artifacts or posted in the Model Library.
The Call Graph Tab

The Summary Report Tab
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The Hit Analysis Tab
The 'Hit Analysis' tab displays a number of columns:
· Function: the name of the function (or module if no
symbols for module)
· Hits: the number of samples taken, in which the function
was executing.
· Depth: the frame number or stack depth at which the hit
took place.
· Occurrences: the number of times the function was hit at
this particular stack depth
The number of hits on a particular function are aggregated
according to the stack frame depth when sampled.
If the function name is unavailable, for example Windows
System DLL's such as User32 or DLL's with no debug
information, the module name is shown instead.
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Stack Profile
The Stack Profiler enables you to set a marker in your
source code so that whenever execution hits that marker, a
full stack trace is captured. As the application continues
executing and the marked position is accessed from a
variety of places within the running executable, a very
detailed and useful picture is built up showing hot spots and
usage scenarios for a particular point in code.

The Stack Profile report, like the Memory Profile report, is
displayed in 'reverse stack' order. This means that the root of
the report is always a single node (in this case the marker)
and the tree then fans out to show all the various places the
marked position has been accessed from.
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Usage
Use the Stack Profile mode to produce a report that shows
the unique ways in which a function can be invoked during
the running of a program. Determine the parts of the model
that rely on this function and their frequency.

Operation
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Profiler modes are selected using the Profiler control
Toolbar. If a Profiler Point is already created, it is displayed.
The Profiler Point is the point at which stack traces are
captured. You can set the Profiler Point using the Set button
on the control itself, once the mode is selected. After
deciding on the Profile Point, build the project to be sure
everything is up to date, then start the Profiler. The number
of unique stack holdings detected is visible during the run.

Results
A results can be produced by clicking the report button on
the Profiler control Toolbar. This button is enabled when
either:
· Capture is turned off (using the Pause Button) or
· The Profiler is stopped (using the Stop Button)
The results produced are displayed as a weighted call graph,
where the lines on the graph represent a unique stack, and
weighted to show the higher frequency stacks first. The
report can then be saved, either to file or to the model, using
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the context menu of the report itself.
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Memory Profile
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Quickly rate performance of activities that interest you
Nothing influences a discussion more than evidence
Reward your efforts by working in those areas that will
make a difference
Surprise yourself by delivering optimizations you might
not have known existed

Usage
The Memory Profile can be used to reveal how activities
perform in regard to memory consumption. Using this
mode, a user would be interested in questioning the
frequency of demands made for memory during a task. They
would be less interested in the actual amount consumed. A
well managed activity might make relatively few calls to
allocate resources but allocate enough memory to do its job
efficiently. Other activities might make many thousands of
requests, and that typically makes them less efficient. This
mode is useful for detecting those scenarios.

Operation
The Memory Profile works by hooking the process in
question, so that program has to be launched using the tool
in Enterprise Architect. Unlike the Call Graph option, you
cannot attach to an existing process. When the program is
started, hooking mechanisms track the allocation of
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memory; this information is collected and collated in
Enterprise Architect. You can easily monitor the number of
allocations being made. Also, the process is controlled; that
is, the memory hooks can be turned on and off on demand.
If you might have mistimed some action, you can pause
capture, discard the data and resume capture again easily.

Results
Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It is your decision how long you let
the Profiler run. You enable the Report button by either
pausing capture or stopping the Profiler altogether.
Results are displayed in a Report view. The report initially
opens with two tabs visible; a single weighted Call Graph
and a Function Summary. The Call Graph depicts all the
Call Stacks that led to memory allocations, which are
aggregated and weighted according to the frequency of the
pattern.

Requirements
For best results, the image and its modules should be built
with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO)
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optimization is likely to produce misleading results.
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Memory Leaks

The Profiler control, showing the count of memory
allocations and the count of operations that are memory free.
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A well behaved program.
Memory leak detection is a road well traveled. Although
many other good options are available, we believe our
approach has major benefits, such as:
· No changes at all to existing project build
· No header files required by the project code
· No runtime dependencies to worry about
· No system configuration to think about

Usage
A person would use this mode to track memory leaks in an
application or in an activity within the application. A
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memory leak from the Profiler's point of view is a successful
call made to a memory allocation function that returns a
memory address for which no matching call is made to free
that address.

Operation
The Memory Leak detection works through hooking. The
memory routines of the process are hooked to track when
memory is both allocated and freed. Call Stacks are captured
at the point of the allocation and this information is collated
in Enterprise Architect to produce a report in the form of a
Call Graph. Capture is controlled; that is, the hooking
mechanisms can be enabled or disabled on demand.
Depending on the type of program and its memory
consumption, you could employ an appropriate strategy. For
small programs, you might track the program from start to
finish. For larger windowed programs, you would probably
do better by toggling capturing before and after a specific
task to avoid tracking too much data.

Results
Results can be produced at any time during the session;
however, capture must be disabled in order for the Report
button to become active. It is your decision how long you let
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the Profiler run. You enable the Report button by either
pausing capture or stopping the Profiler altogether.
Results are displayed in a Report view. The report initially
opens with two tabs visible; a single weighted Call Graph
and a Function Summary. The Call Graph depicts all the
Call Stacks that led to memory allocations, and are
aggregated and weighted according to the frequency of the
pattern.
Reports can contain a variable amount of 'noise'. To focus
on an area you have specific concerns for, locate a function
known to you in the summary report and use that to navigate
directly into the line in the graph where it is featured.

Requirements
For best results, the image and its modules should be built
with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO)
optimization is likely to produce misleading results.
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Setting Options
The first icon on the Profiler window toolbar displays a list
of options that you can set to tailor your Profiling session.

Options
Option

Description

Attach to
Running
Process

Select this option to display the 'Attach to
Process' dialog, from which you choose
an active process to Profile.

Switch to
Debugger

Select this option to change operations
from Profiling to Debugging. The
Debugger has an equivalent drop-down
menu option that you can use to switch
from Debugging to Profiling.
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Load Report

Select this option to load a previously
saved report from the file system.

Analyzer
Scripts

Select this option to open the Analyzer
Script window, which is the model
repository for configuring builds,
debugging, and all other Visual
Execution Analyzer options.

Delay
Sampling

Select this option to set a delay between
clicking on a 'Start Profiling' option and
the Profiling actually beginning. The
delay can be 3, 5 or 10 seconds. Select
'None' to cancel any delay set.

CallGraph
Aggregates
Method

When this option is selected, instances of
the identical stack sequences are
aggregated by method. That is to say, line
numbers / instructions within a method
are ignored, so two stacks will be counted
as one where they differ only by line
number in their final frame.

CallGraph
Samples
Include Wait
State

When this option is selected, the Profiler
will sample all threads, including those in
Wait states. When unselected, the Profiler
only samples threads that have
accumulated CPU time since the last
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interval expired.
Start
Sampling
Immediately

Select this option to trigger Data
Collection immediately on launch. You
would typically use this option to profile
a process during start up.

Discard
Fragments

When stacks cannot be reconciled to the
entry point of a thread they are referred to
as fragments. The number of fragments
encountered during sampling is displayed
in the sampler Summary window. You
can set this option to collect or discard
fragments; when the Discard Fragments
option is:
· Selected, fragments do not appear in
the reports, although the number
encountered is still updated
· Deselected, a special collection named
'fragments' is created in the call graph
to house them, and to ensure they data
is not mixed in with the complete
samples

Capture
Debug
Output

(Applies to Process Sampling). When
selected, output normally visible during
debugging is captured and displayed in
the Debug window. Note that only debug
builds will typically emit debug output.
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This option determines termination
behavior for the Profiler. When the option
is selected, the target process will
terminate when the Profiler is stopped.
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Start & Stop the Profiler
Profiling is a two stage process of data collection and
reporting. In Enterprise Architect the data collection has the
advantage of being a background task - so you are free to do
other things while it runs. The information sent back to
Enterprise Architect is stored until you generate a report. To
view a report, the capture must be turned off. After the
report is produced you can resume capture with the click of
a button. If, for some reason, you decide to scrap your data
and start again, you can do so easily and without having to
stop and start the program again.

Access
Ribbon

Execute > Tools > Profiler > Open
Profiler

Other

Execution Analyzer toolbar : Analyzer
Windows | Profiler
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Actions
Action

Detail

Toolbar
Strategy
Selection

Select the Profiling strategy from the
available options on the Toolbar.

Start the
Profiler

Click the Run button on the Profiler
window

Stop the
Profiler

The process exits if:
· You click on the Stop button
· The target application terminates, or
· You close the current model
If you stop the Profiler and the process is
still running, you can quickly attach to it
again.

Pause and
Resume
Capture

You can pause and resume capture at any
time during a session.
When capture is turned on, samples are
collected from the target. When paused,
the Profiler enters and remains in a wait
state until either capture is enabled, the
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Profiler is stopped or the application
finishes.
Generate
Reports

The Report button is disabled during
capture but is available when capture is
turned off.

Mode
drop-down

Click on the drop-down and select the
mode of Profiling - Call Graph, Stack
Profile, Memory Profile or Memory
Leaks.

Clear Data
Collection

You can clear any data samples collected
and resume at any time. First suspend
capture by clicking on the Pause button.
The Discard button, as for the Report
button, is enabled whenever capture is
turned off. In clicking on the Discard
button you will be asked to confirm the
operation. This action cannot be undone.
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Function Line Reports
After you have run the Profiler on an executing application
and generated a Sampler report, you can further analyze the
activity of a specific function listed in the report by
generating a Function Line report from that item. A
Function Line report shows the number of times each line of
the function was executed. You produce one Function Line
report at a time, on any method in the Sampler report that
has a valid source file. The Function Line report is
particularly useful for functions that perform loops
containing conditional branching; the coverage can provide
a picture of the most frequently and least frequently
executed portions of code within a single method.
The line report you generate is saved when you save the
Sampler report. The body of the function is also saved with
the Function Line report to preserve the function state at that
time.
This facility is not applicable to Memory Profile reports.

Platforms supported
Java, Microsoft .NET and Microsoft native code

Create a Line Report
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In the Sampler report, right-click on the name of the
function to analyze, and select the 'Create Line Report for
Function' option.
Once the Profiler binds the method, the Function Line report
is opened on the Sampler Report window. The report shows
the body of the function, including line numbers and text.
As each line is executed a hit value will accumulate against
that line. A timer will update the report approximately once
every second.
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End Line Report Capture
Once enough information is captured, or the function has
ended, click on the Profiler toolbar Stop button to stop
recording the capture.

Save Reports
Use the Save button on the Call Stack toolbar to save the
Sampler report and any Function Line reports to a file.

Delete Line Reports
Closing the 'Line Report' tab will close that report but the
report data will only be deleted when the report is saved.
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Generate, Save and Load Profile
Reports
Reports can be produced at any time during a session, or
naturally when a program ends. To enable the Report button
while the program is running, however, you need to suspend
Profiling by toggling the Pause/Resume button, or by
terminating the Profiler with the Stop button. You have
some options for reviewing and sharing the results:
· View the report
· Save the report to File
· Distribute the report as a Model Library resource
· Attach the report as a document to an Artifact element
· Synchronize the model by reverse engineering the source
code that participated in the profile

Access
Ribbon

Execute > Tools > Profiler > Create
Report from Current Data

Profiler

From the Profiler window, click on the
icon in the toolbar.
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Load Report from File
The option is available from the drop down menu of the
Profiler window

Generate Report
From the Profiler window, click on the
toolbar.

icon in the

CallFrequency Report
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Function Summary
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Unfiltered Summary Report listing all participating
functions in order of inclusive hits.

You can filter and reorganize the information in the report,
in the same way as you do for the results of a Model Search.

Report Options
Right-click on the report to display the context menu.

Note that the options listed depend on the type of report
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displayed; the report illustrated here is a Memory Profile
report.
Action

Detail

Show Source
for Function

For the selected frame, select this option
to display the corresponding line of code
in a code editor. Frames that have source
available are identifiable by their icon.

Find in
Summary
Window

Select this option to locate the function in
the Summary window.

Collapse
Graph

Select this option to collapse the entire
graph including child nodes, visible or
not.

Collapse to
Node

Select this option to collapse the entire
graph, then expand and set the focus to
the selected node.

Follow Max
Allocations

Select this option to expand an entire line
in the graph.

Create Line
Report for
Function

Select this option to launch the Profiler (if
it is not already running), immediately
bind the selected function and ready it for
recording. Once bound, an extra tab is
opened in the current Report View. This
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report will update instantaneously,
showing the number of times each line
executed. Of course, the report will
continue to record activity in the function
even if is not visible.
Notes:
· In windowed programs, it is usually
necessary to take some action in the
application to cause the function to be
invoked
· This option is not applicable to
Memory Profile reports
Create
Function
Graph

Select this option to create an additional
tab, which shows the selected function in
isolation. For a Call Frequency Profile,
this produces a graph showing all the
lines that led to this function being called
(that is, the callers). For a Memory
Profile, this produces a graph showing all
lines that emanate from this function (that
is, the callees).

Mark Initial
Frame for
Call Stack
Diagram

Use prior to creating a Call Stack
Sequence diagram to limit the stack
length. When this option is selected, the
frame is marked and its text is
highlighted. Frames above this one will
then be excluded from any Sequence
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diagram produced.
This option is not applicable to Memory
Profile reports.
Remove
Mark

Removes the mark from a frame that was
previously marked as 'Initial'.
This option is not applicable to Memory
Profile reports.

Create Call
Stack
Diagram

Generates a Sequence diagram for a
single stack in the graph. The selected
frame is depicted as the terminal frame in
the stack. The initial frame of the stack
defaults to the root node if no 'Initial'
frame has been marked.
This option is not applicable to Memory
Profile reports.

Create
Weighted
Call Graph
Diagram

Generates a Sequence diagram that
presents a sequence for each visible stack
branching from the selected frame. By
expanding and collapsing the nodes of
interest, you can tailor the Sequence
diagram content to your liking.
This option is not applicable to Memory
Profile reports.

Display the
Heaviest

Select this option to display the line in the
graph with the highest weight in which
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Weighted
Use

this function appears.

Display the
Next
Weighted
Use

Select this option to navigate to the next
line in the graph where the function
appears.
You can use the shortcut key combination
Ctrl+Down Arrow.

Display the
Previous
Weighted
Use

Select this option to navigate to the
previous line in the graph where this
function appears.
You can also use the shortcut key
combination Ctrl+Up Arrow.

Import
Source Code

Select this option to import selected
source code into the report.
This option is not applicable to Memory
Profile reports.

Autofit

When enabled, automatically fits the
columns to the available display area.

Save Report
to File

Select this option to display the 'Save As'
dialog, allowing you to choose where to
store the report.

Save Report

Note: Before selecting this option, go to
the Browser window and select the
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Package or element under which to create
the Artifact element.
You are prompted to provide a name for
the report (and element); type this in and
click on the OK button.
The Artifact element is created in the
Browser window, underneath the selected
Package or element.
If you add the Artifact to a diagram as a
simple link, when you double-click on
the element the report is re-opened.

Notes
·

If you add the Profiler report to an Artifact element and
also attach a Linked Document, the Profiler report takes
precedence and is displayed when you double-click on the
element; you can display the Linked Document using the
'Edit Linked Document' context menu option
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Save Report in Model Library
You can save any current report as a resource for a
Category, Topic or Document in the Model Library. The
report can then be shared and reviewed at any time as it is
saved with the model. This helps you to:
· Preserve a Profiler report to compare against future runs
· Allow other people to investigate the profile

Access
Context
Menu
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Testpoints
Testpoints present a scheme by which constraints and rules
governing the behavior of objects can be taken from the
model and applied to one or more applications. The
advantages that schemes such as this offer are tolerance to
code changes - adding and subtracting lines from a function
has no effect on the constraints that govern it. Another
advantage is that changes to the behavioral rules do not
require a corresponding change to any source code; meaning
nothing has to be re-compiled!
Also, the ability to verify multiple applications using a
single test domain is a simple rather than onerous matter.
The Test Domain is a both a logical and relational model;
constraints in the Class model can be partitioned with Test
Cuts. These can be aggregated simply into Test Sets and
Test Suites using connectors. Due to the decoupling of the
Test Domain from the codebase, it is a simple choice of
buttons to run a program normally, or run it for a specific
Test Domain. This system also delivers practical benefits in
that no instrumentation is required at all. Test results are
displayed in the report window during the run, in real-time,
as the program runs. These results can be retained, and
reviewed at any time in the 'Test Details' dialog or using
Enterprise Architect's documentation features.
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Features
Feature

Details

Testpoint
Composition

Testpoint composition is performed using
the Testpoints window. The Testpoints
window is context-sensitive and displays
the Test Domain for the selected element
in either the Browser window or diagram.
Selecting a single Class will display the
Class structure. A 'pencil' icon is
displayed against Classes and methods
that have existing constraints.
When you select a Test Cut, Set or Suite
Test, the Testpoints window displays the
entire Domain structure, including all the
Classes that make up the domain. Note:
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You can navigate the domain hierarchy
using the 'Navigation' pane on the right.
Testpoints are composed as expressions,
using the variable names of the Class
members. The Intelli-sense shortcut
Ctrl+Space is available within the editor
to help you find these. Expressions that
evaluate to True are taken to mean a pass.
Returning False is taken to mean a fail.

You can add or edit an existing Invariant
by double-clicking the Class.
You can add or edit an existing pre- or
post-condition similarly by
double-clicking the method.
Double-clicking a Testpoint will
automatically display the source code if it
is available.
Line conditions are best added from
within the code editor using its shortcut
menus.
This image is of a pre-condition in the
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Test domain.

Testpoint
Trace
Statements

Each Testpoint can have its own Trace
statement. The Trace statement is a
dynamic message that can reference
variables in its object or local scope.
They are output during the evaluation of a
test. They can be configured to be output
every time a constraint is evaluated, or
more usually when a test has failed. Trace
statements can be directed to the
'Testpoints' tab of the System Output
window, or to an external file. You can
configure this in any Analyzer Script.

Test Domain
Composition

The Test Domain diagram is a dynamic
medium where Testpoints are assembled
to test Use Cases. Use Cases in a Test
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Domain diagram are provided in three
different stereotypes: Test Cut, Test Set
and Test Suite. Management of the
domain is as easy as modeling on any
diagram. The toolbox and shortcut menus
provide access to any Test Domain
Artifacts. In brief, Testpoints from
multiple Classes are aggregated into Test
Sets. Test Sets are then linked to form
Test Suites. Both Test Cuts and Test Sets
are re-usable assets. Linking the same
Test Set to the one or more Test Suites is
a matter of drawing connectors.

Test Domain
and the Class
Model
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subset of methods a 'cut', and the Test Cut
Artifact is the tool we use to make these
cuts. The Testpoints window will adapt
depending on the context, to be that for a
Test Domain or Class element. This
image shows the Testpoints window
when a Test Cut has been selected. Note
the checkboxes, which are only visible
for a Test Cut. They denote the methods
(Test Cuts) that are contributing to a Test
Set. In this example the Test domain was
generated by the Execution Analyzer,
which did the method identification work
for us.

Testpoint
Evaluation
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The Testpoints window is used to
evaluate Test domains. The window has a
toolbar for starting or attaching to the
target application. The domain to test is
always reflected by the element that has
context, so if you select a Class the
window will show only the Class
structure and Testpoints of that Class. If
you select a Test Suite, the window will
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display the entire domain hierarchy and
all the Testpoints included in it. Clicking
on the Run button will load the Testpoint
domain in the Execution Analyzer, which
will then evaluate, collect and update the
report window as Use Cases pass or fail
each test. The exact details of each
constraint type and the when and how of
that constraint's capture are:
· A Class Invariant is evaluated by the
Analyzer whenever any method called
on an object of this Class type is
completed; the invariant serves to test
that the state of a complying object is
both known and permitted
· Pre-conditions are evaluated
immediately before an operation is
called
· Post-conditions are evaluated (at the
same time as a Class invariant) when
the method is completed
· Line-conditions are evaluated if and
when their specific line of code comes
into scope during program execution
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Test Domain Diagram
The Test Domain diagram is the medium where you
assemble and group test cases for a particular domain. An
example of a Test domain might be 'Customer'. The breadth
and depth of the domains you assemble is up to you. You
might have separate domains for 'Add Customer' and 'Delete
Customer', depending entirely on how you consider best to
balance the domain hierarchy. The Diagram Toolbox and
Shortcut menu provide a number of Artifacts to help model
the domain. Because the medium is dynamic, allowing you
to revisit and build on relationships between Test domains,
the system is a great model for delivering reusable assets to
an organization that are low overhead and integrate with
both the UML view of the world, and the Software
Engineering nuts and bolts of daily life.

Facilities
Facility

Details

Test Domain
Generation

If you think the process of composing a
Test Domain is complex, it can be, but
help is at hand! The Execution Analyzer
can produce a Test Domain diagram for
you. It cannot write the Tests for you, but
it can do some of the leg work. It can
identify the Classes and pick out only
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those methods that participated in a Use
Case. And this is not guesswork. The
Analyzer Test Domain is obtained from a
running program. This image shows the
Test Domain generated by the Execution
Analyzer from recording an Example
Model program.

And this is the recording itself (as a
Sequence diagram) from which the Test
Domain was generated.

Test Domain
Composition
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The first task on a Test Domain diagram
is to create the Use Cases (Test Sets).
These define this particular domain's
responsibility. The Diagram Toolbox and
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shortcut menu provide Artifacts to help
you achieve this. The first of these
elements is the Test Cut, which is used in
the next step; identifying those methods
(from the Class model) that you consider
to be participants in the Use Case. The
Test Cut Artifact is useful because it
allows us to partition a Class, selecting
only those methods that are relevant. Test
Cuts can be run individually or linked to
one or more Test Sets. Test Sets in turn
can be linked to one or more Test Suites.
In any case, any element of the Test
Domain tree can be run individually or as
a whole.
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Test Cut

Description
A Test Cut element is a stereotyped Object element, used
internal to Enterprise Architect for defining Test Sets using
the Testpoint code testing facilities.
A task, such as 'Print', might involve operations on different
Classes. In order to create a 'Print' test, you would want to
include only the 'Print' operations of these Classes and
exclude any other operations.
A Test Cut enables you to capture only the operations that
represent the behavior (in this case, 'Print') defined for a
single Class. You might then place the Test Cut from each
of several Classes into a single task as a Test Set.
When you drag a Test Cut element onto a Test Domain
diagram, you create a Dependency relationship with the
required Class element. As a result, when you select the Test
Cut element on the Testpoints window, the operations of the
Class are listed in the window, each with a checkbox. You
then select the checkbox against each Class operation to
include in the Test Cut.
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Toolbox icon
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Test Set

Description
A Test Set element is a stereotyped Use Case element used
to aggregate one or more groups of methods (Test Cuts),
which perhaps span multiple Classes, into a single task. Test
Sets can also be aggregated into Test Suites.
You link the Test Cut elements to the Test Set using
Dependency connectors.

Toolbox icon
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Test Suite

Description
A Test Suite element is a stereotyped Use Case element,
used to aggregate one or more groups of tasks (Test Sets).
You link the Test Set elements to the Test Suite using
Dependency connectors.

Toolbox icon
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The Testpoints Window
The Testpoints Window is the hub where Test Domain
constraints are composed. It is also the control that lets you
verify a particular Test Domain on a program. The program
might be already running or it can be launched using the
control's Toolbar. Here you will also be able to see the
results of your tests, as they happen. This control is
context-sensitive, responding to the selection of elements in
the Browser window or on a diagram. Depending on the
selection, tests can be carried out on a single Class, a Use
Case (Test Set) or a collection of Use Cases (A Test Suite).

Access
Ribbon

Execute > Tools > Tester > Show
Testpoint Window

Testpoints Window Columns
Column

Usage

Tests

Displays the name of the selected
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Testpoint object and the hierarchy of
objects beneath it.
The selected object can be a:
· Class
· Operation
· Test Cut
· Test Set or
· Test Suite
Id

For an Operation, this column shows a
Testpoint marker icon ( ) when the
Analyzer has successfully bound this
operation in the target application. If no
icon appears in this column during a run,
it indicates that the model and code base
might not be synchronized; perhaps the
signature of the function has changed, or
the operation is a new method you are
working on that exists in the source code
but not yet in your model.
For a Testpoint, this column shows a
generated id number. This id number is
used in trace output to indicate which
constraint is being referenced.

Constraints

A pencil icon ( ) in this column indicates
that one or more constraints are defined
for this Class or Operation.
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Status

During a test run, indicates these possible
statuses:
· ( ) Failed - Constraint has evaluated as
false one or more times.
· ( ) Invalid Statement - Constraint
failed to parse due to invalid syntax.
· ( ) Variable not found - A referenced
variable name was not found at the
location where the constraint was
evaluated.
No icon is shown if a constraint has
Passed.

Evals

During a test run, indicates the number of
times the Execution Analyzer has
evaluated this constraint.

Passes

During a test run, indicates the number of
times the test passed.

Fails

During a test run, indicates the number of
times the test failed.

Last Run By

Displays the username of the last person
to run this test. (Values are derived from
the Project Author definitions in the
'People' dialog - 'Settings > Reference
Data > Model Types > People > Project
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Authors'.)
Last Run
Date

Displays the date and time this test was
last evaluated.

Last Run
Result

Displays the result of the last test run.

Parent
Collections
Pane

Lists any parent collections that include
the selected object as part of their design.
Double-click this collection to make it the
selected object in the left pane.
The Parent Collections pane can be
hidden by clicking the Show / Hide
Parent Collections pane button on the
Testpoints Window Toolbar.
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Testpoints Toolbar
The Testpoints Window Toolbar provides options to execute
configured tests on the currently selected Testpoint object,
stop a test run currently in progress, filter the displayed
items, and save the results of a completed test run.

Access
Ribbon

Execute > Tools > Tester > Show
Testpoint Window

Testpoints toolbar options
Toolbar
Button

Action
Field showing the name of the currently
selected Testpoint object.
Execute the test run.
Stop the test run currently in progress.
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Toggle between showing all items and
showing only those items that have
constraints defined.
Toggle between showing all items and
showing only operations that have been
marked for inclusion in this Test Cut; this
button is only enabled when a Test Cut
object is selected.
When a Test Cut is selected, each of the
operations of its associated Class are
displayed with a checkbox; you use this
checkbox to mark the operations that
apply to this Test Cut.
Click on the drop arrow next to this icon
to display the 'Test Run Options' menu,
providing these options:
· 'Prefix Trace output With Function
Call' - Prefix all trace output lines with
the executing function name
· 'Enable Standard Breakpoints during
Testing' - When not checked, the test
run ignores any breakpoints in the
current breakpoint set, and any
attempts to set breakpoints during the
run are ignored
· 'View Trace output' - Display the
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'Testpoints' tab of the System Output
window
Click on this icon after completion of a
test run to save the results to Test item on
the current object. Saved tests can be
viewed using the Testing Workspace.
A prompt displays to select the Test Class
- Unit, Integration, System, Inspection,
Acceptance or Scenario. Select the
appropriate Test Class and click on the
OK button.
Display the Testpoint Management Help
topic.
Show or hide the Parent Collections pane.
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Testpoint Editor
The Testpoint Editor is used to compose constraints for
Classes and Operations. The types of constraint permitted
are dependent on the selected object. For Classes, the type
will always be Invariant. For operations, the type can be
either Pre-Condition, Post-Condition or Line-Condition.
Invariants are evaluated by the Analyzer when any method
called on an object of the selected Class type completes.
Pre-conditions are evaluated at the beginning of each call to
the specified operation. Post-conditions are evaluated upon
completion of each call to the specified operation.
Line-conditions are evaluated each time the specified line of
code is executed.

Access
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1. Execute > Tools > Tester > Show
Testpoint Window.
2. In the Testpoints window, double-click
on a Class or Operation to display the
'Testpoint Editor' dialog.

Constraint Group fields
Field

Usage

Type

The type of constraint for the selected
Class or Operation:
· Invariant - Evaluated after any method
called on the specified Class has
completed
· Pre-Condition - Evaluated at the
beginning of each call to a specific
Operation
· Post-Condition - Evaluated after
completion of each call to a specific
Operation
· Line-Condition - Evaluated upon
execution of a specific line of code
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within an Operation
Offset

For Line-Conditions only, the Line
number within the specified operation
upon which to evaluate the constraint.
An offset value is automatically set if the
Testpoint was created using the Code
Editor context menu.

Condition

The constraint to be evaluated when this
Testpoint is triggered. A status of pass or
fail will be recorded depending upon
whether this constraint condition
evaluates as true or false.

Action on
Fail

Click on the drop-down arrow and select
from the three options:
· 'Continue' - ignore failure of this
constraint and continue execution
· 'Break execution' - halt execution and
display the Stack trace
· 'Disable on fail' - do not execute the
constraint again after failing once

Evaluate
When

(Optional) An additional constraint which
must be met before the main Testpoint
Condition is evaluated, providing greater
control over test coverage.
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Trace Group fields
Option

Action

Level

Specifies when the trace statement (if
defined) will be output. Available options
are:
· 'Fail Only' - Output trace statement
only when this Testpoint condition fails
· 'Always' - Output trace statement every
time this Testpoint is evaluated

Statement

(Optional) A message to be output when
this Testpoint is evaluated.
Variables currently in scope can be
included in a trace statement output by
prefixing the variable name with a $
token for string variables, or a @ token
for primitive types such as 'int' or 'long'.
Output from a Trace Statement can be
directed either to the 'Testpoints' tab of
the System Output window, or to an
external file, as configured by the
Analyzer Script for the parent Package.
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Testpoint Constraints
A Constraint is typically composed using local and member
variables in expressions, separated by operators to define
one or more specific criteria that must be met. A constraint
must evaluate as true to be considered as Passed. If a
constraint evaluates as false, it is considered as Failed.
Any variables referenced within the constraint must be in
scope at the position where the Testpoint or Breakpoint is
evaluated.

General/Arithmetic Operators
Operator

Description

+

Add
Example: a + b > 0

-

Subtract
Example: a - b > 0

/

Divide
Example: a / b == 2

*

Multiply
Example: a * b == c
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%

Modulus
Example: a % 2 == 1

()

Parentheses - Used to define precedence
in complex expressions.
Example: ((a / b) * c) <= 100

[]

Square Brackets - Used for accessing
Arrays.
Example: Names[0].Surname == "Smith"

.

Dot operator - Used to access member
variables of a Class.
Example: Station.Name == "Flinders"

->

Alternative notation for the Dot operator.
Example: Station->Name == "Flinders"

Comparison Operators
Operator

Description

=

Equal To
Example: a = b
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==

Equal To
Example: a == b

!=

Not Equal To
Example: a != b

<>

Not Equal To
Example: a <> b

>

Greater Than
Example: a > b

>=

Greater Than or Equal To
Example: a >= b

<

Less Than
Example: a < b

<=

Less Than or Equal To
Example: a <= b

Logical Operators
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Operator

Description

AND

Logical AND
Example: (a >= 1) AND (a <= 10)

OR

Logical OR
Example: (a == 1) OR (b == 1)

Bitwise Operators
Operator

Description

&

Bitwise AND
Example: (1 & 1) = 1
(1 & 0) = 0

|

Bitwise OR
Example: (1 | 1) = 1
(1 | 0) = 1

^

Bitwise XOR (exclusive OR)
Example: (1 ^ 1) = 0
(1 ^ 0) = 1
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Additional Examples
Example

Description

((m_nValue
&
0xFFFF0000)
== 0)

Use a Bitwise AND operator (&) with a
hexadecimal value as the right operand to
test that no bits are set in high order bytes
of the variable.

((m_nValue
&
0x0000FFFF)
== 0)

Use a Bitwise AND operator (&) with a
hexadecimal value as the right operand to
test that no bits are set in low order bytes
of the variable.

m_value[0][1
]=2

Accessing a multi-dimensional array

a AND (b
OR c)

Combining AND and OR operators,
using parentheses to ensure precedence.
In this example, variable 'a' must be true,
and either 'b' or 'c' must be true.

Notes
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String comparisons are case-sensitive
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Unit Testing
Enterprise Architect supports integration with unit testing
tools in order to make it easier to develop good quality
software.
In sequence:
· You download and install the NUnit and JUnit
applications (NUnit - http://www.nunit.org/ JUnit http://www.junit.org/); Enterprise Architect does not
include these applications in the installer
· Enterprise Architect helps you to create test Class stubs
with the NUnit and JUnit transformations
· You define your test code within the Class stubs
· You set up and run a test script against any Package
· All test results are automatically recorded inside
Enterprise Architect
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Set Up Unit Testing
This topic explains the actions you should take in setting up
Unit Testing, after having downloaded and installed the
JUnit and/or NUnit applications.

Actions
Action

Details

Create Unit
Test Stubs

By using the JUnit or NUnit
transformations and code generation you
can create test method stubs for all of the
public methods in each of your Classes.
(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
}
(Test)
public void testDivide(){
}
(Test)
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public void testMultiply(){
}
(Test)
public void testSubtract(){
}
}
Define Test
Cases

Write your unit test in the generated code
stubs (either in Enterprise Architect or in
your preferred IDE).
This is an NUnit example in C#, although
it could also be any other .NET language,
or Java and JUnit.
(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
Assert.AreEqual(1+1,2);
}
(Test)
public void testDivide(){
Assert.AreEqual(2/2,1);
}
(Test)
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public void testMultiply(){
Assert.AreEqual(1*1,1);
}
(Test)
public void testSubtract(){
Assert.AreEqual(1-1,1);
}
}
Alternatively, if you have not performed
an xUnit transformation, you can reverse
engineer the code into Enterprise
Architect so that the system can record all
test results against this Class.
Compile
Your Code

Check that the source code being tested
compiles without errors, so that the test
scripts can be run against it.

Set up the
Test Scripts

Set up the Test scripts against the
required Package, and then run the tests.
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Run Unit Tests
On running a test script you generate test results that are
stored as Test Cases against the Classes being tested.

Access
Ribbon

Execute > Run > Start > Test

Execution
Analyzer
Window

ToolBar > Run Test Script
Context Menu > Test

Tasks
Task

Details

Run Tests

Select the appropriate Package in the
Browser window.
Select the 'Run Test Script' option to run
the test script you previously set up for
that Package, in the Execution Analyzer.
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The results of xUnit tests are displayed in
the System Output window, identifying
which tests have run and which of these
have failed.
The results also show which method
failed, and the file and line number the
failure occurred at.
Double-click on an error message;
Enterprise Architect opens the editor to
that line of code, enabling you to quickly
find and fix the error.
Enterprise Architect also records the run
status of each test against the Class being
tested; these are stored in the element
Test Cases.
A diagram containing the Class can be set
to display these Test Cases, by exposing
the test scripts compartment on the
diagram elements.
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Record Test Results
Enterprise Architect is able to automatically record all
results from tests through a testing script in Enterprise
Architect.

Process
In order to use this feature, you must reverse engineer the
test Class into the Package containing your test script.
Once your model contains your test Class, on the next run of
the test script Enterprise Architect adds Test Cases to the
Class for each test method found; on this and all subsequent
test runs all Test Cases are updated with the current run time
and whether they passed or failed, as shown:

The error description for each failed test is added to any
existing results for that Test Case, along with the current
date and time.
Over time this provides a log of all test runs where each Test
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Case has failed, which can then be included in generated
documentation, resembling this:
Failed at 05-Jul-2006 1:02:08 PM
expected: <0>
but was: <1>
Failed at 28-Jun-2006 8:45:36 AM
expected: <0>
but was: <2>
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Samples
Enterprise Architect enables you to easily import complete
sample models (Packages), including all necessary model
information, code and build scripts. These sample Patterns
make it simple to explore and try out the Visual Execution
Analyzer. You can generate an example model for:
· Java
· Microsoft.NET
· Microsoft C++
· PHP Apache

Access
Ribbon

Develop > Source Code > Create From
Pattern > VEA Examples

Display Samples
Field

Action

Technology

Select the appropriate technology.
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Name

Displays the samples available for the
selected technology; select the required
sample to import.

description
field

Displays a description of the selected
sample.

Destination
folder

Browse for and select the directory in
which to load the source code for the
sample.

Use Local
Path

Enable the selection of an existing local
path to place the source code under;
changes the 'Destination folder' field to a
drop-down selection.

Compiler
command

Displays the default compiler command
path for the selected technology; you
must either:
· Confirm that the compiler can be found
at this path, or
· Edit the path to the compiler location

Edit Local
Paths

Many VEA examples specify their
compiler using a local path.
The first time you use any sample you
must click on this button to display the
'Local Paths' dialog, on which you check
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and - if necessary - correct the local path
pointing to the correct compiler location.

Notes
·

·

If required, you can define custom samples by adding files
to the AppSamples directory in which Enterprise
Architect is installed; top-level directories are listed as
Technologies and can contain an icon file to customize
the icon displayed for the technology
Directories below this are defined as groups in the
Patterns list; the Patterns are defined by the presence of
four files with a matching name: a zip file (.zip), XMI file
(.xml), config file (.cfg) and optional icon (.ico)
The config file supports these fields:
- [provider], [language], [platform], [url],
[description], [version] - all displayed in the 'description'
field
- [xmirootpaths] - the root path of the source code in
the exported XMI; this is replaced with the
selected destination folder when the user applies the
application pattern
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